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Preface

As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.

Contact your EMC representative if a product does not function properly or does not 
function as described in this document.

This document was accurate at publication time. New versions of this document might be 
released on the EMC online support website. Check the EMC online support website to 
ensure that you are using the latest version of this document.

Purpose
This guide describes how to install EMC Avamar in a Microsoft Exchange Server 2007 or 
2010 environment, and how to back up and restore data by using Avamar with Microsoft 
Volume Shadow Copy Service (VSS) technology.

Audience
The information in this document is primarily intended for:

◆ System administrators who are responsible for installing software and maintaining 
servers and clients on a network.

◆ Microsoft Exchange Administrators who are responsible for backing up and 
maintaining Microsoft Exchange servers.

Persons using this document should have current practical experience with the following:

◆ Operating system shell commands on the Exchange platform. Root permission is 
required.

◆ The specific version of Microsoft Exchange currently deployed at the site.

Revision history
The following table presents the revision history of this document.

Table 1  Revision history

Revision Date Description

07 August 1, 2013 Corrected inaccuracies in Installation chapter, Multi-streaming 
recommendations. 

06 May 1, 2013 Updated “Recovering a deleted or current user mailbox to an 
alternate mailbox” on page 177 to include Powershell cmdlet 
for Exchange 2010 SP1 or later. 

05 December 7, 
2012

Added a notice in “Exchange cluster configuration” on page 23 
that Exchange 2007 clusters require the Avamar Windows Cluster 
Client for recovery of either passive node or active node backups. 
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Related documentation
The following EMC publications provide additional information:

◆ EMC Avamar Administration Guide
◆ EMC Avamar for Windows Server User Guide
◆ EMC Avamar Backup Clients User Guide
◆ EMC Avamar Operational Best Practices
◆ EMC Avamar Release Notes
◆ EMC Avamar Config Checker for Microsoft Windows Technical Note

Conventions used in this document
EMC uses the following conventions for special notices:

DANGER indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury. 

04 October 25, 
2012

Updates for release 6.1 Service Pack 1:
• Added note about Microsoft VSS framework limitation of 64 

volumes and shadow copies.
• Replaced screenshots for Cluster Configuration options and 

added steps for creating the var folder in “Configuring for 
Exchange 2010 DAG environments” on page 67

• Added “Granular level recovery may fail when security 
hardening packages are enabled on an Avamar server” on 
page 178 to “Troubleshooting message and granular level 
restores. “

• Fixed typo and link to information about using the 
Restore-Mailbox cmdlt in “Recovering a deleted or current 
user mailbox to an alternate mailbox” on page 177.

03 July 31, 2012 Updated “Where to get help” on page 12 in the Preface.

A02 June 15, 2012 Added the following topics:
• “Accessing archive mailboxes in recovery databases” on 

page 176.

• “Recovering a deleted or current user mailbox to an 
alternate mailbox” on page 177.

Updated the description of the backup plug-in option “Group by” 
on page 196.

A01 April 25, 2012 First release of Avamar 6.1.

Table 1  Revision history

Revision Date Description
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CAUTION, used with the safety alert symbol, indicates a hazardous situation which, if not 
avoided, could result in minor or moderate injury. 

NOTICE is used to address practices not related to personal injury.

Note: A note presents information that is important, but not hazard-related.

IMPORTANT

An important notice contains information essential to software or hardware operation.

Typographical conventions

EMC uses the following type style conventions in this document:

Normal Used in running (nonprocedural) text for:
• Names of interface elements, such as names of windows, dialog boxes, 

buttons, fields, and menus
• Names of resources, attributes, pools, Boolean expressions, buttons, 

DQL statements, keywords, clauses, environment variables, functions, 
and utilities

• URLs, pathnames, file names, directory names, computer names, links, 
groups, service keys, file systems, and notifications

Bold Used in running (nonprocedural) text for names of commands, daemons, 
options, programs, processes, services, applications, utilities, kernels, 
notifications, system calls, and man pages

Used in procedures for:
• Names of interface elements, such as names of windows, dialog boxes, 

buttons, fields, and menus
• What the user specifically selects, clicks, presses, or types

Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis, for example, a new term
• Variables

Courier Used for:
• System output, such as an error message or script
• URLs, complete paths, file names, prompts, and syntax when shown 

outside of running text

Courier bold Used for specific user input, such as commands

Courier italic Used in procedures for:
• Variables on the command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user 

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections — the bar means “or”

{ } Braces enclose content that the user must specify, such as x or y or z

... Ellipses indicate nonessential information omitted from the example
EMC Avamar 6.1 for Exchange VSS User Guide 11



Where to get help
The Avamar support page provides access to licensing information, product 
documentation, advisories, and downloads, as well as how-to and troubleshooting 
information. This information may enable you to resolve a product issue before you 
contact EMC Customer Service.

To access the Avamar support page:

1. Go to https://support.EMC.com/products.

2. Type a product name in the Find a Product box.

3. Select the product from the list that appears.

4. Click the arrow next to the Find a Product box. 

5. (Optional) Add the product to the My Products list by clicking Add to my products in 
the top right corner of the Support by Product page.

Documentation

The Avamar product documentation provides a comprehensive set of feature overview, 
operational task, and technical reference information. Review the following documents in 
addition to product administration and user guides:

◆ Release notes provide an overview of new features and known limitations for a 
release.

◆ Technical notes provide technical details about specific product features, including 
step-by-step tasks, where necessary. 

◆ White papers provide an in-depth technical perspective of a product or products as 
applied to critical business issues or requirements.

Knowledgebase

The EMC Knowledgebase contains applicable solutions that you can search for either by 
solution number (for example, esgxxxxxx) or by keyword.

To search the EMC Knowledgebase:

1. Click the Search link at the top of the page.

2. Type either the solution number or keywords in the search box.

3. (Optional) Limit the search to specific products by typing a product name in the Scope 
by product box and then selecting the product from the list that appears.

4. Select Knowledgebase from the Scope by resource list.

5. (Optional) Specify advanced options by clicking Advanced options and specifying 
values in the available fields. 

6. Click the search button.

Live chat

To engage EMC Customer Service by using live interactive chat, click Join Live Chat on the 
Service Center panel of the Avamar support page.
12 EMC Avamar 6.1 for Exchange VSS User Guide
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Service Requests

For in-depth help from EMC Customer Service, submit a service request by clicking Create 
Service Requests on the Service Center panel of the Avamar support page.

Note: To open a service request, you must have a valid support agreement. Contact your 
EMC sales representative for details about obtaining a valid support agreement or with 
questions about your account.

To review an open service request, click the Service Center link on the Service Center 
panel, and then click View and manage service requests.

Facilitating support

EMC recommends that you enable ConnectEMC and Email Home on all Avamar systems:

◆ ConnectEMC automatically generates service requests for high priority events.

◆ Email Home emails configuration, capacity, and general system information to EMC 
Customer Service.

Your comments
Your suggestions help us to continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:

BSGDocumentation@emc.com

Please include the following information:

◆ Product name and version

◆ Document name, part number, and revision (for example, 01)

◆ Page numbers

◆ Other details that will help us address the documentation issue
EMC Avamar 6.1 for Exchange VSS User Guide 13
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CHAPTER 1
Introduction

The following topics provide an introduction to using Avamar Plug-in for Exchange VSS as 
a complete backup and recovery solution for Microsoft Exchange Server 2007 and 2010:

◆ Architecture ............................................................................................................  16
◆ Installation .............................................................................................................  27
◆ Backup ...................................................................................................................  30
◆ Restore ...................................................................................................................  36
◆ Disaster recovery planning and preparation ............................................................  41
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Introduction
Architecture
The Avamar Plug-in for Exchange VSS supports several types of Exchange environment and 
versions of Exchange server. Though Exchange 2007 and 2010 are quite similar, they also 
differ in many ways such as clustering, high availability, and recovery databases and 
storage groups. These differences affect how Avamar backup and restore operations are 
configured and run. Whenever possible, Avamar is designed to use the same features and 
steps for backup and restore, but when needed separate procedures are provided for 
Exchange 2007 and Exchange 2010. 

The following topics explain the architecture of a Microsoft Exchange environment, and 
how the various Avamar components fit in the environment to provide backup and 
recovery:

◆ “Microsoft Exchange environments”  on page 16
◆ “How Avamar works in a Microsoft Exchange environment”  on page 20
◆ “Using Avamar with Data Domain”  on page 26

Microsoft Exchange environments

All Exchange servers must have the Avamar for Windows client and Avamar plug-in for 
Exchange VSS installed. If you want to enable granular level recovery capabilities, you 
must also select the Avamar Plug-in for Exchange GLR option during installation of the 
Avamar plug-in for Exchange VSS.

You can deploy Microsoft Exchange in several configurations. 

The simplest configuration is a single Windows network host running Exchange. This is 
referred to as a stand-alone configuration. In a stand-alone Exchange environment, 
everything resides on one server, which manages all Exchange operations and stores all 
mailbox databases. 

However, most larger enterprises typically deploy Exchange in some form of 
high-availability configuration. In Exchange 2007, this typically involves the use of 
Windows clusters, Exchange 2007 replication, or both. In Exchange 2010, this typically 
involves the use of Database Availability Groups (DAGs). 

The following topics provide details on both stand-alone and high-availability 
environments with Microsoft Exchange Server.

◆ “High availability and clustering in Exchange 2007”  on page 16
◆ “High availability in Exchange 2010”  on page 20

High availability and clustering in Exchange 2007
To use clustering in Exchange 2007, you must install and configure Windows failover 
clustering (Windows Server 2008) or Windows clustering (Windows Server 2003) prior to 
installing Exchange. In Exchange 2007, this typically involves the use of Windows clusters, 
Exchange 2007 replication, or both.
16 EMC Avamar 6.1 for Exchange VSS User Guide



Introduction
Exchange 2007 supports several types of replication and clustering:

◆ Cluster continuous replication (CCR)
◆ Local continuous replication (LCR)
◆ Standby continuous replication (SCR)
◆ Single copy cluster (SCC)
◆ Clustered mailbox servers

Exchange 2007 replication

Exchange 2007 includes built-in data features that enable replication of Exchange data 
from one Exchange server to another.

Exchange 2007 offers three levels of data replication:

◆ Local Continuous Replication (LCR)

LCR is a single-server solution that uses built-in asynchronous log shipping and log 
replay technology to create and maintain a copy of a storage group on a second set of 
disks that are connected to the same server as the production storage group. The 
production storage group is referred to as the active copy, and the copy of the storage 
group maintained on the separate set of disks is referred to as the passive copy. The 
following figure illustrates a basic LCR deployment.

LCR deployments do not require any special Avamar Plug-in for Exchange VSS setup or 
configuration. Install the Avamar Plug-in for Exchange VSS software on the active 
storage group using the normal (non-cluster) installation procedure. 

◆ Cluster Continuous Replication (CCR)

CCR combines the asynchronous log shipping and replay technology built into 
Exchange 2007 with the failover and management features provided by the Windows 
Cluster Service. CCR is designed to provide high availability for Exchange 2007 
mailbox servers by providing a solution that:

• Has no single point of failure.
• Has no special hardware requirements.
• Has minimal shared storage requirements.
• Can be deployed in one or two data center configurations.
Architecture 17
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CCR uses the database failure recovery functionality in Exchange 2007 to enable the 
continuous and asynchronous updating of a second copy of a database with the 
changes that have been made to the active copy of the database. During installation of 
the passive node in a CCR environment, each storage group and its database is copied 
from the active node to the passive node. This operation is called seeding, and it 
provides a baseline of the database for replication. After the initial seeding is 
performed, log copying and replay are performed continuously.

In a CCR environment, the replication capabilities are integrated with the Cluster 
Service to deliver a high-availability solution. In addition to providing data and service 
availability, CCR also provides scheduled outages. When updates need to be installed 
or when maintenance needs to be performed, an administrator can move a clustered 
mailbox server (called an Exchange Virtual Server in earlier versions of Exchange 
Server) manually to a passive node. After the move operation is complete, the 
administrator can then perform the needed maintenance. The following figure 
illustrates an Exchange CCR configuration.
18 EMC Avamar 6.1 for Exchange VSS User Guide
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◆ Standby Continuous Replication (SCR)

CCR can be combined with SCR to replicate storage groups locally in a primary data 
center (using CCR for high availability) and remotely in a secondary or backup data 
center (using SCR for site resilience). The secondary data center could contain a 
passive node in a failover cluster that hosts the SCR targets. This type of cluster is 
called a standby cluster because it does not contain any clustered mailbox servers, 
but it can be quickly provisioned with a replacement clustered mailbox server in a 
recovery scenario. If the primary data center fails or is otherwise lost, the SCR targets 
hosted in this standby cluster can be quickly activated on the standby cluster. The 
following figure illustrates a CCR combined with SCR.

◆ Single Copy Cluster (SCC)

SCC is a more typical Windows cluster configuration, where databases and logs are 
only stored in one location, a disk that is shared by both nodes of the cluster. In the 
following example, Exchange Servers MBX-01 and MBX-02 share Exchange databases 
and logs on external storage. 
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High availability in Exchange 2010
Exchange 2010 uses Database Availability Group (DAG) and mailbox database copies to 
replace the following features from Exchange 2007: CCR, LCR, SCR, SCC, and clustered 
mailbox servers.

You do not need to install and configure any Windows clustering prior to installing 
Exchange 2010. An Exchange administrator can add high availability to the Exchange 
2010 environment after Exchange has been deployed without having to uninstall 
Exchange and then reinstall in a high-availability configuration. 

Active and passive nodes and databases
In a clustered environment, there are active and passive copies of the databases. This 
allows the server to constantly update a copy, or replica, as the passive copy, and 
minimize the impact on performance of the active copy. For backups, the passive copy 
allows you to back up the databases without affecting the performance or data of the 
active copy. With Exchange 2007, a node is either all active or all passive, as shown in 
“Cluster Continuous Replication (CCR)”  on page 17. With Exchange 2010 the databases, 
not the nodes, are designated as active or passive. This allow you to have several nodes 
with a mix of active and passive databases on each node. In the following figure, an 
Exchange 2010 DAG environment is shown with four mailbox databases (DB1 - DB4), with 
active and passive copies spread over three nodes (servers MBX1, MBX2, and MBX3). 

How Avamar works in a Microsoft Exchange environment

Avamar Plug-in for Exchange VSS provides a complete backup and recovery solution for 
Exchange 2007 and 2010 platforms, using the Avamar Client for Windows, Avamar Plug-in 
for Exchange VSS, and Avamar Plug-in for Exchange GLR. 

For backup and recovery for Exchange Server 2003, use the Avamar 6.0 Windows 
Exchange Database plug-in and the Windows Exchange Message plug-ins. The Avamar 6.0 
for Exchange Guide provides more information about using these legacy plug-ins.

For backup and recovery for Exchange Server 2000, use Avamar Exchange Client 4.1.
20 EMC Avamar 6.1 for Exchange VSS User Guide
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Note: Though either the older Windows Exchange Database plug-in or the current Avamar 
Plug-in for Exchange VSS can be installed on Exchange 2007, installing and using both is 
not supported. Microsoft recommends using VSS-based backup. If you need to back up a 
CCR passive node in Exchange 2007, you must use the Avamar Plug-in for Exchange VSS 
and you cannot use the Windows Exchange Database plug-in.

Avamar Administrator
Avamar Administrator is a graphical management console software application that is 
used to remotely administer an Avamar system from a supported client computer. The 
Avamar Administrator program provides access to a specific Avamar server. Backups and 
restores are configured and run through Avamar Administrator. The EMC Avamar 
Administration Guide provides complete instructions for installing and using Avamar 
Administrator.

Avamar clients and plug-ins
The following topics describe the Avamar clients and plug-ins that you can use to protect a 
Microsoft Exchange server:

◆ “Avamar Client for Windows”  on page 21
◆ “Avamar Plug-in for Exchange VSS”  on page 21
◆ “Avamar Plug-in for Exchange GLR”  on page 22
◆ “AvamarBackupUser account”  on page 22

Avamar for Exchange VSS provides advanced backup and recovery features specific to the 
capabilities and architecture of the version of Exchange you are using. Though all servers 
in an Exchange environment require both the Avamar Client for Windows and the Windows 
Exchange VSS plug-in, the configuration on each server varies depending on whether 
Exchange is deployed as stand-alone or high-availability, and granular level recovery 
options. The following illustrations describe Avamar client and plug-in installation for 
stand-alone or high-availability deployments, and granular level recovery options.

◆ “Stand-alone and single Exchange servers”  on page 23
◆ “Exchange 2007 clusters”  on page 24
◆ “Exchange 2010 DAGs (clusters)”  on page 25

Avamar Client for Windows

You must install the Avamar Client for Windows on every server in the Exchange 
environment. The Avamar Client for Windows is required for the Avamar Plug-in for 
Exchange VSS to run. In addition, you can use the Avamar Client for Windows to back up 
operating system and Exchange binary files, which may be required for disaster recovery.

Avamar Plug-in for Exchange VSS

The Avamar Plug-in for Exchange VSS uses Microsoft Volume Shadow Copy Service (VSS) 
snapshot technology to provide full database backup and recovery. 

Regardless of whether the Avamar Plug-in for Exchange GLR is installed, the Avamar 
Plug-in for Exchange VSS backs up at the storage group level (Exchange 2007) or database 
level (Exchange 2010).

Regular Avamar Exchange VSS restore without granular level recovery is at the database 
level for Exchange 2007 and 2010.
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Avamar Plug-in for Exchange GLR

The Avamar Plug-in for Exchange GLR provides the capability to perform granular level 
recovery. This plug-in enables you to mount the content database from an Avamar Plug-in 
for Exchange VSS backup to a virtual drive, usually located in the ...\avs\var\avfscache\ 
folder. You can then browse and extract individual items from the database for recovery to 
the Exchange server. 

A standard recovery allows you to recover databases or entire servers. Exchange 2007 
recovery storage groups (RSG), and Exchange 2010 recovery databases (RDB), allow 
granular level restore of individual mailboxes, mailbox folders, or mail items such as 
messages. But a standard recovery to the RSG/RDB can take a long time and use a lot of 
resources, because before you can select items for restore, you must restore entire 
databases. If you only want a few mailboxes, folders, or items, this process can take a lot 
of time and resources, and affect Exchange server performance if the data is restored to 
the original server or a folder on the original server:

◆ Time, network, and processors, to copy the backup set to the recovery location.

◆ Disk space to stage or store the RSG/RDB.

◆ Hardware resources to open the restored databases and then locate the items to 
restore.

Avamar granular level recovery can significantly reduce the time, resources, and space 
needed to recover individual mailboxes, folders, or items. With the Windows Exchange 
GLR plug-in, the backup dataset is mounted to a virtual drive, usually located in the 
..\avs\var\avfscache\ folder. The virtual drive allows you to browse the contents of the 
backup, without physically moving any files, folders, or databases. It only takes Avamar a 
minute or two to “recover” the contents to the mounted virtual drive. Once you have 
selected the items you want to recover, the request is sent to the Avamar server, and then 
the actual items are copied or transferred. Since the dataset actually retrieved is limited to 
the items you want, and not a complete database or RSG/RDB, the impact on resources 
(memory, network, processor, disk space, and server performance) is considerably 
reduced.

If you plan to perform granular level recovery with the Avamar Plug-in for Exchange GLR, 
install the plug-in on the Exchange server when you install the Avamar Plug-in for 
Exchange VSS.

When you install the Avamar Plug-in for Exchange GLR, it appears in the list of plug-ins 
when you browse for backups. However, the Avamar Plug-in for Exchange GLR is only for 
recovery. When you perform granular level recovery, it uses backups created with the 
Avamar Plug-in for Exchange VSS.

AvamarBackupUser account

Since Avamar directly accesses Exchange server and Windows server features, a special 
account is required to provide Avamar agents the appropriate domain and 
administrator-level permissions. For the Avamar Client for Windows, Avamar Plug-in for 
Exchange VSS, and Avamar Plug-in for Exchange GLR, this is accomplished by creating a 
special Exchange user account, AvamarBackupUser. You need to set up this Exchange user 
account and mailbox once in an Exchange domain. Setting up this account includes 
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adding the account to the appropriate Active Directory, Exchange, and local accounts, 
creating a mailbox for the account, and then testing and activating the account. Once this 
user account is set up and activated in the Exchange domain, then on each Exchange 
server running Avamar, Avamar services must be configured to use the 
AvamarBackupUser account. 

Because the AvamarBackupUser account is required for many Avamar Plug-in for Exchange 
VSS and Avamar Plug-in for Exchange GLR operations, you should always set up this 
account. 

Exchange cluster configuration

Avamar for Exchange VSS includes separate cluster configuration tools: one for Exchange 
2007, and another for Exchange 2010. All nodes in an Exchange cluster need the Avamar 
Client for Windows and Avamar Plug-in for Exchange VSS installed, but you only need to 
run the cluster configuration tool from one client in the cluster, an active node. 

In Exchange 2007 cluster backups, the Avamar Cluster Client is only used for active node 
backups, not passive node backups. However, the Avamar Cluster Client is required for all 
cluster recoveries from active or passive node backups. 

The specific installation steps for each supported version of Exchange server are provided 
in “Task 5: Configuring for an Exchange cluster environment”  on page 63.

Avamar for Exchange VSS provides a new feature, federated backups, that allows you to 
back up entire DAG clusters more easily. This feature is described in “Federated backups 
of Exchange 2010 DAG environments”  on page 34. To use the Avamar federated backup 
feature for Exchange 2010 DAG environments, you must configure the DAG cluster, as 
described in “Configuring for Exchange 2010 DAG environments”  on page 67.

Stand-alone and single Exchange servers 

In a stand-alone or single Exchange server environment, all mailbox databases, log files, 
and checkpoint files reside on one server such as: 

◆ Exchange 2007 stand-alone
◆ Exchange 2007 Local Continuous Replication (LCR)
◆ Exchange 2010 stand-alone

The following figure illustrates the relationship of the Avamar Server, Avamar 
Administrator Console, and Avamar client and plug-in installation on a single Exchange 
server. The Avamar Plug-in for Exchange GLR option can be installed when installing the 
Avamar Plug-in for Exchange VSS. 
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Exchange 2007 clusters

In an Exchange 2007 cluster, the Avamar for Windows client and Avamar plug-in for 
Exchange VSS must be installed on each Exchange server with the mailbox role installed. 
In addition, after installing the Avamar clients and plug-ins on each Exchange server in the 
cluster, Avamar can provide protection for the cluster with the Exchange Cluster 
Configuration tool. Through Avamar Cluster Configuration, backups are run against the 
current passive server to minimize performance impact on mail users and the active 
(production) server. The cluster configuration only needs to be run once from the active 
node, and then the settings are replicated to the passive node. 
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The following figure illustrates Avamar client and plug-in installation in Exchange 2007 
cluster environments such as: 

◆ Cluster continuous replication (CCR)
◆ Standby continuous replication (SCR)
◆ Single copy cluster (SCC)
◆ Clustered mailbox servers

“Configuring for Exchange 2007 clusters”  on page 63 provides detailed steps for 
configuring the Avamar Cluster Client on the active node after installation of the Avamar 
Windows client and Avamar plug-in for Exchange VSS on each Exchange server in the 
cluster. 

Exchange 2010 DAGs (clusters)

In an Exchange 2010 DAG, the Avamar for Windows client and Avamar plug-in for 
Exchange VSS must be installed on each Exchange server with the mailbox role installed. 
In addition, after installing the Avamar clients and plug-ins on each Exchange server in the 
cluster, use the Exchange Cluster Configuration tool to install a separate Avamar client 
resource for the DAG. This DAG client coordinates a federated backup of the passive 
databases in the DAG by allowing you to specify which databases to back up, and what 
order the backup should check the Exchange servers for a passive copy of each database. 
This allows you to minimize performance impact on mail users and the active (production) 
servers during backup. 
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The following figure illustrates Avamar client and plug-in installation in an Exchange 2010 
DAG environment.

“Configuring for Exchange 2010 DAG environments”  on page 67 provides detailed steps for 

configuring the Avamar Cluster Client on the active node after installation of the Avamar Client for 

Windows and Avamar Plug-in for Exchange VSS on each Exchange server in the cluster. 

Using Avamar with Data Domain

You can store Microsoft Exchange backups on either the Avamar server or on an EMC Data 
Domain® system. By default, backups are stored on the Avamar server. 

To store backups on a Data Domain system, use Avamar Administrator to configure the 
Data Domain system for use, then select the Data Domain system during on-demand 
backup or when configuring the dataset for a scheduled backup. The EMC Avamar 
Administration Guide provides details on how to configure the Data Domain system in 
Avamar Administrator. The individual backup procedures in this guide provide the steps 
on selecting the Data Domain system to use.

When you store Microsoft Exchange backups on a Data Domain system instead of the 
Avamar server, the Exchange database files are stored on the selected Data Domain 
system. However, the Microsoft Exchange log files and any Microsoft Exchange system 
files are stored on the Avamar server.
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Installation
Avamar can be installed in a wide variety of Exchange environments: Exchange 2007 and 
2010, stand-alone, clusters, and DAGs. The following figure provides a road map of what 
needs to be installed and configured, including cluster configuration. “Installation and 
Configuration”  on page 43 provides the actual procedures for each of these tasks.

Task 1: Install Windows Client (all Exchange servers)

Task 2: Install Exchange VSS client (all Exchange servers)

Task 3: Create Avamar Backup User account (once per Exchange domain)

Task 5: Run Cluster Configuration Tool (not applicable to standalone
installations)

Manually create Avamar Backup
User account and mailbox

Optional: Run Configuration Checker

Use Avamar Backup User
Configuration Tool

Subtask: Install Exchange GLR client

Exchange Server 2007
Configure on active

node

Exchange Server 2010
Configure the Avamar agent for DAG in the

cluster group

Configure cluster
agent in DAG

Add new node in a
DAG, cluster agent
already configured

Finish

Task 4: Configure Avamar Services to run as Avamar Backup (all servers)
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Creating and configuring AvamarBackupUser

The AvamarBackupUser account plays a crucial role in providing Avamar services access to 
and privileges on Active Directory, Exchange servers, and the local machines running the 
Avamar plug-in for Exchange. In order perform many Avamar backup and restore 
operations, you must create the AvamarBackupUser account on the Exchange domain. In 
previous versions of Avamar, creation of this account was only required for message-level 
and granular level restores. With this release of Avamar, other operations require this 
account too, so setting up the account is now a requirement. You can create the account 
with an Avamar tool or manually. You can use either of these methods, described in the 
following topics:

◆ “Using the AvamarBackupUser Configuration Tool”  on page 56 describes using the 
AvamarBackupUser Configuration Tool. 

◆ “Manually creating the AvamarBackupUser account and mailbox”  on page 58 
describes how to manually create the account, add the account to the appropriate 
user groups, and activating the AvamarBackupUser mailbox. 

The benefits of using each method are contrasted in Table 2 on page 28.

You only need to create the AvamarBackupUser account once in the Exchange domain. But 
once you have created this account on the domain and activated the AvamarBackupUser 
mailbox, you must configure the Avamar services on each Exchange server to run as 
AvamarBackupUser, as described in “Task 4: Configuring Avamar services to run as 
AvamarBackupUser”  on page 61. 

Table 2  Benefits of AvamarBackupUser creation methods

Creating the account with the Avamar Backup 
User Configuration Tool Manually creating the account

• Automatically creates the 
AvamarBackupUser mailbox. 

• Automatically adds the AvamarBackupUser 
account to the appropriate Active Directory 
accounts.

• Allows you to view what the settings are for 
security reasons.

• May be required if the AvamarBackupUser 
check mailbox test fails after using the 
Configuration tool. 

• May be required for complex parent/child 
domain configurations that might not configure 
correctly with the configuration tool. 
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The following figure illustrates the configuration of the AvamarBackupUser account on a 
stand-alone Exchange server environment. In this environment, there is only one 
Exchange server, so you would create the AvamarBackupUser account and configure 
Avamar services to run as that account all on one machine.
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The following figure illustrates the configuration of the AvamarBackupUser account on a 
multiple machine Exchange server environment. In this environment, within a domain, 
multiple machine could be a Exchange 2007 cluster environment, or Exchange 2010 DAG. 
In this example, you would create the AvamarBackupUser account once for the domain, on 
any machine, and then configure Avamar services to run as that account all on each 
machine. 

Backup
The Exchange data is stored in the Information Store, which contains the following data:

◆ The Exchange database (.edb) files include mailbox databases and public folder 
databases.

◆ The Transaction log (.log) files store database operations such as creating or 
modifying a message. Once the operations are committed, they are written to the .edb 
file.

◆ The Checkpoint (.chk) files store information about successful operations when they 
are saved to the database on the hard disk.

When you select an Information Store or any database for backup, Avamar backs up the 
database file and accompanying .log and .chk files. The backup strategy for a Microsoft 
Exchange environment should include the following backups.
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Exchange 2010 environment

Back up the following components with the Windows Exchange VSS plug-in: 

◆ Databases 

◆ Stand-alone (non-DAG) databases

◆ Active and passive databases in a DAG environment

Exchange 2007 environment

Back up the following components with the Windows Exchange VSS plug-in:

◆ Storage groups on the active and passive nodes in a CCR or SCR environment

◆ Stand-alone (non-CCR) Exchange servers

Perform these backups regularly on either an on-demand or scheduled basis.

Separate backup procedures for each type of Exchange environment are provided in 
“Backup”  on page 85. Backups can be performed on-demand, but setting up regular 
backups on a schedule is recommended.

You also can improve backup performance by using multi-streaming, as discussed in 
“Multi-streaming”  on page 36.

On-demand backup in a stand-alone environment

When you perform an on-demand backup in a stand-alone (non-clustering) environment, 
you can back up the entire Exchange server, or a specific Exchange 2007 storage group or 
Exchange 2010 database.

The following figure illustrates the backup workflow for a stand-alone Exchange 2007, 
Exchange 2007 LCR, or stand-alone Exchange 2010 environment. 
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On-demand backup in a high-availability environment

With the Windows Exchange VSS plug-in you can back up both the active node and the 
passive node in a high-availability Exchange configuration. Exchange 2007 and Exchange 
2010 differ on how they store active and passive databases.

Exchange 2007 on-demand backup in a high-availability environment
In Exchange 2007, a physical server, or node, can only contain either active or passive 
databases. To back up the passive node, back up the passive databases by the physical 
machine on which they currently reside. The following figure illustrates the workflow for a 
passive node backup of an Exchange 2007 cluster: CCR, SCR, SCC, or clustered mailbox 
servers.

To back up the active node, you select the Exchange Virtual Server (EVS) during the 
backup. 

The Avamar Windows Exchange VSS plug-in provides several ways to perform backups of a 
CCR environment: 

◆ (Recommended) Back up the physical machine name of the CCR passive node.

◆ Back up the Exchange Virtual Server (EVS) of a CCR active node, no matter where it is 
currently residing.

◆ (Not recommended) Back up the physical machine name of the CCR active node.
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Exchange 2010 on-demand backup in a high-availability environment
In Exchange 2010, a physical server (node) can contain both active and passive 
databases, but not active and passive copies of the same database. To back up all passive 
databases on a node, select all databases on the physical node, and then select the 
option to only back up the replicas (passive copies). To back up all active databases on a 
node, select all databases on the physical machine, and then select the option to only 
back up the active databases. The following figure illustrates a non-federated backup of 
all of the databases in an Exchange 2010 DAG. 

In this example, there are three Exchange servers, with active and passive copies of four 
mailbox databases. In a non-federated backup, each Exchange server is a separate 
Avamar client, so to back up all passive mailbox databases, you must perform a passive 
node backup for each physical server in the cluster. You could set up and schedule a 
backup dataset that includes the backups of all of these servers, MBX1, MBX2, and MBX3. 
However, when you run passive node backups against all servers in the cluster, you may 
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end up with multiple passive node backups of the same database. While this does not 
cause any errors for Avamar, it does consume extra server and storage resources to back 
up and store duplicate copies of the same database. “Federated backups of Exchange 
2010 DAG environments”  on page 34 describes how you can back up the entire Exchange 
2010 DAG cluster more efficiently. 

Backing up the passive node is recommended because it has less impact on Exchange 
server performance and mail users. In some environments, such as a stand-alone 
Exchange server, you may not have a choice and must back up an active database 
because the system does not have passive databases or replicas. 

Federated backups of Exchange 2010 DAG environments

In an Exchange 2010 DAG environment, passive and active databases can be replicated 
across multiple nodes for high availability. Backups are created from the passive 
databases, which can reduce the impact on production servers and resources. To back up 
all databases in the DAG environment using conventional backup, requires that all passive 
databases be backed up on each Exchange server, even if the same database has multiple 
passive copies replicated across several nodes. However, with the Avamar federated 
backup for Exchange 2010 DAGs, you can back up Exchange databases under the DAG 
name rather than each server. With a federated backup, you can specify the order that 
Avamar polls each server in the DAG for passive copies of each Exchange database. 
Avamar federated backups of Exchange 2010 DAGs use several key features: Avamar 
Cluster Client Configuration, Avamar Cluster Client Resource, and Preferred Server Order 
List. 

Avamar Cluster Client Configuration

The Avamar Cluster Client Configuration tool identifies which servers in the DAG to include 
in the Avamar Cluster Client. Run the Avamar Cluster Configuration tool after installing the 
Avamar Windows Client and Windows Exchange VSS plug-in. 

Avamar Cluster Client Resource

The Avamar Cluster Client Configuration tool creates a separate Avamar client for the DAG 
cluster. This configuration provides a separate client resource in Avamar Backup and 
Restore, which you can select instead of selecting each individual Exchange server in the 
DAG. 

Preferred Server Order List

When you perform a backup through the DAG resource, Avamar selects an Exchange 
server to back up the passive copies of the databases. Since multiple Exchange servers 
can host replicas or passive copies of the same database, a preferred server order list 
(PSOL) can be specified to tell Avamar which Exchange servers to use to back up the 
Exchange databases. When the backup order starts, Avamar backs up the passive or 
replica copies of each database, running the backups from the Exchange servers in the 
order specified in the PSOL. 

The following figure illustrates an example of a federated backup of a DAG cluster with 
three Exchange servers MBX1, MBX2, and MBX3. The cluster contains four Exchange 
databases, DB1, DB2, DB3, and DB4. Each database can only have one active copy, but 
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can have multiple passive or replica copies. In this example, there are two passive copies 
of DB1, one copy on two different Exchange servers, MBX2 and MBX3. The other 
databases DB2, DB3, and DB4 only have one passive copy each in the cluster. Only one 
copy of each database needs to be backed up. The preferred server order list specifies to 
back up databases from the Exchange servers in this order: MBX2, MBX3, and MBX1. 

The following topics explain how to perform an on-demand backup of the passive and 
active nodes:

◆ “Backing up a passive node”  on page 89
◆ “Backing up an active node”  on page 94
◆ “DAG federated backup for Exchange 2010”  on page 98
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Multi-streaming

Multi-streaming enables parallel processing of backup jobs using multiple processors. You 
can use as many as six streams. Each stream requires a separate processor core. By taking 
advantage of multi-processors, you can improve backup performance when storing 
backups on either the Avamar server or on a Data Domain system. 

You can configure multi-streaming to group backups by volume or by database. If volumes 
have varying database sizes, for example 500 GB on g:\, 100 GB on h:\, and 100 GB on 
z:\, it will take more time for streams to release the volumes with bigger sizes. For 
balanced multi-stream backup performance, choose by volume if all volumes are similar in 
overall size, or by database if all databases are similar in size. If databases are balanced 
across volumes so that each database is about the same size, and each volume contains 
about the same number of databases, then there will be little difference between grouping 
backups by database or volume.

Multi-streaming places additional demands on computer hardware and resources beyond 
the base requirements for the Windows Exchange VSS plug-in. “Multi-streaming 
recommendations”  on page 47 provides details.

A clustered environment is not required for multi-streaming, but it is highly recommended. 
When using multi-streaming, Avamar consumes much more CPU resources than when 
backing up as a single stream. If the backup is being performed on an active Exchange 
server node, this could have an impact on e-mail server performance and for end users. 

Restore
An Exchange restore can serve many different purposes. The smallest unit of granularity of 
a backup is an Exchange database, log files, and checkpoint files. Those backups can be 
used to restore entire servers, and as part of disaster recovery. Alternatively, they can be 
used to restore individual databases. They can also be used to recover items down to the 
user mailbox or individual messages. When you perform backups of a Microsoft Exchange 
environment with the Windows Exchange VSS plug-in, the following restore options are 
available. The procedures are provided in two chapters:

◆ “Exchange Database Restore and Disaster Recovery”  on page 121 provides 
procedures for stand-alone, high-availability, Exchange 2007, and Exchange 2010 
environments:

• Restore to the original location on the original Exchange server

• Restore to an alternate path

◆ “Message and Granular Level Restore”  on page 157

• Restore to the Exchange 2010 RDB or Exchange 2007 RSG on the original Exchange 
server

• Restore to an Exchange 2010 RDB or Exchange 2007 RSG on a different Exchange 
server

• Message-level recovery using the Exchange GLR plug-in
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Restoring Exchange Information Stores and mail databases

In a conventional Exchange Information Store or database restore, entire databases are 
replaced or restored. This is most useful for disaster recovery-level restores or for moving 
Exchange databases to another Exchange server or machine. At this level of restore, it is 
all or nothing. When you restore entire databases, it overwrites the current content at that 
location with the restored data. If you do not want to overwrite the current content, you 
can restore the databases to an alternate location or server, a recovery storage group 
(RSG), or a recovery database (RDB). This allows you to use Exchange server 
administration tools or browse mail folders to locate individual messages. 

The following figure illustrates a simple restore of the Exchange Information Store or 
databases in a stand-alone Exchange 2007 or 2010 environment.

In a stand-alone environment, you can also restore to an alternate location, such as a 
different directory on the same server, or to a different server, such as a backup 
(non-clustered) Exchange server, as shown in the following figure. This enables you to use 
the Avamar plug-in for Exchange VSS to restore content without directly overwriting 
existing content on the production Exchange server databases. This can be useful for 
migrating an Exchange server to a different server or machine. 
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Recovering individual mailboxes, mailbox folders, and messages

Retrieving large backups, such as the Exchange Information Store or entire databases, and 
restoring them can use a lot of network, memory, processor, and storage resources. 
Depending on the topology and architecture a site or organization uses, the restore 
operations may also affect production server performance, noticeable to mail users. 

Avamar provides several methods for recovering individual items from within an Exchange 
database, such as individual user mailboxes, mailbox folders, and messages. These 
methods offer several advantages over full server or database restores:

◆ The backup data can be restored to an alternate location without overwriting the 
existing databases or servers.

◆ Individual items can be browsed and selected from the restored data, and then 
restored to the individual’s mailbox.

With the Avamar Plug-in for Exchange VSS and the Avamar Plug-in for Exchange GLR, you 
can recover individual items with the following methods:

Granular level recovery  — Avamar mounts the backup set to a virtual drive, where you can 
browse the contents of the backup, without actually moving or copying the data. It only 
takes minutes to create this virtual drive, and does not require any significant amount of 
disk storage space. You can browse and select the data from this virtual drive, as if you 
were looking at the actual database, down to the message level. Only when you send the 
restore request to the Avamar server are actual items copied out of the backup set to the 
user’s mailbox. The items are placed in a new “Restored items” folder in the user’s 
mailbox, where the user can browse and select the items to keep, just like any other folder 
in their mailbox. Using granular level recovery saves you the time and space needed to 
browse the actual database, and saves you time and resources by only retrieving the 
items you selected, not entire databases. 

Restore to RDB or RSG  — You can also restore databases to an RDB or RSG, and then 
browse those databases to select mailboxes, user folders, or messages, to restore to the 
user’s mailbox. Restoring to an RDB or RSG allows you to browse the database offline, on a 
separate server or folder location from your online production Exchange server. While this 
allows you to browse and retrieve items without overwriting your live Exchange databases 
or user mailbox, it does require disk space, network resources, and processor resources to 
stage the databases in the RDB or RSG. When you restore to a RDB or RSG, it takes time to 
copy gigabytes or terabytes of data from one location to another. Once the backup is 
restored to the RDB or RSG, then you can browse and retrieve individual items. 

Compare the following figures, which illustrate:

◆ Restore using Avamar granular level recovery.

◆ Restore to an RSG/RDB using Avamar, and then using Microsoft Exchange tools to 
restore data from the RSG/RDB to a user mailbox.
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An RDB or RSG can only be used for recovering mailbox database data. It cannot be used 
to recover public folders. 

The steps for using granular level recovery or restoring from an RDB or RSG are described 
in the following sections:

◆ “Performing message and granular level restores”  on page 158
◆ “Restoring to an RDB on the original server”  on page 163
◆ “Restoring to an RSG on the original server”  on page 167
◆ “Restoring to an RDB on a different server”  on page 170
◆ “Restoring to an RSG on a different server”  on page 173

Disaster recovery planning and preparation
The redundancy and replication of a clustered environment reduces the need for full 
disaster recovery, or at least the urgency of an emergency. Often if one server in the cluster 
fails, the cluster fails over to another server and there is little or no noticeable disruption 
to users or service. This may give you some time to rebuild or bring online replacement 
backup servers or cluster nodes. 

However, catastrophic events such as storms, power outages, earthquakes, fire, or 
intentional sabotage of physical equipment can take multiple machines or entire sites out 
of service. Even with remote mirror sites, or other offsite backup servers, you may need to 
rebuild entire Exchange servers, not just restore databases from a recent backup to 
another Exchange server.

To ensure that you can perform a complete disaster recovery of a Microsoft Exchange 
environment if necessary, you must develop a comprehensive backup strategy to protect 
each component in the environment. Disaster recovery requires good planning, expertise 
in Exchange server installation, and regular scheduled full backups of the databases and 
servers. 

“Disaster recovery”  on page 152 describes the overall process, from rebuilding the 
Windows Servers to rebuilding the Exchange servers with Microsoft tools. 
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CHAPTER 2
Installation and Configuration

The following topics explain how to install and configure Avamar client and plug-in 
software on a supported Microsoft Exchange server in either stand-alone or 
high-availability configurations:

◆ System requirements ..............................................................................................  44
◆ Installation road map ..............................................................................................  49
◆ Optional: Using the Avamar Config Checker for Microsoft Windows..........................  51
◆ Task 1: Installing the Avamar Client for Windows .....................................................  52
◆ Task 2: Installing the Windows Exchange VSS plug-in ..............................................  54
◆ Task 3: Creating the AvamarBackupUser account.....................................................  55
◆ Task 4: Configuring Avamar services to run as AvamarBackupUser...........................  61
◆ Task 5: Configuring for an Exchange cluster environment.........................................  63
◆ Upgrade..................................................................................................................  78
◆ Uninstall .................................................................................................................  79
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System requirements
The following topics list the system requirements for Avamar in a Microsoft Exchange 
environment:

◆ “Supported configurations”  on page 44
◆ “Supported high-availability configurations”  on page 45
◆ “Hardware requirements”  on page 45
◆ “Transaction log and database file storage location requirements”  on page 46
◆ “Exchange 2007 CCR requirements”  on page 46
◆ “AvamarBackupUser account requirements”  on page 47
◆ “Avamar Plug-in for Exchange GLR plug-in requirements”  on page 47
◆ “Multi-streaming recommendations”  on page 47

Supported configurations

The following table lists the Exchange versions and operating systems supported by the 
Avamar Plug-in for Exchange VSS.

The Avamar plug-in for Windows Exchange GLR does not support Windows Server 2003, 
and has additional hardware and resource requirements. “Avamar Plug-in for Exchange 
GLR plug-in requirements”  on page 47 provides information. 

The EMC Avamar Compatibility and Interoperability Matrix, which is available on EMC 
Online Support at https://support.EMC.com/products, provides the most up-to-date and 
accurate listing of supported Exchange versions and operating systems, including support 
for older versions of Microsoft Exchange Server with previous versions of Avamar software.

Unsupported configurations

Windows Small Business Server not supported

Avamar does not support backup and recovery of Windows Small Business Server. 

Microsoft Exchange and Microsoft SharePoint Server installations on 
same machine not supported

Avamar does not support Microsoft Exchange Server and Microsoft SharePoint Server 
installed on the same machine. This configuration is not supported by Microsoft, and 
Microsoft best practices advise to install these roles on separate machines. 

Table 3  Supported Exchange Server versions and operating systems 

Exchange Server version Operating systems

2007 SP3 • Windows Server 2008 SP2 x64 
• Windows Server 2008 R2 x64 
• Windows Server 2003 SP2 x64 

2010 SP2 • Windows Server 2008 SP2 x64 
• Windows Server 2008 R2 x64 
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Hardware providers are not supported

All Avamar VSS-based backup operations use the Microsoft Software Shadow Copy 
provider, also known as the Microsoft system provider. Hardware providers are not 
supported.

Supported high-availability configurations

The following table lists the Microsoft Exchange high-availability environments that the 
Avamar Plug-in for Exchange VSS supports.

The Microsoft Exchange Server 2010 documentation recommends two networks, one for 
public traffic and one for replication traffic. Although a DAG with a single network is a 
supported configuration, it is not recommended. Using only one network connection can 
lead to unstable operations, such as databases that fail over to other systems when they 
experience network connection timeouts.

Hardware requirements

The following table lists the hardware requirements for Avamar Plug-in for Exchange VSS.

Table 4  Avamar Plug-in for Exchange VSS support for Microsoft Exchange clustering 

Exchange Server version Operating systems High availability support

2007 SP3 • Windows Server 2008 x64 R2
• Windows Server 2008 x64 SP2 

Enterprise/ DC Edition
• Windows Server 2003 x64 

Enterprise/DC Edition

• Single-copy cluster (SCC)
• LCR
• CCR
• SCR

2010 SP1 DAG • Windows Server 2008 x64 SP2
• Windows Server 2008 x64 R2

• DAGs
• Passive and active

Table 5  Hardware requirements 

Requirement Minimum

Memory (RAM) 64 MB.

Hard drive space Software installation requires at least 100 MB permanent hard drive space, 
with 1 GB recommended.
For local cache files, an additional 12 MB of permanent hard drive space is 
required for each 64 MB of physical RAM.

Network Interface 10BaseT or higher, configured with latest drivers for the platform.
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Transaction log and database file storage location requirements

Microsoft best practices recommend that you store transaction log files and database files 
on separate volumes. Also, if Microsoft best practices are not followed, and the database 
and system path are placed in a subfolder of the transaction logs folder, this is known to 
cause Avamar backup failures. Microsoft describes these best practices in the following 
documents:

◆ For Exchange 2007, “Recommendations for Configuring Storage Groups and 
Databases,” 

http://technet.microsoft.com/enus/ library/bb331954(EXCHG.80).aspx

◆ For Exchange 2010 “Understanding Storage Configuration,” 

http://technet.microsoft.com/en-us/ library/ee832792.aspx

Exchange 2007 CCR requirements

If you intend to use Microsoft Exchange 2007 with the CCR high-availability feature, you 
must configure the Windows cluster in accordance with the information presented in the 
following articles:

◆ “Installing Cluster Continuous Replication on Windows Server 2008,” which is 
available on the Microsoft TechNet website at the following URL:

http://technet.microsoft.com/en-us/library/bb629714.aspx

◆ “Using Backup to Back Up and Restore Exchange Data,” which is available on the 
Microsoft TechNet website at the following URL:

http://technet.microsoft.com/en-us/library/aa998870.aspx

This article discusses the exact conditions under which log files are removed, since 
log truncation with Exchange 2007 CCR depends on the state of the replication.

◆ “Event ID 214 is logged when you run a backup operation on a passive node after you 
install Exchange Server 2007 SP3 in an Exchange Server 2007 CCR environment”, 
which is available on the Microsoft Support website at the following URL:

http://support.microsoft.com/kb/2297394

To resolve the issue described in the article, install Exchange 2007 SP3 Update Rollup 
1 on all affected servers. You can download the update rollup at the following URL:

http://www.microsoft.com/downloads/details.aspx?FamilyID=ae45d06e-dcb7-43d8-
b1ff-d3953836425b

In addition, to browse and select items for backup in an Exchange 2007 CCR environment, 
the Avamar backup agent requires the following permissions on the passive node:

◆ Administrator
◆ Domain Administrator
◆ Domain User
◆ Exchange Install Domain Servers
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AvamarBackupUser account requirements

The AvamarBackupUser account is required to enable Avamar permissions and access to 
perform backup and recovery operations. In previous versions of the Exchange plug-ins, 
the AvamarBackupUser account was only required for message-level and granular level 
restores. However many more operations are now dependent on the AvamarBackupUser, 
so it is required for all Exchange VSS plug-in installations. “Installation road map”  on 
page 49 describes when and how to configure this account in the installation process. 

Avamar Plug-in for Exchange GLR plug-in requirements

The Avamar Plug-in for Exchange GLR plug-in places additional demands on computer 
hardware and resources beyond the base requirements for the Avamar Plug-in for 
Exchange VSS. The following table describes the requirements for the Avamar Plug-in for 
Exchange GLR.

Multi-streaming recommendations

Multi-streaming places additional demands on computer hardware and resources beyond 
the base requirements for the Avamar Plug-in for Exchange VSS. In addition, there are 
several configuration recommendations for multi-streaming.

Multi-streaming hardware and software recommendations
The following table lists hardware and software recommendations for multi-streaming. 

Table 6  Avamar Plug-in for Exchange GLR plug-in requirements 

Requirement Description

Memory (RAM) The Windows Exchange GLR plug-in requires additional memory (RAM). 
Start with1 GB of RAM. The amount of additional or total memory 
required depends on current system performance with existing memory:
• If resources are already strained and performance is slow with regular 

operations of the Avamar Plug-in for Exchange VSS, then add 
significantly more memory to support Avamar Plug-in for Exchange 
GLR operations. 

• If performance is currently adequate with regular operations of the 
Avamar Plug-in for Exchange VSS, then additional memory may not be 
required to support Avamar Plug-in for Exchange GLR operations. 

Disk staging area Additional disk space is required to provide a disk staging area to hold 
writes to the Exchange database and log files. 

Table 7  Multi-streaming hardware and software recommendations

Hardware and Software Recommendations

CPU At least one processor core per stream 

Memory (RAM) 48 GB or more

Hard disks • 1 disk drive for operating system/Exchange installation
• 1 to 2 disk drives or RAID drive group for each Exchange database
• 7200 RPM or faster disk drives

Network adapter 1 GB

Operating system Windows Server 2008 SP2 or later 
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Multi-streaming Exchange configuration recommendations
The following topics describe how to configure Microsoft Exchange for multi-streaming.

A clustered environment is not required for multi-streaming, but it is highly recommended. 
When using multi-streaming, Avamar consumes much more CPU than when backing up as 
a single stream. If the backup is being performed on an active Exchange server node, this 
could have an impact on e-mail server performance and for end users. 

Configuring Exchange 2007 SP3 for multi-streaming

Ensure that Exchange 2007 SP3 meets the following recommendations for 
multi-streaming:

◆ If using Continuous Cluster Replication (CCR), configure the environment with a 
minimum of two Exchange servers with the Mailbox role installed.

◆ Locate each storage group on a separate physical disk, or if possible, on two disks: 
one disk for the database file and one disk for the transaction logs folder.

◆ Ensure that each storage group is approximately the same size.

◆ Perform all backups from the passive node of the Exchange cluster. 

Configuring Exchange 2010 SP1 for multi-streaming

Ensure that Exchange 2010 SP1 meets the following requirements for multi-streaming: 

◆ If using Database Availability Groups (DAG), configure the environment with a 
minimum of two Exchange servers with the Mailbox role installed. 

◆ Locate each database on a separate physical disk, or if possible, on two disks: one 
disk for the database file and one disk for the transaction logs folder.

◆ Ensure that each database is approximately the same size.

◆ Perform all backups by using passive database copies. 
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Multi-streaming Avamar configuration requirements
When you specify multi-streaming options for a backup, specify a maximum of one backup 
stream for each disk in the backup set. For example:

◆ If you are backing up two databases, with each database on its own disk, specify a 
maximum of two streams.

◆ If you are backing up two databases, with each database and its logs on two disks (for 
a total of four disks), then specify a maximum of four streams.

VSS snapshot volume requirements

◆ Microsoft VSS framework allows up to 64 volumes in a VSS snapshot. When creating a 
dataset, do not include more than 64 volumes. If the number of volumes in a 
snapshot exceeds 64, backup fails and the Avamar event log lists the following error:

VSS_E_MAXIMUM_NUMBER_OF_VOLUMES_REACHED. 

◆ The VSS framework also limits the number of shadow copies to 64 per volume. If the 
number of shadow copies in a volume exceeds 64, the backup fails and the Avamar 
event log lists the following error:

VSS_E_MAXIMUM_NUMBER_OF_SNAPSHOTS_REACHED. 

Installation road map
Prior installing and configure Avamar, your Exchange server and cluster environment 
should be set up and running:

1. (Exchange 2007 clustering environments only) Install and configure the Windows 
cluster according to Microsoft guidelines.

2. Install and configure Microsoft Exchange according to Microsoft guidelines.

To install the necessary Avamar software to back up and restore a Microsoft Exchange 
environment, perform the tasks in the following table.

Table 8  Avamar installation and configuration map for Exchange servers (page 1 of 2)

Task Description

“Optional: Using the Avamar Config 
Checker for Microsoft Windows”  on 
page 51
• Perform on each Exchange server

Install and run the Avamar Config Checker to verify if your 
Windows and Exchange setups are properly configured 
for backup and recovery when using Avamar.

“Task 1: Installing the Avamar Client 
for Windows”  on page 52
• Perform on each Exchange server

Install the Avamar client for Windows on all Microsoft 
Exchange servers.
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If you need to perform an upgrade or uninstall, the following procedures provide more 
information: 

◆ “Upgrading Avamar for Exchange VSS”  on page 78
◆ “Upgrading to Exchange Cluster Client”  on page 79
◆ “Uninstalling the Avamar Cluster Client in Exchange 2010 DAGs”  on page 80
◆ “Resetting the Avamar Cluster Client in Exchange 2007”  on page 82
◆ “Uninstalling the Windows Exchange VSS plug-in”  on page 83

“Task 2: Installing the Windows 
Exchange VSS plug-in”  on page 54
• Perform on each Exchange server

Install the Avamar plug-in for Exchange VSS on each 
Microsoft Exchange server.
If you intend to perform granular level recovery, then 
select the option to install the Windows Exchange GLR 
plug-in in addition to the Windows Exchange VSS 
plug-in.

Notice: Installing the Windows Exchange GLR plug-in will 
require rebooting the server. 

“Task 3: Creating the 
AvamarBackupUser account”  on 
page 55 
• Only one time per Exchange domain

Create the AvamarBackupUser account, so that Avamar 
has sufficient Exchange and administrator privileges to 
perform all backup, browse, and restore operations. 

Notice: You only need to create the AvamarBackupUser 
account once in the Exchange domain. 

You can create this account with either of these 
methods:
• With the AvamarBackupUser Configuration Tool, as 

described in “Using the AvamarBackupUser 
Configuration Tool”  on page 56 

• Manually, as described in “Manually creating the 
AvamarBackupUser account and mailbox”  on 
page 58.

“Task 4: Configuring Avamar services 
to run as AvamarBackupUser”  on 
page 61 
• Perform on each Exchange server

Once you have created the AvamarBackupUser account 
on the domain and activated the AvamarBackupUser 
mailbox, you must configure the Avamar services on 
each Exchange server to run as AvamarBackupUser.

 “Configuring the environment for 
message-level restores”  on page 62

If you plan on performing message-level or granular level 
restores, there are additional configuration requirements 
and steps. 

“Task 5: Configuring for an Exchange 
cluster environment”  on page 63
• For Exchange 2010 DAGs, configure 

cluster agent once in the DAG, and 
on new nodes when you add them 
to the DAG.

• For Exchange 2007, configure once, 
on the active node. 

In cluster environments, run the Cluster Configuration 
tool. The tools and requirements differ for Exchange 
2007 clusters and Exchange Server 2010 DAGs. 
Complete the appropriate procedure for your Exchange 
version: 
“Configuring for Exchange 2007 clusters”  on page 63
“Configuring for Exchange 2010 DAG environments”  on 
page 67

Table 8  Avamar installation and configuration map for Exchange servers (page 2 of 2)

Task Description
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Optional: Using the Avamar Config Checker for Microsoft Windows
The Avamar Config Checker for Microsoft Windows is an optional tool that you can use 
before or after Avamar client and plug-in installation. You can use the Config Checker to 
verify if your setup is properly configured for backup and recovery when using the Avamar 
Client for Windows and Avamar plug-ins for Microsoft applications. 

Use of this tool is not required, but is highly recommended before installing the Avamar 
Client for Windows and Windows Exchange VSS plug-in. 

This section provides an overview of the Config Checker and instructions on how to 
download and install it. You can download the EMC Avamar Config Checker for Microsoft 
Windows Technical Note from https://support.EMC.com/products. This technical note 
provides complete instructions for running and uninstalling the Config Checker, as well as 
examples of HTML results files. 

The Config Checker checks and captures configuration errors that may lead to failure in 
Avamar installation, data backup, or data recovery for:

◆ Application host (operating system environment)
◆ Microsoft SharePoint
◆ Microsoft Exchange
◆ Microsoft SQL
◆ Microsoft Hyper-V

The Config Checker is only supported on English operating systems.

The Config Checker runs in the following modes:

◆ Preinstall mode:

• If Avamar is not installed.
• If upgrading from an older version of Avamar to a newer version.

◆ Postinstall mode:

• If Avamar is already installed and the same release of Avamar is selected when 
running the Config Checker.

To install the Avamar Config Checker:

1. Log in to the computer where the software will be installed.

On Windows Vista platforms, you must log in as Administrator.

2. Open a web browser and type the following URL:

http://AVAMARSERVER

where AVAMARSERVER is the network hostname as defined in DNS or the IP address of 
the Avamar server.

You are redirected to the Avamar secure web server.

3. If a security alert dialog box appears due to browser security settings, click Yes or OK 
to allow redirection to the Avamar secure web server. 

The Secure Log On page appears.
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4. Scroll down and then click the Documents and Downloads hyperlink.

The Documents and Downloads page appears.

5. Locate the link for the correct operating system for the client computer, and then click 
the corresponding install package: 

• Windows for x86 (32 bit) > Avamar_ConfigChecker_win_x86.zip

or

• Windows for x86 (64 bit) > Avamar_ConfigChecker_win_x64.zip

6. Save the install package, unzip the folder, and then run the installation program.

Task 1: Installing the Avamar Client for Windows
Install the Avamar Client for Windows on the Mailbox server role. Microsoft provides more 
information about Exchange Server roles in Exchange 2007 and 2010, respectively, in the 
following articles on the Microsoft TechNet website at http://technet.microsoft.com:

◆ “Server Role Roadmap”
◆ “Overview of Exchange 2010 Server Roles”

Windows Server 2008 and 2008 R2 with User Account Control

In Windows Server 2008, Microsoft added the User Account Control (UAC) feature. UAC is 
designed to provide additional operating system security by preventing software from 
being installed with administrator privileges, unless an administrator authorizes the 
elevated privileges.

If you start the Avamar Client for Windows installer with normal account privileges, then 
the software does not install correctly on a computer with a default implementation of 
UAC. Instead, run the installer with elevated administrative privileges. This workaround is 
included in the steps listed in “Download and install the Avamar Windows Client”  on 
page 52.

Microsoft .NET Framework 4 required

The Avamar 6.1 for Windows VSS plug-in requires Microsoft .NET Framework 4. You can 
download and install “Microsoft .NET Framework 4” from the Microsoft Download Center:

http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=17851

Download and install the Avamar Windows Client

To install the Avamar Client for Windows:

1. Log in to the Exchange server with an account that has Administrator privileges.

2. Open a web browser and go to the following URL:

http://AVAMARSERVER

where AVAMARSERVER is the network hostname (as defined in DNS) or the IP address 
of the Avamar server.

You are automatically redirected to the Avamar secure web server.
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3. If a security alert dialog box appears, click Yes or OK to allow redirection to the Avamar 
secure web server. 

The Secure Log On page appears.

4. Page down and then click the Downloads and Documents hyperlink.

The Downloads and Documentation page appears.

5. Under Windows for X86 (64 bit), click Microsoft Windows XP, 2003, Vista, 2008, 7, 
2008 R2. 

A folder listing appears in the browser.

6. Select the AvamarClient-windows-x86_64-VERSION.msi install package, where 
VERSION is the client version that you are installing.

The browser prompts you to either run the file or save it to the local computer. 

7. Start the installer, by using one of the following set of steps, depending on whether 
the User Account Control (UAC) feature is enabled on the computer:

• If UAC is disabled, open the file in place on the server, or download the file to a 
temporary directory on the computer, and then open the file.

• If UAC is enabled, perform the following steps:

a. In Windows, right-click the Command Prompt icon and select Run as 
administrator. 

b. In the command prompt window, change the working directory to the location 
of the installation package.

cd INSTALL_PATH

where INSTALL_PATH is the full path of the temporary directory that contains 
the installation package. 

c. On a single line, type the following command to launch the installer:

msiexec /i AvamarClient-windows-x86_64-VERSION.msi

where VERSION is the version number of the available install package.

When the installation wizard appears, follow the instructions to complete the 
installation.
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Task 2: Installing the Windows Exchange VSS plug-in
Install the Windows Exchange VSS plug-in on the Mailbox server role. Microsoft provides 
more information about Exchange Server roles in Exchange 2007 and 2010, respectively, 
in the following articles on the Microsoft TechNet website at http://technet.microsoft.com:

◆ “Server Role Roadmap”
◆ “Overview of Exchange 2010 Server Roles”
If a Windows Security dialog box appears during installation and indicates a possible 
security risk because of an unsigned driver or device, then click Install or Install this driver 
software anyway. The exact message varies, depending on the operating system, and may 
identify the software publisher EldoS Corporation. 

To install the Windows Exchange VSS plug-in: 

1. Log in to the Exchange server with an account that has Administrator privileges.

2. Open a web browser and go to the following URL:

http://AVAMARSERVER

where AVAMARSERVER is the network hostname (as defined in DNS) or the IP address 
of the Avamar server.

You are automatically redirected to the Avamar secure web server.

3. If a security alert dialog box appears, click Yes or OK to allow redirection to the Avamar 
secure web server. 

The Secure Log On page appears.

4. Page down and then click the Downloads and Documents hyperlink.

The Downloads and Documentation page appears.

5. Under Windows for X86 (64 bit), click Microsoft Windows XP, 2003, Vista, 2008, 7, 
2008 R2. 

A folder listing appears in the browser.

6. Select the AvamarExchangeVSS-windows-x86_64-VERSION.msi install package, 
where VERSION is the client version that you are installing.

The browser prompts you to either run the file or save it to the local computer. 

7. Start the installer, by using one of the following set of steps, depending on whether 
the User Account Control (UAC) feature is enabled on the computer:

• If UAC is disabled, open the file in place on the server, or download the file to a 
temporary directory on the computer, and then open the file.

• If UAC is enabled, perform the following steps:

a. In Windows, right-click the Command Prompt icon and select Run as 
administrator. 

b. In the command prompt window, change the working directory to the location 
of the installation package.

cd INSTALL_PATH
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where INSTALL_PATH is the full path of the temporary directory that contains 
the installation package. 

c. On a single line, type the following command to launch the installer:

msiexec /i AvamarExchangeVSS-windows-x86_64-VERSION.msi 

where VERSION is the version number of the available install package.

The EMC Avamar Plug-in for Exchange VSS Setup Wizard appears.

8. Follow the instructions to proceed through the wizard, selecting the following options, 
if necessary:

• Choose whether to install only the Windows Exchange VSS plug-in, or both the 
Windows Exchange VSS plug-in and the Windows Exchange GLR plug-in.

• If you choose to install the Windows Exchange GLR plug-in, you are prompted for a 
location for a WriteCache folder. You can accept the default location, or specify a 
different location.

The WriteCache folder specifies where to log changes made by the Exchange server 
to a dataset when it is mounted for granular level recovery. The WriteCache acts as 
a filter to store and interpret those changes and apply them in the viewing and use 
of the mounted dataset, without changing the original recovery dataset on the 
Avamar server. Generally, these log files are not very large, and they are temporary 
for the current granular level recovery session. 

9. Click Finish to complete the installation procedure.

If you selected the option to install the Windows Exchange GLR plug-in, then you are 
prompted to restart the server after installation completes.

10. Activate the client on the Avamar server. This assigns the client to a specific Avamar 
server. The EMC Avamar Administration Guide provides the steps for activating an 
Avamar client on the Avamar server. 

Task 3: Creating the AvamarBackupUser account
The AvamarBackupUser account is used for most backup and recovery operations. 

Creating the AvamarBackupUser account is required for all Avamar for Exchange 
installations. In previous releases of Avamar for Exchange, creating this account was only 
required for message-level and granular level restores, but not database restores. 

You can create the AvamarBackupUser account with an Avamar configuration tool or 
manually, by using one of the following methods:

◆ “Using the AvamarBackupUser Configuration Tool”  on page 56

◆ “Manually creating the AvamarBackupUser account and mailbox”  on page 58

The benefits of using each method are contrasted in“Benefits of AvamarBackupUser 
creation methods”  on page 28.
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AvamarBackupUser account requirements
Keep in mind the following requirements for the AvamarBackupUser account:

◆ Create the AvamarBackupUser account after you install the Avamar client for Windows 
and the Avamar plug-in for Exchange VSS on the Exchange server.

◆ If the Exchange server is deployed in a high-availability configuration using Windows 
clusters, create the AvamarBackupUser and configure the backup agent service to 
start and run as AvamarBackupUser on all nodes in the cluster, including inactive 
nodes.

◆ If the Exchange server is in the child domain of a parent-child domain, then create the 
AvamarBackupUser in the parent domain. To do this, log in to the child domain by 
using the parent domain administrator account when creating the AvamarBackupUser 
account. 

Using the AvamarBackupUser Configuration Tool 

The following procedure involves the use of the AvamarBackupUser Configuration Tool to 
create and configure the AvamarBackupUser account. However, you also can manually 
create the AvamarBackupUser account instead of using the tool. “Manually creating the 
AvamarBackupUser account and mailbox”  on page 58 provides detailed steps. 

The Messaging API (MAPI) client libraries and Collaboration Data Objects (CDO) 1.2.1 
should be installed on every server used for Exchange granular level recovery. If you use 
the AvamarBackupUser Configuration tool, the MAPI client libraries and CDO 1.2.1 must 
also be installed on the server you intend to run that tool on. When you install the MAPI 
client libraries and CDO 1.2.1, it is recommended that you perform that step before you 
create the AvamarBackupUser account. 

To create the AvamarBackupUser account by using the AvamarBackupUser Configuration 
Tool:

1. If you intend to perform message level and granular level restores, download and 
install the MAPI client libraries and CDO 1.2.1. These components are available as a 
single download from Microsoft.com at the following location:

http://www.microsoft.com/download/en/details.aspx?id=1004

2. Log in to the Exchange server by using a domain administrator account.

If the environment is an Exchange cluster, log in to any node in the cluster. 

If the Exchange server is in the child domain of a parent-child domain, log in to the 
child domain.
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3. Select Start > All Programs > EMC Avamar > Backup User Configuration Tool.

The AvamarBackupUser Configuration Tool appears.

4. In the UserName box, type a username for the AvamarBackupUser account, or use the 
default name of AvamarBackupUser.

5. In the Password box, type a password for the account. 

6. Retype the password in the Confirm Password box. 

7. In the Exchange Server, Storage group, and Mailbox store lists, select the Exchange 
server, storage group, and mailbox store for the account.

If the Active Directory forest contains more than one Exchange server, select a mailbox 
store from the Exchange server on which you are running the tool.

8. Click Check. 

Since the MAPI user account is not configured correctly, the message log should 
display messages that the AvamarBackupUser existence test and user mailbox failed. 

9. Click Create User.

The following actions occur:

• The AvamarBackupUser is created, enabled, and added to the necessary domain 
groups.

• A mailbox is created for the user.

• The local Backup Agent service starts using this user.

• The tool verifies that the login for the user works correctly.
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10. Click Check to test the new user settings. 

The message log lists a set of tests that have passed or were successful.

11. If all of the check test pass, click Close.

If the AvamarBackupUser check mailbox test fails, you may need to manually configure the 
AvamarBackupUser account, following the procedures in “Manually creating the 
AvamarBackupUser account and mailbox”  on page 58. Otherwise, if you do not create the 
AvamarBackupUser mailbox, then later run granular level recovery the operations will fail. 

12. After creating the AvamarBackupUser account once for the domain, you must follow 
the steps in Configuring Avamar services to run as AvamarBackupUser on each 
Exchange server

Manually creating the AvamarBackupUser account and mailbox

This procedure describes how to create a new user account, AvamarBackupUser, in Active 
Directory. The steps and user interface, are part of Microsoft Windows Server, not Avamar. 
If you are not familiar with creating a new user account in Active Directory, the Microsoft 
TechNet article “Create a new user account” at 
http://technet.microsoft.com/en-us/library/cc784390(WS.10).aspx provides more 
information. 
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The MAPI client libraries and CDO 1.2.1 should be installed on every server used for 
Exchange granular level recovery. If you use the AvamarBackupUser tool, the MAPI client 
libraries and CDO 1.2.1 must also be installed on the server you intend to run that tool on. 
When you install the MAPI client libraries and CDO 1.2.1, it is recommended that you 
perform that step before you create the AvamarBackupUser account. 

To create the AvamarBackupUser account and mailbox:

1. If you intend to perform message level or granular level restores, download and install 
the MAPI client libraries and CDO 1.2.1. Install these components on every server 
used for Exchange granular level recovery. These components are available as a single 
download from Microsoft.com at the following location:

http://www.microsoft.com/download/en/details.aspx?id=1004

2. Log in to the domain controller server by using an administrative user account.

If the Exchange server is in the child domain of a parent-child domain, then log in to 
the child domain by using the parent domain administrator account.

3. Select Start > Programs > Administrative Tools > Active Directory Users and Computers.

The Active Directory Users and Computers application appears. 

4. Select Actions > New > User.

The New Object - User wizard appears.

5. In the Full name text box, type the name for the account. The suggested name is 
AvamarBackupUser.

6. In the User logon name text box, type the login name for the account. The suggested 
login name is AvamarBackupUser.

7. From the list next to the User logon name text box, select the Active Directory domain 
for the account.

8. In the User logon name (pre-Windows 2000) text box, type the same login name for 
the account again.

9. Click Next.
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The next wizard screen appears.

10. In the Password and Confirm password text boxes, type and confirm the password for 
the account.

11. Select the Password never expires check box.

12. Click Next, and then complete the remaining pages of the wizard to create the account. 
The new user appears in the list of Active Directory users.

13. Right-click the new account and select Properties.

The User Properties dialog box appears.

14. Click the Member Of tab.

15. Make the account a member of the following groups:

• Backup Operators
• Domain Users
• (Exchange 2010 only) Exchange Organization Management, in Microsoft Exchange 

Security Groups
• (Exchange 2007 only) Exchange Organization Administrators
• Exchange Servers

16. Click OK. 

17. Log in to the Exchange server as an administrator.

18. From the Exchange Management Console, create an AvamarBackupUser mailbox using 
the default settings.

19. Add FullAccess permission to the AvamarBackupUser account using the Exchange 
Management Shell by typing the following command on a single command line:

get-exchangeserver -identity 'EXCHANGESERVER'|add-adpermission -user 
avamarbackupuser -ExtendedRights Receive-As,Send-As

where EXCHANGESERVER is the name of the Exchange server.
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Activating the AvamarBackupUser mailbox

When you manually create the AvamarBackupUser account, you must activate the 
AvamarBackupUser Exchange server mailbox by using one of the following methods:

◆ Access the AvamarBackupUser mailbox with an Outlook email client.
◆ Send a test email message to the AvamarBackupUser email account.

Task 4: Configuring Avamar services to run as AvamarBackupUser
The Avamar Backup Agent service and the EMC Avamar Exchange GLR service run as the 
AvamarBackupUser account.

To configure the Backup Agent service and the EMC Avamar Exchange GLR service to run as 
AvamarBackupUser:

1. Log in to the Exchange server as AvamarBackupUser or some other administrative user 
account.

2. Launch the Services application by selecting Start > Programs > Administrative Tools > 
Services.

The Services window appears.

3. Right-click the Backup Agent service in the Services list, and select Properties.

The Backup Agent Properties dialog box appears.

4. Click the Logon tab.

5. Set This account option.

6. Type the AvamarBackupUser account name in the This account text box.

If there is more than one Active Directory domain, then type the username with the 
syntax DOMAIN\ACCOUNT, where DOMAIN is the Active Directory domain for the 
AvamarBackupUser user account, and ACCOUNT is the name of the 
AvamarBackupUser account.

7. Type the password for the AvamarBackupUser account in the Password and Confirm 
Password text boxes.

8. Click OK.

The Backup Agent Properties dialog box closes. 

9. Right-click the Backup Agent service in the Services list, and select Restart.

10. If GLR is installed:

a. Repeat step 3 through step 8 for the EMC Avamar Exchange GLR service. 

b. If the EMC Avamar Exchange GLR service is already running, restart it.

If the EMC Avamar Exchange GLR service is not running, do not start or restart it.

11. Select File > Exit.
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Configuring the environment for message-level restores

If you plan to perform granular level recovery for message-level restores, then perform the 
following steps to configure the Microsoft Exchange environment after you install the 
Avamar client and plug-in software:

1. Create the AvamarBackupUser account on the Exchange server, including 
downloading and installing the MAPI client libraries and CDO 1.2.1 from Microsoft, as 
discussed in “Task 3: Creating the AvamarBackupUser account”  on page 55.

2. If the Exchange servers are running in a child domain: 

a. Use the parent domain administrator account to add parent domain administrators 
to the local administrators group on the child domain, as discussed in “Adding 
parent domain administrators on the child domain”  on page 62. 

b. If the Exchange server is running on the child domain, enable the Backup Agent 
service and the EMC Avamar Exchange service on the child domain server, as 
discussed in “Enabling Avamar services on the child domain”  on page 63.

3. Enable the Backup Agent service and the EMC Avamar Exchange service on the child 
domain server, as discussed in “Enabling Avamar services on the child domain”  on 
page 63. 

4. (Exchange 2010 only) If you plan to perform granular level recovery on an Exchange 
mailbox server that does not have the client access role installed, then install 
Exchange Server 2010 SP1 Update Rollup or later, or Exchange Server 2010 SP2. The 
Microsoft support article at http://support.microsoft.com/kb/2385194 provides 
more information and download links. 

Adding parent domain administrators on the child domain

To add parent domain administrators to the local administrators group on the child 
domain:

1. Log in to the child domain as domain administrator.

2. In the Control Panel, go to User Accounts > Manage User Accounts.

3. In the User Accounts dialog box, select the Advanced tab.

4. In the Advanced User Management section, click the Advanced button.

The Local Users and Groups window appears. 

5. Select Groups in the left pane. 

A list of local groups appears in the right pane.

6. Double-click Administrators groups in the right pane.

7. In the Administrators group dialog box, click Add.

8. Type PARENTDOMAIN\Domain Admins group, where PARENTDOMAIN is the name of 
the parent domain.

9. Click OK and apply the changes.
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Enabling Avamar services on the child domain

To enable the Backup Agent service and the EMC Avamar Exchange service on the child 
domain server when the Exchange server is running on the child domain server:

1. Log in to the child domain server by using the parent domain administrator account. 

2. Start Services with the Services.msc command, or click Start > Administrative Tools > 
Services.

3. In the Services list, double-click Backup Agent. 

The Backup Agent Properties (Local Computer) dialog box appears.

4. Click the Log On tab.

5. Ensure that This account is selected, and that the AvamarBackupUser account name is 
listed as the account.   

6. If GLR is installed, repeat step 3 through step 5 for the EMC Avamar Exchange service.

Task 5: Configuring for an Exchange cluster environment
If you are using Avamar in a Microsoft Exchange 2007 clustering environment, or federated 
backup and restore in an Exchange 2010 DAG, you need to configure the Avamar Cluster 
Client on the active node of the cluster.

You should perform these steps after you install the Avamar Client for Windows and the 
Windows Exchange VSS plug-in to the same directory on all nodes of the cluster.

Avamar for Exchange VSS provides separate tools for configuring Exchange 2007 cluster 
and Exchange 2010 DAG environments. Setup and configuration of these tools are 
described in the following sections: 

◆ “Configuring for Exchange 2007 clusters”  on page 63

◆ “Configuring for Exchange 2010 DAG environments”  on page 67

Configuring for Exchange 2007 clusters

The Avamar Cluster Client only needs to be configured on the active node of the cluster. 
Prior to performing this procedure, review these important notes:

◆ For Exchange 2007 clusters, you must install the Avamar Client for Windows and the 
Windows Exchange VSS plug-in on all nodes of the cluster. Also, they must be 
installed to the same directories on all cluster nodes. For example, if you install the 
Avamar client to C:\AVS1 on the first node, you must install the Avamar client to the 
same directory C:\AVS1 on all other nodes in the cluster. 

◆ Configuration of the Avamar Cluster Client is required in order to perform backups of 
the active node of the cluster, but is not used to perform backups of a passive node. 
However, the Avamar Cluster Client is required for all cluster recoveries from active 
node and passive node backups. 

◆ During setup, you will be asked to provide the AvamarBackupUser account name and 
password.
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To configure the Avamar Cluster Client:

1. Log in to the active node in the Exchange cluster with the AvamarBackupUser account, 
which has Administrator-level privileges.

2. Select Start > All Programs > EMC Avamar > Cluster Configuration Tool.

The Setup - Cluster Backup Agent for Windows dialog box appears.
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3. Complete the settings described in the following table. 

Table 9  Cluster Backup Agent for Windows settings  (page 1 of 2)

Setting Description

Choose a Group for Install or Update Select the correct cluster group, on which you want to 
install this software, from this list box

Group resources

Network name for backup agent 
communication

Select the network name to use for Avamar client and 
server communication. 

Note: This list contains all network names (hostnames) 
assigned to the cluster group.

Shared volume for backup agent 
configuration and log files

Select the shared external storage drive on which to 
install this software.

Note: This list contains all shared external storage drives 
assigned to this cluster group.

Var folder Specify the path to a shared network folder where the 
configuration and log files are to be placed. If a shared 
volume is available, this field is automatically filled in by 
default.
Type the UNC path or click Browse to specify an existing 
folder, or click Share Dir to create a shared folder. 

Note: The AvamarBackupUser account must have write 
access to the shared network folder.
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Registration

Do not register client now Select to prevent client registration with the Avamar 
server. 
You must manually register and activate the client before 
you can back up any data.

Administrator server host name or IP 
address

Type the Administrator server network hostname as 
defined in DNS.

Administrator server listen data port Use the default data port of 28001 for Avamar 
client/server communication unless you are using a 
different data port.
Consult the Avamar system administrator for the specific 
data port to use when registering this client.

Backup domain for this client Type the name of the Avamar domain for this client. 
The default domain is “clients.” However, the Avamar 
system administrator might have defined other domains 
and subdomains. 
Consult the Avamar system administrator for the specific 
domain to use when registering this client.
If typing a subdomain (for example, clients/MyClients), 
do not include a slash (/) as the first character. A slash 
as the first character causes an error and prevents you 
from registering this client.

Override automatic backup client name 
with this name

To use a name other than the cluster group name, type 
another name in this field for this Avamar backup client.

Plug-ins

Install following plug-ins Displays all plug-ins currently installed that will work on 
clusters. Usually, changing the defaults is not necessary.
To prevent Avamar from using a particular plug-in, select 
it and click Remove. 
To reload the complete list of plug-ins that were 
displayed when you opened this window, click Set All.

Note: The plug-in avexvss.pin must be included in this 
list. 

Cluster nodes

Perform installation on following nodes Displays a list from Windows Cluster Services of all 
nodes that are part of the cluster. Usually, changing the 
defaults is not necessary. 
If there is a node on the cluster that you do not want the 
cluster backup agent service installed on, select the item 
and then click Remove. 
To reload the complete list of nodes that are part of this 
cluster, click Set All.

Table 9  Cluster Backup Agent for Windows settings  (page 2 of 2)

Setting Description
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4. Click Configure.

You will be prompted for credentials to run the Avamar service. The following message 
will be displayed: 

Please enter credentials to enable Avamar service to access 
network shared var folder.

5. Enter the credentials for the AvamarBackupUser account. This is the account that the 
cluster client backup agent service will run under.

When installation is complete, a message box will confirm the configuration of the 
client is complete, and will list the plug-ins that were configured. After you click OK, 
the setup dialog box is displayed, and the Install button will be greyed out. 

If the Var folder is on a network share, you must enter credentials for an account that has 
full access permissions to the folder where Avamar log files are written.

Configuring for Exchange 2010 DAG environments

The Avamar Cluster Configuration Tool allows you to perform several tasks depending on 
the state of your current cluster configuration:

◆ Install the Avamar backup agent for DAG on a cluster. This initial installation will 
configure the agent on all known nodes for the cluster that are up. 

◆ Install the agent on any new nodes that have been added to the cluster after the initial 
cluster configuration.

◆ Check the current configuration of a cluster.

◆ Uninstall the Avamar backup agent on the cluster
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Configuring the Avamar Cluster Client
To configure the Avamar Cluster Client in an Exchange 2010 DAG environment:

1. Activate all physical nodes of the cluster on the Avamar server. The EMC Avamar 
Administration Guide provides more information on activating a client.

2. On a machine that is accessible to all Exchange DAG nodes, create a new folder for the 
Avamar logs and cluster configuration files for the DAG:

a. Right-click the new folder and select Properties. 

b. Click the Sharing tab.

c. Click Advanced Sharing.

The Advanced Sharing dialog box appears.

d. Select Share this folder and then specify a share name. 
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e. Click the Permissions button. 

The Permissions for <folder> dialog box appears.

f. Click Add.

The Select Users, Computers, Service Accounts, or Groups dialog box appears.

g. Click Object Types.

The Object Types dialog box appears. 

h. In the Object types list, ensure that Computers and Users are selected and then 
click OK.
Task 5: Configuring for an Exchange cluster environment 69



Installation and Configuration
i. In Enter the object names to select, enter the Avamar backup user account name 
and the name of each machine in the Exchange DAG, separated by semicolons, 
similar to the following figure.

j. Click OK. 

k. In the Permissions for <folder> dialog box, select the Avamar backup user account 
and each machine account and specify to Allow Full Control permissions for each, 
similar to the following figure. 

l. Click OK. 

3. Log in to the active node in the Exchange cluster with the AvamarBackupUser account, 
which has Administrator-level privileges.
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4. Select Start > All Programs > EMC Avamar > Cluster Configuration Tool.

The Avamar Windows Cluster Configuration wizard appears.

5. Select Install, configure, or uninstall Exchange DAG clients for Exchange VSS plug-in 
and click Next.

Note: The Configure backup cluster failover services option closes this wizard and 
opens a different version for configuring cluster services for other plug-ins that 
support Windows clusters, such as SharePoint, Oracle, or Lotus, or the Windows 
client. Consult the respective guides for these plug-ins for specific cluster 
configuration instructions.

The Configure Exchange DAG client for Exchange VSS plug-in page displays 
prerequisites.

6. Confirm that the Avamar Windows client and Avamar Exchange VSS client plug-in have 
been installed on all of the servers in the cluster, the cluster group exists, and that a 
static address has been obtained, and then click Next.
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Note: If there is no check mark for the Cluster Group prerequisite, you will be prompted 
with the option to overwrite any existing clients when performing an Install operation. 

The Configure Exchange DAG client for Exchange VSS plug-in page displays 
configuration options. 

7. Select Install the Avamar backup agent for DAG <cluster_name> and then click Next.

The Backup Nodes page appears with a list of all nodes for the cluster that are 
available. 

8. Confirm that all of the nodes are listed correctly and click Next.
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Note: If a node’s status is Down, the Avamar backup agent will not be installed. You 
can run the wizard later when the node is up and install the agent on that node by 
using the Use existing configuration to install new nodes for DAG option in the Backup 
DAG Exchange Server page. 

The Agent Setting page appears.

9. In the Exchange DAG client DAG Network table, select the network that is connected to 
the Avamar server.

10. Type the unique IP address and associated network mask for the DAG Exchange 
Server, and then click Next.
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The Server Settings page appears. 

11. Configure the Avamar server settings listed in the following table.

Table 10  Avamar Windows Cluster Configuration Avamar Server Settings

12. Click Next.

The Avamar Backup agent summary page appears.

13. Confirm that information is correct, and then click Install.

Once the installation is complete, a confirmation page appears.

14. You can view a detailed report by clicking the View Detailed Report button. Click Close 
to close the wizard.

Setting Description

Avamar server The Avamar server can be specified by name or IP address.

Client domain 
for DAG

Specifies the Avamar domain that the DAG Exchange server will be 
associated with.

Port number The data port used to communicate between the Avamar client and 
the Avamar server. This is typically left at the default value.

DAG client’s var 
directory

Specifies the location that will store the \var directory. Enter the 
UNC path of the shared var folder created previously in step 2 on 
page 68 .
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Adding a new node to an existing cluster configuration
Whenever you add a new node to a DAG where you previously configured the Avamar 
Exchange DAG agent, you must use the Avamar Windows Cluster Configuration wizard to 
install the agent on the new node. You can also use this procedure to change settings in 
an existing cluster configuration.

To add a new node to an existing cluster configuration:

1. Select Start > All Programs > EMC Avamar > Cluster Configuration Tool.

The Avamar Windows Cluster Configuration wizard appears. 

2. Select Install, configure or uninstall Exchange DAG clients for Exchange VSS plug-in 
and click Next.

The Configure cluster share volume virtual machines page appears.

3. Confirm that the Avamar Windows client and Avamar Exchange VSS client plug-in have 
been installed on all of the servers in the cluster, the cluster group exists, and that a 
static address has been obtained, and then click Next.
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Note: If there is no check mark for the Cluster Group prerequisite, you will be prompted 
with the option to overwrite any existing clients when performing an Install operation. 

The Backup DAG Exchange Server page appears. 

4. Select Use existing configuration to install new nodes for Exchange DAG 
<cluster_name> and then click Next.

The Use existing DAG configuration to install new nodes page appears. It lists the 
nodes that are already configured, and new nodes that are available. 

5. Confirm that all of the nodes are listed correctly and click Next.

The Avamar Backup agent summary page appears.
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6. Confirm that information is correct, and then click Install.

A progress bar appears. Once the installation is complete, a confirmation page 
appears.

7. You can view a detailed report by clicking the View Detailed Report button. Click Close 
to close the wizard.

Viewing the cluster configuration settings of nodes in the cluster
To check the cluster configuration of all nodes in the cluster:

1. Select Start > All Programs > EMC Avamar > Cluster Configuration Tool.

The Avamar Windows Cluster Configuration wizard appears. 

2. Select Install, configure, or uninstall Exchange DAG clients for Exchange VSS plug-in 
and click Next.

The Configure cluster share volume virtual machines page appears.

3. Click Next.
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The Backup DAG Exchange Server page appears. 

4. Select Display current configuration for Exchange DAG <cluster_name> and then click 
Next.

The Cluster configuration settings page appears. It is similar to the summary page that 
is displayed when you first set up the configuration, and lists all nodes for the cluster 
that are available. 

5. Review the settings, and then click Close.

Upgrade
The following topics explain how to upgrade Avamar components in a Microsoft Exchange 
environment:

◆ “Upgrading Avamar for Exchange VSS” on page 78
◆ “Upgrading to Exchange Cluster Client”  on page 79

Upgrading Avamar for Exchange VSS

To upgrade the Windows Exchange VSS plug-in to a newer version:

1. Uninstall the current version of the Exchange VSS plug-in:

• On Windows Server 2003, use the Add/Remove Programs feature in the Control 
Panel. 

• On Windows Server 2008, use the Programs and Features feature in the Control 
Panel.

2. Download the new version of the Avamar Client for Windows and the Windows 
Exchange VSS plug-in from the same Avamar server. This ensures that the version 
number for the client and plug-in match, which is required.
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3. Install the Avamar Client for Windows as discussed in “Task 1: Installing the Avamar 
Client for Windows”  on page 52.

4. Install the Windows Exchange VSS plug-in, and optionally the Windows Exchange GLR 
plug-in, as discussed in “Task 2: Installing the Windows Exchange VSS plug-in”  on 
page 54. 

5. If GLR is installed, update the Backup Agent service and the EMC Avamar Exchange 
GLR Service to use the AvamarBackupUser account, as discussed in “Task 4: 
Configuring Avamar services to run as AvamarBackupUser”  on page 61.

Upgrading to Exchange Cluster Client

To upgrade from a previous (Avamar 6.0 or earlier) cluster client to the Exchange cluster 
client:

1. For Exchange 2007, uninstall the Avamar cluster client, as discussed in “Resetting the 
Avamar Cluster Client in Exchange 2007”  on page 82.

For Exchange 2010, you do not need to uninstall the Avamar cluster client.

2. Uninstall the Avamar Client for Windows and Windows Exchange VSS plug-in, as 
discussed in “Uninstalling the Windows Exchange VSS plug-in”  on page 83.

3. Install the new version of the Avamar Client for Windows and Windows Exchange VSS 
plug-in, as discussed in “Task 1: Installing the Avamar Client for Windows”  on 
page 52 and “Task 2: Installing the Windows Exchange VSS plug-in”  on page 54.

4. Install the new cluster client, by using the appropriate procedures in:

• “Configuring for Exchange 2007 clusters”  on page 63

• “Configuring for Exchange 2010 DAG environments”  on page 67

Uninstall
The following topics explain how to uninstall Avamar components in a Microsoft Exchange 
environment:

◆ “Uninstalling the Avamar Cluster Client in Exchange 2010 DAGs”  on page 80
◆ “Resetting the Avamar Cluster Client in Exchange 2007”  on page 82
◆ “Uninstalling the Windows Exchange VSS plug-in”  on page 83

Note: If uninstalling in a cluster environment, reset or uninstall the Avamar Windows 
Cluster Client before uninstalling the clients on each node.
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Uninstalling the Avamar Cluster Client in Exchange 2010 DAGs 

To uninstall the Avamar Cluster Client in an Exchange 2010 DAG environment:

1. Select Start > All Programs > EMC Avamar > Cluster Configuration Tool.

The Avamar Windows Cluster Configuration wizard appears. 

2. Select Install, configure, or uninstall Exchange DAG clients for Exchange VSS plug-in 
and click Next.

The Configure cluster share volume virtual machines page appears.

3. Confirm that the Avamar Windows client and Avamar Exchange VSS client plug-in have 
been installed on all of the servers in the cluster, the cluster group exists, and that a 
static address has been obtained, and then click Next.

Note: If there is no check mark for the Cluster Group prerequisite, you will be prompted 
with the option to overwrite any existing clients when performing an Install operation. 
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The Backup DAG Exchange Server page appears. 

4. Select Uninstall the Avamar Exchange DAG client for Exchange DAG <cluster_name> 
and then click Next.

The Uninstall the Avamar backup agent page appears. 

5. Click Next and proceed through the Uninstall Summary, Progress, and Results pages.
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Resetting the Avamar Cluster Client in Exchange 2007 

Resetting the Avamar Cluster Client in Exchange 2007, like configuring the Avamar Cluster 
Client, is performed on the active node in the cluster. You do not perform the uninstall 
steps on every node in the cluster. Prior to performing this procedure, review these 
important notes:

◆ It is recommended that all cluster nodes are operational during the reset process. 

◆ During setup, you will be asked to provide the AvamarBackupUser account name and 
password.

To reset the Avamar Windows Cluster Client:

1. Log in to the active node in the Windows cluster with an account that uses 
Administrator-level privileges. 

2. From the avs\bin directory (usually C:\Program Files\avs\bin), run 
AvamarClusterConfiguration.exe.

The Setup - Cluster Backup Agent for Windows dialog box appears. 

3. In Choose a Group for Install or Update, select the cluster group you want to uninstall.

4. Click Reset. 
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Uninstalling the Windows Exchange VSS plug-in

To uninstall the Windows Exchange VSS plug-in on Windows Server 2003, use the 
Add/Remove Programs feature in the Control Panel. 

To uninstall the Windows Exchange VSS plug-in on Windows Server 2008, use the 
Programs and Features feature in the Control Panel.

When you uninstall the Windows Exchange VSS plug-in, the Windows Exchange GLR 
plug-in is uninstalled too. 
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CHAPTER 3
Backup

The following topics describe how to use the Windows Exchange VSS plug-in to perform 
on-demand and scheduled backups of a Microsoft Exchange environment:

◆ On-demand backup ................................................................................................  86
◆ Scheduled backups...............................................................................................  103
◆ Troubleshooting backups ......................................................................................  117
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On-demand backup
The following topics describe how to use the Windows Exchange VSS plug-in to perform an 
on-demand backup in a Microsoft Exchange environment:

◆ “Backing up a stand-alone environment”  on page 86
◆ “Backing up a passive node”  on page 89
◆ “Backing up an active node”  on page 94
◆ “DAG federated backup for Exchange 2010”  on page 98

Backing up a stand-alone environment 

You can back up the entire Exchange server, or a specific Exchange 2007 storage group or 
Exchange 2010 database.

To perform an on-demand backup in a stand-alone Exchange environment:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears. 

2. In the clients tree, select the Exchange server.

You cannot view clients outside the domain for the login account. To view all clients, 
log in to the root domain.

3. Click the Select for Backup tab.

A list of plug-ins installed on the selected client appears in the left pane of the Select 
for Backup tab.

When you install the Avamar Plug-in for Exchange GLR, Windows Exchange GLR 
appears in the list of plug-ins when you browse for backups. However, the Windows 
Exchange GLR plug-in is for recovery only. When you perform granular level recovery, it 
uses backups created with the Windows Exchange VSS plug-in.

4. Select the Windows Exchange VSS plug-in.

5. Choose the data to back up:

• To back up the entire Exchange server, select the check box next to Exchange 
Information Store.

• To back up a subset of the server, select Exchange Information Store, and then 
select the check box next to either the Exchange 2007 storage group, or Exchange 
2010 database in the right pane.
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The following figure illustrates the entire Exchange Server selected for backup.

6. Select Actions > Backup Now.

The On Demand Backup Options dialog box appears.

7. Select the backup retention setting:

• To automatically delete this backup from the Avamar server after a specific amount 
of time, select Retention period and then specify the number of days, weeks, 
months, or years for the retention period.

• To automatically delete this backup from the Avamar server on a specific calendar 
date, select End date and browse to that date on the calendar.

• To keep this backup for as long as this client remains active in the Avamar server, 
select No end date.
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8. Select the encryption method to use for client/server data transfer during this backup.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

9. Click More Options.

The Backup Command Line Options dialog box appears.

10. Select the Show Advanced Options check box.

Additional options appear in red.

11. Click More if you want to enter attributes. 

The following figure illustrates the Backup Command Line Options dialog box with 
Advanced Options selected.
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12. Set the plug-in options:

a. To store the backups for this dataset on a Data Domain system instead of the 
Avamar server, select Store backup on Data Domain system and select the Data 
Domain system from the list. For optimal performance, the Exchange database is 
stored on the Data Domain system but the Exchange transaction logs and system 
file are stored on the Avamar server.

b. Choose whether to enable multi-streaming by selecting or clearing the Enable 
multi-streaming check box.

c. If you enable multi-streaming, select the maximum number of streams to use for 
the backup from the Maximum number of streams list. Specify a maximum of one 
backup stream for each disk in the backup set. For example:

– If you are backing up two databases with each database on its own disk, 
specify a maximum of two streams.

– If you are backing up two databases with each database and its logs on two 
disks (for a total of four disks), then specify a maximum of four streams. 

d. From the Group by list, select whether to group the backups by Database or by 
Volume.

e. To write maximum information to log files, select Enable debugging messages. If 
selected, very large log files are created.

“Backup options”  on page 194 provides additional information on the backup 
plug-in options.

13. Click OK to close the Backup Command Line Options dialog box.

14. Click OK to close the On Demand Backup Options dialog box.

The On Demand Backup Options dialog box closes and the On Demand Backup 
Request message box appears, displaying the following messages:

Backup request initiating
Backup initiated.

15. Click Close.

Backing up a passive node

To perform an on-demand backup of a passive node in a high-availability environment:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears. 

2. In the clients tree, select the Exchange server that contains passive database copies.

You cannot view clients outside the domain for the login account. To view all clients, 
log in to the root domain.

3. Click the Select for Backup tab.

A list of plug-ins installed on the selected client appears in the left pane of the Select 
for Backup tab.
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When you install the Avamar Plug-in for Exchange GLR, Windows Exchange GLR 
appears in the list of plug-ins when you browse for backups. However, the Windows 
Exchange GLR plug-in is for recovery only. When you perform granular level recovery, it 
uses backups created with the Windows Exchange VSS plug-in.

4. Select the Windows Exchange VSS plug-in.

5. Select the Exchange Information Store with the data to back up.

When you select the Exchange Information Store, all databases in the selected 
information store are included in the backup. You can specify that the backup should 
include only passive databases later in this procedure. 

The following figure illustrates the selection of the Exchange Information Store in the 
Backup and Restore window.
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6. Select Actions > Backup Now.

The On Demand Backup Options dialog box appears.

7. Select the backup retention setting:

• To automatically delete this backup from the Avamar server after a specific amount 
of time, select Retention period and then specify the number of days, weeks, 
months, or years for the retention period.

• To automatically delete this backup from the Avamar server on a specific calendar 
date, select End date and browse to that date on the calendar.

• To keep this backup for as long as this client remains active in the Avamar server, 
select No end date.

8. Select the encryption method to use for client/server data transfer during this backup.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

9. Click More Options.

The Backup Command Line Options dialog box appears.
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10. Select the Show Advanced Options check box.

Additional options appear in red on the Backup Command Line Options dialog box, as 
shown in the following figure.

11. Set the plug-in options:

a. From the Set when backup occurs on clustered or DAG systems list, select Replica 
(passive) writer only.

This setting specifies that only databases in a passive state are included in the 
backup. The system determines which databases are in a passive state during the 
backup. You do not need to select them individually.

b. To store the backups for this dataset on a Data Domain system instead of the 
Avamar server, select Store backup on Data Domain system and select the Data 
Domain system from the list.

c. Choose whether to enable multi-streaming by selecting or clearing the Enable 
multi-streaming check box.
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d. If you enable multi-streaming, select the maximum number of streams to use for 
the backup from the Maximum number of streams list. Specify a maximum of one 
backup stream for each disk in the backup set. For example:

– If you are backing up two databases with each database on its own disk, 
specify a maximum of two streams.

– If you are backing up two databases with each database and its logs on two 
disks (for a total of four disks), then specify a maximum of four streams. 

e. From the Group by list, select whether to group the backups by Database or by 
Volume.

f. To write maximum information to log files, select Enable debugging messages. If 
selected, very large log files are created.

g. (Exchange 2010 only) Choose whether to disable the consistency check by 
selecting or clearing the Disable consistency check (recommended only if 2+ 
members in DAG) check box. 

Selecting the check box to disable the consistency check is recommended only if 
there are more than two members in the DAG. In such an environment, the 
consistency check can cause performance issues, such as I/O bottlenecks, that are 
so severe that consistency checks fail and other operations with the system are 
adversely affected.

h. If you leave consistency check enabled, then choose whether to throttle the utility 
by selecting or clearing the Enable consistency check throttling check box.

i. If you enable throttling of the consistency check, specify the following throttling 
values:

– Specify the number of I/Os between pauses when throttling in the #I/Os 
between pauses box. The value must be between 100 and 10000. The default 
value is 1000.

– Specify the duration of the pause in milliseconds in the Duration of pauses 
(ms) box. The value must be between 1000 and 60000. The default value is 
1000.

“Backup options”  on page 194 provides additional information on the backup 
plug-in options.

12. Click OK to close the Backup Command Line Options dialog box.

13. Click OK to close the On Demand Backup Options dialog box.

The On Demand Backup Options dialog box closes and the On Demand Backup 
Request message box appears, displaying the following messages:

Backup request initiating
Backup initiated.

14. Click Close.
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Backing up an active node

To perform an on-demand backup of an active node in a high-availability environment:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears. 

2. In the clients tree, select the Exchange server:

• For Exchange 2007, select the Exchange virtual server.

• For Exchange 2010, select the Exchange server that hosts active database copies. 

You cannot view clients outside the domain for the login account. To view all clients, 
log in to the root domain.

3. Click the Select for Backup tab.

A list of plug-ins installed on the selected client appears in the left pane of the Select 
for Backup tab.

When you install the Avamar Plug-in for Exchange GLR, Windows Exchange GLR 
appears in the list of plug-ins when you browse for backups. However, the Windows 
Exchange GLR plug-in is for recovery only. When you perform granular level recovery, it 
uses backups created with the Windows Exchange VSS plug-in.

4. Select the Windows Exchange VSS plug-in.

5. Select the Exchange Information Store with the data to back up.

When you select the Exchange Information Store, all databases in the selected 
information store are included in the backup. You can specify that the backup should 
include only active databases later in this procedure. 

The following figure illustrates the selection of the Exchange Information Store in the 
Backup and Restore window.
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6. Select Actions > Backup Now.

The On Demand Backup Options dialog box appears.

7. Select the backup retention setting:

• To automatically delete this backup from the Avamar server after a specific amount 
of time, select Retention period and then specify the number of days, weeks, 
months, or years for the retention period.

• To automatically delete this backup from the Avamar server on a specific calendar 
date, select End date and browse to that date on the calendar.

• To keep this backup for as long as this client remains active in the Avamar server, 
select No end date.

8. Select the encryption method to use for client/server data transfer during this backup.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

9. Click More Options.

The Backup Command Line Options dialog box appears.
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10. Select the Show Advanced Options check box.

Additional options appear in red on the Backup Command Line Options dialog box, as 
shown in the following figure.
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11. Set the plug-in options:

a. From the Set when backup occurs on clustered or DAG systems list, select Store 
(active) writer only.

This setting specifies that only databases in an active state are included in the 
backup. The system determines which databases are in an active state during the 
backup. You do not need to select them individually.

b. To store the backups for this dataset on a Data Domain system instead of the 
Avamar server, select Store backup on Data Domain system and select the Data 
Domain system from the list. For optimal performance, the Exchange database is 
stored on the Data Domain system but the Exchange transaction logs and system 
file are stored on the Avamar Server.

c. Choose whether to enable multi-streaming by selecting or clearing the Enable 
multi-streaming check box.

d. If you enable multi-streaming, select the maximum number of streams to use for 
the backup from the Maximum number of streams list. Specify a maximum of one 
backup stream for each disk in the backup set. For example:

– If you are backing up two databases with each database on its own disk, 
specify a maximum of two streams.

– If you are backing up two databases with each database and its logs on two 
disks (for a total of four disks), then specify a maximum of four streams.

e. From the Group by list, select whether to group the backups by Database or by 
Volume.

f. To write maximum information to log files, select Enable debugging messages. If 
selected, very large log files are created.

g. Choose whether to disable the consistency check by selecting or clearing the 
Disable consistency check (recommended only if 2+ members in DAG) check box. 

Selecting the check box to disable the consistency check is recommended only if 
there are more than two members in the DAG. In such an environment, the 
consistency check can be safely disabled.

h. If you leave the consistency check enabled, then choose whether to throttle the 
utility by selecting or clearing the Enable consistency check throttling check box.

i. If you select Enable consistency check throttling, specify the following throttling 
values:

– Specify the number of I/Os between pauses when throttling in the #I/Os 
between pauses box. The value must be between 100 and 10000. The default 
value is 1000.

– Specify the duration of the pause in milliseconds in the Duration of pauses 
(ms) box. The value must be between 1000 and 60000. The default value is 
1000.

“Backup options”  on page 194 provides additional information on the backup 
plug-in options.

12. Click OK to close the Backup Command Line Options dialog box.
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13. Click OK to close the On Demand Backup Options dialog box.

The On Demand Backup Options dialog box closes and the On Demand Backup 
Request message box appears, displaying the following messages:

Backup request initiating
Backup initiated.

14. Click Close.

DAG federated backup for Exchange 2010 

The Windows Exchange VSS plug-in allows you to back up passive (replica) databases in a 
DAG without running a backup of each node. Running an on-demand DAG federated 
backup is similar to a standard backup, except for a few key differences.

Before backup, you must configure the DAG for backups with the Avamar Cluster Client 
Configuration tool. The steps are described in “Configuring the Avamar Cluster Client”  on 
page 68.

When you select which client to back up, you select the cluster client resource, not 
individual servers in the DAG, for backup. The Avamar Cluster Client will automatically 
locate and back up mailbox databases from the passive copies in the DAG.

When you configure the backup, you can specify a preferred server order list (PSOL), which 
tells the Avamar Cluster Client the order to poll each server in the DAG for passive copies 
to back up. 

To perform an on-demand federated backup of an Exchange 2010 DAG:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears. 

2. In the clients tree, select the Exchange DAG.

The Exchange DAG name is the name you specified when configuring the Avamar 
Cluster Client. The Exchange DAG will be listed as a client, just like each individual 
node is listed as a separate client. The icon is the same, and in the client tree 
hierarchy the DAG client and individual server node clients appear as peers on the 
same level. 

You cannot view clients outside the domain for the login account. To view all clients, 
log in to the root domain.

3. Click the Select for Backup tab.

A list of plug-ins installed on the selected client appears in the left pane of the Select 
for Backup tab.

4. Select the Windows Exchange VSS plug-in.

5. Select the Exchange Information Store with the data to back up.

When you select the Exchange Information Store, all databases in the selected 
information store are included in the backup. 
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The following figure illustrates the selection of the Exchange DAG client av-exch14dag, 
the Windows Exchange VSS plug-in, and the Exchange Information Store in the Backup 
and Restore window.

6. Select Actions > Backup Now.

The On Demand Backup Options dialog box appears.
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7. Select the backup retention setting:

• To automatically delete this backup from the Avamar server after a specific amount 
of time, select Retention period and then specify the number of days, weeks, 
months, or years for the retention period.

• To automatically delete this backup from the Avamar server on a specific calendar 
date, select End date and browse to that date on the calendar.

• To keep this backup for as long as this client remains active in the Avamar server, 
select No end date.

8. Select the encryption method to use for client/server data transfer during this backup.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

9. Click More Options.
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10. Select the Show Advanced Options check box.

Additional options appear in red on the Backup Command Line Options dialog box, as 
shown in the following figure.

11. Set the plug-in options:

a. In the Federated Backup Preferred server order list, specify which servers to use to 
back up the Exchange databases. Specify the server name only (not the FQDN), 
separated by commas. In the previous example of the Backup and Restore window, 
the servers in the DAG av-exch14dag were exch14-1 and exch14-2. You 
would not specify the FQDN exch14-1.exch14.CorpExch.example.com in the PSOL. 
“Federated backups of Exchange 2010 DAG environments”  on page 34 provides 
more information. 

b. To store the backups for this dataset on a Data Domain system instead of the 
Avamar server, select Store backup on Data Domain system and select the Data 
Domain system from the list.
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c. Choose whether to enable multi-streaming by selecting or clearing the Enable 
multi-streaming check box.

d. If you enable multi-streaming, select the maximum number of streams to use for 
the backup from the Maximum number of streams list. Specify a maximum of one 
backup stream for each disk in the backup set. For example:

– If you are backing up two databases with each database on its own disk, 
specify a maximum of two streams.

– If you are backing up two databases with each database and its logs on two 
disks (for a total of four disks), then specify a maximum of four streams.

e. From the Group by list, select whether to group the backups by Database or by 
Volume.

f. To write maximum information to log files, select Enable debugging messages. If 
selected, very large log files are created.

g. Choose whether to disable the consistency check by selecting or clearing the 
Disable consistency check (recommended only if 2+ members in DAG) check box. 

Selecting the check box to disable the consistency check is recommended only if 
there are more than two members in the DAG. In such an environment, the 
consistency check can be safely disabled.

h. If you leave the consistency check enabled, then choose whether to throttle the 
utility by selecting or clearing the Enable consistency check throttling check box.

i. If you select Enable consistency check throttling, specify the following throttling 
values:

– Specify the number of I/Os between pauses when throttling in the #I/Os 
between pauses box. The value must be between 100 and 10000. The default 
value is 1000.

– Specify the duration of the pause in milliseconds in the Duration of pauses 
(ms) box. The value must be between 1000 and 60000. The default value is 
1000.

“Backup options”  on page 194 provides additional information on the backup 
plug-in options.

12. Click OK to close the Backup Command Line Options dialog box.

13. Click OK to close the On Demand Backup Options dialog box.

The On Demand Backup Options dialog box closes and the On Demand Backup 
Request message box appears, displaying the following messages:

Backup request initiating
Backup initiated.

14. Click Close.
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Scheduled backups
In a stand-alone environment, you can schedule backups for the entire Exchange server. 

In a high-availability environment, such as Exchange 2007 Cluster continuous replication 
(CCR), Standby continuous replication (SCR), Single copy cluster (SCC), clustered mailbox 
servers, you must schedule multiple backups:

◆ One backup for the active node

◆ One passive node backup for each physical server in the cluster, even if the physical 
server is currently an active node

Since the role of a node may change from active to passive, this scheduled backup 
strategy ensures that each physical server is backed up when it is the passive node.

In an Exchange 2010 DAG environment, you can schedule backups for the entire cluster 
with a federated backup. 

To use the Windows Exchange VSS plug-in to perform scheduled backups of an Exchange 
environment:

1. Create a dataset for the backups, as discussed in “Creating a dataset”  on page 104.

2. Create a schedule for backups, as discussed in “Creating a schedule”  on page 108.

3. Create a group for the backups, as discussed in “Creating a group”  on page 113. 
During the group creation process, you:

a. Assign the new dataset to the new group.

b. Assign a schedule to the new group.

c. Assign a retention policy to the new group.

d. Add the Exchange server to the new group.

4. Enable scheduling for the group, as discussed in “Enabling scheduled backups”  on 
page 117.

A thorough discussion of groups, group policy, datasets, schedules, and retention policies 
is beyond the scope of this guide. The EMC Avamar Administration Guide provides 
additional information.

Microsoft VSS limitation of 64 volumes in a snapshot

Microsoft VSS technology allows up to 64 volumes in a VSS snapshot. When creating a 
dataset, do not include more than 64 volumes. If more than 64 volumes are included in a 
snapshot, backup will fail immediately. The Avamar event log will list an error, 
VSS_E_MAXIMUM_NUMBER_OF_VOLUMES_REACHED. 
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Creating a dataset

To create a dataset for scheduled backups:

1. In Avamar Administrator, select Tools > Manage Datasets.

The Manage All Datasets window appears.

2. Click New. 

The New Dataset dialog box appears. 

3. In the Name box, type a name for the dataset.

The name can include alphanumeric characters (A-Z, a-z, 0-9) and the following 
special characters: period (.), hyphen (-), underscore (_). Do not use Unicode 
characters or any of the following characters:

` ~ ! @ # $ % ^ & * ( ) = + [ ] { } | \ / ; : ’ ” < > , ?
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4. On the Source Data tab, choose whether the dataset includes data from all plug-ins 
installed on the client or only specific plug-ins installed on the client:

• To include data from all plug-ins installed on the client, select Select All Data for All 
Local File Systems.

• To include data from only specific plug-ins installed on the client, select Enter 
Explicitly. For example, select Windows Exchange VSS, as shown in the previous 
figure.

5. If you chose Enter Explicitly, you can customize the dataset by including a subset of 
the installed plug-ins or by specifying individual files or directories:

a. To remove a plug-in from the dataset, select the plug-in from the list in the bottom 
portion of the New Dataset dialog box, and then click - (Remove From List). Repeat 
this step as necessary.

b. To add a plug-in to the dataset, select the plug-in from the Select Plug-In Type list, 
and then click + (Add to List). Repeat this step as necessary.

c. (Optional) To limit the dataset to a specific Exchange 2007 storage group or 
Exchange 2010 database, type the full path or browse to the storage group or 
database.

When typing a file path in the text box, do not use any of the following characters: 
~!@$^%(){}[]|,`;#\/:*?<>'”&. 

To browse to the storage group or database:

1. Click ... (Browse for files and/or folders) to open the Select Files And/Or Folders 
dialog box.

2. Select the client from the Clients tree.

3. In the directory tree, select the storage group or database to include in the 
dataset, similar to the following figure.

4. Click OK.

The Select File And/Or Folder dialog box closes, and the New Dataset dialog 
box lists the storage group or database that you selected.

6. Skip the Exclusions and Inclusions tabs. The Windows Exchange VSS plug-in does not 
support include or exclude lists in datasets.
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7. Click the Options tab and set the plug-in options:

a. Select the Windows Exchange VSS plug-in from the Select Plug-In Type list.

The plug-in options appear on the Options tab, as shown in the following figure. 
These are the same options available in the On Demand Backup Options and 
Backup Command Line Options dialog boxes when you configure an on-demand 
backup, as described in “On-demand backup”  on page 86.

b. (High-availability environments only) From the Set when backup occurs on 
clustered or DAG systems list, choose the databases to include in the backup:

– To include only databases in a passive state, select Replica (passive) writer 
only.

– To include only databases in an active state, select Store (active) writer only.

– To include all databases regardless of state, select Always. 

The system determines which databases are in a passive or active state during the 
backup. You do not need to select them individually.

c. To store the backups for this dataset on a Data Domain system instead of the 
Avamar server, select Store backup on Data Domain system and select the Data 
Domain system from the list.

d. To use multiple processors to back up multiple targets in parallel, select Enable 
multi-streaming, and then select the maximum number of streams to use for the 
backup from the Maximum number of streams list. Specify a maximum of one 
backup stream for each disk in the backup set. For example:

– If you are backing up two databases with each database on its own disk, 
specify a maximum of two streams.

– If you are backing up two databases with each database and its logs on two 
disks (for a total of four disks), then specify a maximum of four streams. 
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e. To specify advanced backup options, select the Show Advanced Options check 
box. Otherwise, proceed to step 8 on page 108.

Additional options appear in red on the Options tab in the New Dataset dialog box, 
as shown in the following figure. 

f. To write maximum information to log files, select Enable debugging messages. If 
selected, very large log files are created.

g. If you enabled multi-streaming, choose whether to group the backups by Database 
or by Volume using the Group by list.

h. Choose whether to disable the consistency check by selecting or clearing the 
Disable consistency check (recommended only if 2+ members in DAG) check box. 

Selecting the check box to disable the consistency check is recommended only if 
there are more than two members in the DAG. In such an environment, eseutil can 
be safely disabled.

i. If you leave the consistency check enabled, then choose whether to throttle the 
utility by selecting or clearing the Enable consistency check throttling check box.
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j. If you enable throttling of the consistency check, specify the following throttling 
values:

– Specify the number of I/Os between pauses when throttling in the #I/Os 
between pauses box. The value must be between 100 and 10000. The default 
value is 1000.

– Specify the duration of the pause in milliseconds in the Duration of pauses 
(ms) box. The value must be between 1000 and 60000. The default value is 
1000.

“Backup options”  on page 194 provides additional information on the backup 
plug-in options.

8. Click OK to close the New Dataset dialog box, and then click OK to close the Manage 
All Datasets dialog box.

Creating a schedule

The steps to create a schedule depend on whether you are creating a daily, weekly, or 
monthly schedule. The following procedures describe each of these options:

◆ “Creating a daily schedule”  on page 108
◆ “Creating a weekly schedule”  on page 110
◆ “Creating a monthly schedule”  on page 111

Creating a daily schedule
To create a daily schedule:

1. In Avamar Administrator, select Tools > Manage Schedules.

The Manage All Schedules window appears.

2. Click New. 

The New Schedule dialog box appears.

3. In the Name box, type a name for the schedule.

Do not use any of the following characters in the name: ~!@$^%(){}[]|,`;#\/:*?<>'"&.
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4. Under Repeat this schedule, select Daily.

5. For each time at which the schedule should run each day, use the Select Daily Times 
lists to select the time and click Add to add the time to the Scheduled Times list.

To remove a time from the Scheduled Times list, select the time and click Remove.

6. Limit the duration of scheduled system activities to prevent job overlap by selecting a 
time limit from the Limit each run to (hours) list.

7. From the Delay until list, select the date when the schedule should take effect.

To make a schedule effective immediately, select the current date from the list.

Server workload affects the actual start time for an activity. In addition, the first time 
that a backup is performed for any client, the backup is allowed to continue past the 
specified end time. This is because initial backups can take significantly longer than 
subsequent backups of the same client.

8. Choose when to discontinue the schedule:

• To enable a schedule to run indefinitely, select No End Date.

• To discontinue a schedule on a specific date, select End after and then select a 
date from the list.

9. Ensure that the date and time listed next to Next Run Time near the top of the New 
Schedule dialog box are correct.

10. Click OK.
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Creating a weekly schedule
To create a weekly schedule:

1. In Avamar Administrator, select Tools > Manage Schedules.

The Manage All Schedules window appears.

2. Click New. 

The New Schedule dialog box appears.

3. In the Name box, type a name for the schedule.

Do not use any of the following characters in the name: ~!@$^%(){}[]|,`;#\/:*?<>'"&.

4. Under Repeat this schedule, select Weekly.

5. Select the check box next to the days of the week on which the schedule should run.
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6. Define the activity operating hours by using the Earliest start time and End no later 
than boxes. You can type the times, or select the time and use the arrow buttons to 
change the times.

Server workload affects the actual start time for an activity. In addition, the first time 
that a backup is performed for any client, the backup is allowed to continue past the 
specified end time. This is because initial backups can take significantly longer than 
subsequent backups of the same client.

7. From the Delay until list, select the date when the schedule should take effect.

To make a schedule effective immediately, select the current date from the list.

8. Choose when to discontinue the schedule:

• To enable a schedule to run indefinitely, select No End Date.

• To discontinue a schedule on a specific date, select End after and then select a 
date from the list.

9. Ensure that the date and time listed next to Next Run Time near the top of the New 
Schedule dialog box are correct.

10. Click OK.

Creating a monthly schedule
To create a monthly schedule:

1. In Avamar Administrator, select Tools > Manage Schedules.

The Manage All Schedules window appears.

2. Click New. 

The New Schedule dialog box appears.

3. In the Name box, type a name for the schedule.

Do not use any of the following characters in the name: ~!@$^%(){}[]|,`;#\/:*?<>'"&.
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4. Under Repeat this schedule, select Monthly.

5. Choose whether to repeat the activity on a specific calendar date or on a designated 
day of the week each month:

• To repeat the activity on a specific calendar date, select Day of every month, and 
then select the day from the list. 

• To repeat the activity on a designated day of the week each month, select The ... of 
every month and then select the day from the lists.

6. Define a logical window of time during which the system activity can take place by 
using the Earliest start time and End no later than boxes. You can type the times, or 
select the time and use the arrow buttons to change the times.

Server workload affects the actual start time for an activity. In addition, the first time 
that a backup is performed for any client, the backup is allowed to continue past the 
specified end time. This is because initial backups can take significantly longer than 
subsequent backups of the same client.

7. From the Delay until list, select the date when the schedule should take effect.

To make a schedule effective immediately, select the current date from the list.

8. Choose when to discontinue the schedule:

• To enable a schedule to run indefinitely, select No End Date.

• To discontinue a schedule on a specific date, select End after and then select a 
date from the list.

9. Ensure that the date and time listed next to Next Run Time near the top of the New 
Schedule dialog box are correct.

10. Click OK.
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Creating a group

To create a group for scheduled backups:

1. In Avamar Administrator, click the Policy launcher button.

The Policy window appears.

2. Select the Groups tab.

3. In the left pane, select the Avamar domain to which the group should belong.

4. Select Actions > New Group.

The New Group wizard appears.

5. In the Name box, type a name for the new group.

Do not use any of the following characters in the group name: 
~!@$^%(){}[]|,`;#\/:*?<>'”&.
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6. Clear the Disabled check box to use this group to perform scheduled client backups. 

Selecting the check box disables backups for the group.

7. From the Encryption method list, select the encryption method for client/server 
network communications. This is the method that all clients in the group use unless 
the method is overridden at the client level.

The exact encryption technology and bit strength used for any given client-server 
connection depends on a number of factors, including the client platform and Avamar 
server version. The EMC Avamar Product Security Guide provides additional 
information.

8. Choose whether to use the assigned schedule for the group or override the assigned 
schedule:

• To use the assigned schedule, leave the Override Schedule check box clear.

• To override the schedule:

a. Select Override Schedule.

Selecting Override Schedule enables the Skip Next Backup and Run Next 
Backup Once options.

b. Choose whether to skip the next scheduled backup entirely or to perform the 
next scheduled backup one time only by selecting either Skip Next Backup or 
Run Next Backup Once.

9. Click Next.

The next New Group wizard screen appears with dataset information.

10. From the Select An Existing Dataset list, select the dataset that you defined during 
“Creating a dataset”  on page 104.
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11. Click Next.

The next New Group wizard screen appears with schedule information.

12. From the Select An Existing Schedule list, select a schedule for the group.

You cannot edit schedules from this screen. Detailed schedule properties are shown 
so that you can review them prior to making a selection. The EMC Avamar 
Administration Guide provides additional information about editing schedule 
properties.

13. Click Next.

The next New Group wizard screen appears with retention policy information.

14. From the Select An Existing Retention Policy list, select a retention policy for the 
group.
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You cannot edit retention policies from this screen. Detailed retention policy 
properties are shown so that you can review them prior to making a selection. The 
EMC Avamar Administration Guide provides additional information about editing 
retention policy properties.

15. Click Next.

The final New Group wizard screen appears with a tree of domains and clients.

16. Select the clients to include in the list:

• In a stand-alone environment, select the Exchange server.

• For a passive node backup in a high-availability environment, select the Exchange 
server with the passive database copies.

• For an active node backup in a high-availability environment, select either the 
Exchange virtual server (Exchange 2007) or the Exchange server with the active 
database copies (Exchange 2010).

• For DAG federated backups, select the Exchange DAG client.

17. Click Finish.

The New Group wizard closes and the new group appears in the Policy window.
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Enabling scheduled backups

Note: Complete these steps only if the group is already shown as disabled.

To ensure that the group is enabled for scheduled backups:

1. In Avamar Administrator, click the Policy launcher button.

The Policy window appears.

2. On the Policy Management tab, select the Groups tab.

3. Select the group that you created in “Creating a group”  on page 113.

4. Select Actions > Group > Disable Group.

This clears the Disable Group option on the Actions > Group menu.

A confirmation message appears.

5. Click Yes to enable this group.

Troubleshooting backups
The following topics explain issues that may occur during the backup process for an 
Exchange environment, as well as steps to resolve or work around the issues.

Unmounted or offline databases are skipped

If a database is unmounted or offline when a backup is performed, the backup skips that 
database. Generally, this is not an issue because databases that are not mounted are not 
in production. 

System Writer failure event in the Application log

A successful backup using the Windows Exchange VSS plug-in may log an event in the 
Application log indicating a System Writer failure. The Windows Exchange VSS plug-in 
does not use the System Writer, so you can safely ignore the error.
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Backups may fail when drive letters and volumes are mixed

If you configure Exchange to point to the same database files through different paths, 
such as volume G:\ and C:\MOUNTPOINT, then backup may fail.

To avoid this backup failure, configure Exchange databases to point to the database files 
using the same path. For example, if you have three databases, DB1, DB2, and DB3, that 
are at the same location as either drive G:\ or on C:\mountpoint, then use one—but not 
both—of the following example paths:

◆ G:\DB1, G:\DB2, G:\DB3
◆ C:\<mountpoint>\DB1,C:\<mountpoint>\DB2,C:\<mountpoint>\DB3

Event log error: Microsoft Exchange Replication service VSS Writer failed

A failed or canceled backup of a passive copy may produce an error in the Event log that 
the Microsoft Exchange Replication service VSS Writer failed. However, this condition may 
be temporary. If this backup failure and error occur, there are two solutions:

◆ If you need to perform an immediate backup, stop and then restart the Microsoft 
Exchange Replication Service writer.

◆ If you wait about 15 minutes, the Exchange server automatically corrects this 
condition.

NTFS softlinks are skipped by default in Windows VSS backups

Avamar Windows File System backups using the Avamar Windows VSS client will skip 
NTFS softlinks (also known as symbolic links or symlinks). In addition, if an Exchange, 
SharePoint, or Windows Server is configured to save either database files or log files to a 
softlink path, backup will fail. EMC plans to fix this in a future release.

Backups may time out for large Exchange databases when using the 
default time out value

The default time out for how long to wait for snapshot creation, before failing the backup is 
5 minutes. For large Exchange servers or databases, backups may fail because VSS 
snapshot creation may require more than 5 minutes. You can use a command line flag, 
--vss-snapshot-timeout=MINUTES to specify more time to wait for VSS snapshot creation 
before timing out and failing the backup. You can set this flag either in the Backup 
Command Line Options Advanced Options Attributes, or by creating an avexvss.cmd file 
and adding the flag. This flag must be set in each DAG node where the DAG client is 
installed. 

To add -vss-snapshot-timeout flag in Backup Command Line Options dialog box:

1. Set up an on-demand or scheduled backup, as described in “On-demand backup”  on 
page 86 or “Scheduled backups”  on page 103.

2. When you reach the Backup Options dialog box, click More Options.

3. In the Backup Command Line Options dialog box, click Show Advanced Options.

4. In Enter Attribute field, type --vss-snapshot-timeout, and in Enter Attribute Value, type 
the number <X> where X is the number of minutes you want Avamar to wait for the VSS 
snapshot to be created. 
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5. Click the + button, and then click OK as needed to close dialog boxes.

6. Run the on-demand backup or save the backup settings for the dataset if it is a 
scheduled backup. 

To specify -vss-snapshot-timeout flag by using an avexvss.cmd file:

1. If an avexvss.cmd file does not already exist, create the file in the avs\var folder on 
each node of the DAG where the DAG client is installed. 

2. In the avexvss.cmd file, add the following line:

--vss-snapshot-timeout=X

where X is the number of minutes you want Avamar to wait for the VSS snapshot to be 
created. 

3. Add this avexvss.cmd file with VSS snapshot timeout settings to each DAG node in the 
DAG client. 
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CHAPTER 4
Exchange Database Restore and Disaster 
Recovery

The following topics explain how to restore Exchange databases and perform disaster 
recovery-level restores in a Microsoft Exchange environment:

◆ Restore types and procedures ...............................................................................  122
◆ Finding a backup for restore ..................................................................................  122
◆ Restoring from active copy or active node backups................................................  127
◆ Restoring from passive node backups ...................................................................  134
◆ Restoring from a DAG federated backup ................................................................  142
◆ Restoring a database to a different location ..........................................................  146
◆ Resuming replication and restarting cluster resources...........................................  150
◆ Disaster recovery...................................................................................................  152
◆ Troubleshooting database restores .......................................................................  153
Exchange Database Restore and Disaster Recovery 121



Exchange Database Restore and Disaster Recovery
Restore types and procedures
Avamar for Exchange VSS plug-in provides many levels of restore, such as restoring all 
files on an Exchange server, restoring databases, or down to restoring individual 
messages in a user mailbox. 

Database and disaster recovery level restores

This chapter describes how to restore entire Exchange storage groups (Exchange 2007) 
and databases (Exchange 2010). When you restore a storage group/database, it generally 
overwrites the current database unless you restore to an alternate Exchange server. This is 
most useful when an entire Exchange server or database has been lost or corrupted, or as 
part of a disaster recovery. 

Message level and granular level restores

When you need to retrieve individual user mailboxes, user mail folders, or messages, you 
can do so without overwriting entire mail databases. You can restore a storage group to an 
Exchange 2007 RSG or database to an Exchange 2010 RDB, and then use Exchange server 
management tools or Avamar Granular Level Recovery (GLR) to select and restore 
individual mailboxes, folders, or messages. Those restore procedures are provided in the 
next chapter, “Message and Granular Level Restore”  on page 157.

Finding a backup for restore
You can find Avamar client backups for a restore either by date or by files and folders. 
Some plug-ins, content, or restore types use only one method to locate backups. When 
only one method applies, it is noted within the restore procedure. All restore procedures 
start with finding the backup. 

The following topics provide details on finding a backup for a restore:

◆ “Finding a backup by date”  on page 122
◆ “Finding a backup by file or folder”  on page 123
◆ “How to find a backup by date”  on page 123
◆ “How to find a backup by file or folder”  on page 124

Finding a backup by date

You should locate backups by date when:

◆ All Exchange data to restore is backed up in a single backup set. 

◆ The exact path or name of the file, folder, or data you want to restore is unknown. 

◆ The content from a backup you want to restore is before a specific date or event. For 
example, you know approximately when a file or folder was lost or corrupted, and 
need to find the last backup before that date.

◆ The specific types of backups are known. For example, you run scheduled disaster 
recovery backups every Wednesday and Saturday night, and you run full volume 
backups daily. If you need to rebuild a server, you can select the disaster recovery 
backup with the date closest to the event that caused the loss of data. 
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Finding a backup by file or folder

You should locate backups by the specific files or folders contained within each backup 
when:

◆ Each database is backed up in a separate backup set. For example, you know that 
\\Server_Name\storage group\Database_1 is backed up in one backup set and 
\\Server_Name\storage group\Database_2 is backed up in another backup set. If you 
know the content you need is in Database_2, or is the entire Database_2 database, 
then you can specify the path or browse to the Database_2 folder.

◆ You want to see multiple versions of the same file.

◆ The date of the backup or what was saved in a backup is unknown, but you know the 
path to the Exchange server, machine name, or database to recover. 

How to find a backup by date
To find backups for a restore by date:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. In the clients tree, select the client on which the backup was performed:

• In a stand-alone environment, select the Exchange server.

• If you are restoring from a passive node backup, select the Exchange server that 
contained the passive database copies at the time of backup, since the passive 
copy could be on a different node than it was when backed up.

• If you are restoring from an active node backup in Exchange 2007, select the 
Exchange virtual server.

• If you are restoring from an active node backup in Exchange 2010, select the node 
on which the backup was performed.

• If you are restoring from a DAG federated backup, select the DAG client. 

You cannot view clients outside the domain for the login account. To view all clients, 
log in to the root domain.

3. Click the Select for Restore tab. 

4. Click the By Date tab.

5. Select a backup from the calendar:

a. Use the year and month navigational arrows to browse to a backup.

Dates highlighted by yellow indicate a valid backup was performed on that date.

b. Click a date highlighted by yellow.

A list of backups that were performed on that date appears in the Backups table next 
to the calendar.
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6. Select the backup to restore from the Backups table.

7. Select the data to restore from the Contents of Backup pane at the bottom of the 
Select for Restore tab, as described in the following topics:

• “Restoring from an active copy in a stand-alone environment”  on page 127
• “Restoring from an active node backup”  on page 130
• “Restoring from a passive node backup in Exchange 2010”  on page 135
• “Restoring from a passive node backup in Exchange 2007”  on page 138
• “Restoring databases to a different location on a different server”  on page 146
• “Restoring to an alternate location on the same server”  on page 149
• “Restoring with Avamar granular level recovery”  on page 159
• “Restoring to an RDB on the original server”  on page 163
• “Restoring to an RSG on the original server”  on page 167
• “Restoring to an RDB on a different server”  on page 170
• “Restoring to an RSG on a different server”  on page 173

How to find a backup by file or folder
To find a backup by specific files or folders in that backup:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. In the clients tree, select the client on which the backup was performed:

• In a stand-alone environment, select the Exchange server.

• If you are restoring from a passive node backup, select the Exchange server that 
contained the passive database copies at the time of backup, since the passive 
copy could now be on a different node than it was when backed up.

• If you are restoring from an active node backup in Exchange 2007, select the 
Exchange virtual server.

• If you are restoring from an active node backup in Exchange 2010, select the node 
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on which the backup was performed.

• If you are restoring from a DAG federated backup, select the DAG client. 

You cannot view clients outside the domain for the login account. To view all clients, 
log in to the root domain.

3. Click the Select for Restore tab.

4. Click the By File/Folder tab.

5. In the Enter path to retrieve history for text box, specify the path to the file or folder:

• Type the full path to the client directory or file in the Enter path to retrieve history 
for text box.

• Browse to the file or folder:

a. Click Browse.

The Select File or Folder window appears.

b. Select the client.

c. Select the plug-in.

A list of folders appears in a table to the right of the plug-ins pane.

d. Select the file or folder to restore.

e. Click OK.

The selected file or folder appears in the Enter path to retrieve history for text 
box.

6. Click Retrieve.

The Version History table lists all versions and sizes for that directory or file that have 
been backed up from the selected client. 

7. Select the directory or file version in the Version History table.

All backups for the selected client that contain the selected version appear in the 
Backups table next to the Version History table. 
Finding a backup for restore 125



Exchange Database Restore and Disaster Recovery
8. Select the backup to restore from the Backups table.

The following figure illustrates backups that contain the folder Exchange Information 
Store.

9. Select the data to restore from the Contents of Backup pane at the bottom of the 
Select for Restore tab, as described in the following topics:

• “Restoring from active copy or active node backups”  on page 127
• “Performing message and granular level restores”  on page 158
• “Restoring with Avamar granular level recovery”  on page 159
• “Restoring to an RDB on the original server”  on page 163
• “Restoring to an RSG on the original server”  on page 167
• “Restoring to an RDB on a different server”  on page 170
• “Restoring to an RSG on a different server”  on page 173
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Restoring from active copy or active node backups
You can restore from an active copy of an Exchange database in stand-alone environment 
or an active node backup in a high-availability environment:

◆ “Restoring from an active copy in a stand-alone environment”  on page 127
◆ “Restoring from an active node backup”  on page 130

Restoring from an active copy in a stand-alone environment

To restore an active copy of an Exchange database in a stand-alone environment to its 
original location:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123. The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the database to restore.
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4. Select Actions > Restore Now.

The Restore Options dialog box appears.

5. Select Restore everything to its original location.

6. From the Encryption method list, select the encryption method to use for client/server 
data transfer during this restore.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.
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7. Click More Options.

The Restore Command Line Options dialog box appears. 

8. Set the plug-in options:

a. Choose one of the following settings to enable this database or all databases to be 
overwritten by the restore:

– To specify to enable the overwrite of just the database you actually want to 
restore, in the Restore Command Line Options dialog box, leave the Allow 
database overwrite check box cleared, and then in Exchange Management 
Console, select the This database can be overwritten by a restore option in the 
recovery options for the database you want to restore. This enables you to set 
Allow database overwrite for the databases that were selected for restore. 

– To enable the overwrite of all databases when you perform a restore, in the 
Restore Command Line Options dialog box, select the Allow database overwrite 
option.

b. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

c. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.
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d. If log file conflicts may occur during the restore, then use the Move logs path box to 
specify a location to which to move the existing log files before the restore. 

e. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. 

9. Click OK on the Restore Command Line Options dialog box.

10. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

11. Click OK.

Restoring from an active node backup 

To restore from an active node backup in Exchange 2007 or 2010:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the Exchange 2007 storage group or Exchange 2010 
database to restore. 
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4. Select Actions > Restore Now.

The Restore Options dialog box appears. 

5. In an Exchange 2010 environment where the node from which the databases were 
backed up is now the passive node instead of the active node, perform the following 
steps:

a. Select Restore everything to a different location. 

b. Click Browse. 

The Browse for Client Destination dialog box appears.

c. Select the target Exchange server for the restore, which is the node that currently 
hosts the active copy of the databases to restore.

d. Click OK to return to the Restore Options dialog box. 

In an Exchange 2007 environment or in an Exchange 2010 environment where the 
node from which the databases were backed up is still the active node, skip this step 
and proceed to the next step.
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6. Click More Options.

The Restore Command Line Options dialog box appears. 

7. Set the plug-in options:

a. Choose one of the following settings to enable this database or all databases to be 
overwritten by the restore:

– To enable the overwrite of just the database you actually want to restore, in the 
Restore Command Line Options dialog box, leave the Allow database overwrite 
check box cleared, and then in Exchange Management Console, select the This 
database can be overwritten by a restore option in the recovery options for the 
database you want to restore. This enables you to set Allow database overwrite 
for the databases that were selected for restore. 

– To enable the overwrite of all databases when you perform a restore, in the 
Restore Command Line Options dialog box, select the Allow database overwrite 
option.

b. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

c. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.
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d. If log file conflicts may occur during the restore, then use the Move logs path box to 
specify a location to which to move the existing log files before the restore. 

e. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. 

f. Select Automate replication suspension so that replication to the passive nodes is 
suspended while you are performing the restore. If you do not select this option, 
you will need to manually suspend replication before you perform the restore as 
described in “Manually suspending replication to the passive node”  on page 134.

When you select Automate replication suspension, that only suspends replication 
before the restore. Whether you select this setting or manually suspend replication, 
you will still need to manually resume replication after the restore, as described in 
“Resuming replication and restarting cluster resources”  on page 150.

8. Click OK on the Restore Command Line Options dialog box.

9. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

10. Click OK.

After the restore, replication on the passive node is in a suspended state, and the 
cluster resource for the database is stopped.

11. Manually resume replication, and restart the cluster resource for the database, 
following the steps in “Resuming replication and restarting cluster resources”  on 
page 150.
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Manually suspending replication to the passive node
The Restore Command Line Options dialog box provides the option to automate 
replication suspension. When this option is selected, Avamar will automatically suspend 
replication when you run the restore operation. If you do not select this option, then you 
will need to manually suspend replication to the passive node by using the Exchange 
Management Shell.

To suspend replication to the passive node by using the Exchange Management Shell:

◆ In Exchange 2007, type the suspend-StorageGroupCopy command:

suspend-StorageGroupCopy -Identity “SERVERNAME\SGNAME”

where SERVERNAME is the name of the Exchange server and SGNAME is the name of 
the storage group.

◆ In Exchange 2010, type the suspend-MailboxDatabaseCopy command:

suspend-MailboxDatabaseCopy -Identity “SERVERNAME\DBNAME”

where SERVERNAME is the name of the Exchange server and DBNAME is the name of 
the database.

Restoring from passive node backups 
You can restore from a passive node backup in Exchange 2007 or 2010. The overall 
procedures for either version are quite similar. There are a few key differences, so separate 
procedures are provided for Exchange 2007 and Exchange 2010:

◆ “Restoring from a passive node backup in Exchange 2010”  on page 135

◆ “Restoring from a passive node backup in Exchange 2007”  on page 138

Note: To perform these directed restores, the database needs to have been previously 
backed up from the passive node. “Backing up a passive node”  on page 89 provides 
information. 
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Restoring from a passive node backup in Exchange 2010

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the Exchange Information Store or databases to 
restore.
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4. Select Actions > Restore Now.

The Restore Options dialog box appears. 

5. Select the location for the restore, which must be the client where the active database 
resides:

• If the client where the passive backup took place now has the active copy of the 
databases that you are restoring, go step 6 on page 137.

• If the client where the passive backup took place still has a passive copy of the 
databases that you are restoring, in the Restore Destination Client field, enter the 
name of the client where the active copy of the databases reside, or browse to it. 
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6. Click More Options.

The Restore Command Line Options dialog box appears.

7. Set the plug-in options:

a. Choose one of the following settings to enable this database or all databases to be 
overwritten by the restore:

– To enable the overwrite of just the database you actually want to restore, in the 
Restore Command Line Options dialog box, leave the Allow database overwrite 
check box cleared, and then in Exchange Management Console, select the This 
database can be overwritten by a restore option in the recovery options for the 
database you want to restore. This enables you to set Allow database overwrite 
for the databases that were selected for restore. 

– To enable the overwrite of all databases when you perform a restore, in the 
Restore Command Line Options dialog box, select the Allow database overwrite 
option.

b. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

c. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.
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d. If log file conflicts may occur during the restore, then use the Move logs path box to 
specify a location to which to move the existing log files before the restore. 

e. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. 

f. Select Automate replication suspension so that replication to the passive nodes is 
suspended while you are performing the restore. If you do not select this option, 
you will need to manually suspend replication before you perform the restore as 
described in “Manually suspending replication to the passive node”  on page 134.

When you select Automate replication suspension, that only suspends replication 
before the restore. Whether you select this setting or manually suspend replication, 
you will still need to manually resume replication after the restore, as described in 
“Resuming replication and restarting cluster resources”  on page 150.

8. Click OK on the Restore Command Line Options dialog box.

9. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

10. Click OK.

Restoring from a passive node backup in Exchange 2007

To restore from a passive node backup in Exchange 2007 CCR:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.
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The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the storage group to restore. 

4. Select Actions > Restore Now.

The Restore Options dialog box appears. 

5. In the Restore Destination Client field, enter the name of the Exchange Virtual Server 
(EVS) or browse to it. 
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6. Click More Options.

The Restore Command Line Options dialog box appears. 

7. Set the plug-in options:

a. Choose one of the following settings to enable this database or all databases to be 
overwritten by the restore:

– To specify to enable the overwrite of just the database you actually want to 
restore, in the Restore Command Line Options dialog box, leave the Allow 
database overwrite check box cleared, and then in Exchange Management 
Console, select the This database can be overwritten by a restore option in the 
recovery options for the database you want to restore. This enables you to set 
Allow database overwrite for the databases that were selected for restore. 

– To enable the overwrite of all databases when you perform a restore, in the 
Restore Command Line Options dialog box, select the Allow database overwrite 
option.

b. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

c. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.
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d. If log file conflicts may occur during the restore, then use the Move logs path box to 
specify a location to which to move the existing log files before the restore. If the 
path is not specified, a subfolder is created under the current log location, with a 
name that includes the date and time.

e. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. Saving these files will clutter the disk with extra 
files until the next restore.

f. Select Automate replication suspension so that replication to the passive nodes is 
suspended while you are performing the restore. If you do not select this option, 
you will need to manually suspend replication before you perform the restore as 
described in “Manually suspending replication to the passive node”  on page 134.

When you select Automate replication suspension, that only suspends replication 
before the restore. Whether you select this setting or manually suspend 
replication, you will still need to manually resume replication after the restore, as 
described in “Resuming replication and restarting cluster resources”  on page 150.

8. Click OK on the Restore Command Line Options dialog box.

9. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

10. Click OK.

After the restore, replication on the passive node is in a suspended state, and the 
cluster resource for the database is stopped.

11. Manually resume replication, and restart the cluster resource for the database, 
following the steps in “Resuming replication and restarting cluster resources”  on 
page 150.
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Restoring from a DAG federated backup
A federated DAG backup provides access to backups of all Exchange databases through 
one Avamar client, even though they came from multiple Exchange servers in the DAG. 
This simplifies the restore process in several ways:

◆ You only need to select one Avamar client, the DAG client, in order to select and 
restore the databases. You do not need to locate, select, and restore backups 
separately from each server in the cluster.

◆ Avamar automatically routes each restored database to the correct node where the 
active copy currently resides. 

◆ Because the DAG federated backup only contains one copy of each database, there is 
no duplication from restoring copies of the same database from different server node 
backups. 

To restore the active copies of Exchange databases from a DAG federated backup to their 
original locations:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the DAG backup to restore, as described in “How to find a backup by date”  on 
page 123. Because you are restoring from a DAG federated backup, select the DAG 
client, not the Exchange server clients. 

Note: DAG clients do not appear any different than server clients in the Avamar client 
list, except that the DAG clients only display the client name by itself, for example 
av-exch14dag, but the Exchange server clients display the FQDN, for example 
exch14-1.exch14.corp.example.com. Look for the name used for the DAG client when 
you configured this DAG cluster with the Avamar Cluster Configuration tool. 

The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the database to restore.
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4. Select Actions > Restore Now.

The Restore Options dialog box appears.

5. From the Encryption method list, select the encryption method to use for client/server 
data transfer during this restore.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.
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6. Click More Options.

The Restore Command Line Options dialog box appears. 

7. Set the plug-in options:

a. Choose one of the following settings to enable this database or all databases to be 
overwritten by the restore:

– To enable the overwrite of just the database you actually want to restore, in the 
Restore Command Line Options dialog box, leave the Allow database overwrite 
check box cleared, and then in Exchange Management Console, select the This 
database can be overwritten by a restore option in the recovery options for the 
database you want to restore. This enables you to set Allow database overwrite 
for the databases that were selected for restore. 

– To enable the overwrite of all databases when you perform a restore, in the 
Restore Command Line Options dialog box, select the Allow database overwrite 
option.

b. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

c. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.
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d. If log file conflicts may occur during the restore, then use the Move logs path box to 
specify a location to which to move the existing log files before the restore. 

e. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. 

f. Select Automate replication suspension so that replication to the passive nodes is 
suspended while you are performing the restore. If you do not select this option, 
you will need to manually suspend replication before you perform the restore as 
described in “Manually suspending replication to the passive node”  on page 134.

When you select Automate replication suspension, that only suspends replication 
before the restore. Whether you select this setting or manually suspend replication, 
you will still need to manually resume replication after the restore, as described in 
“Resuming replication and restarting cluster resources”  on page 150.

8. Click OK on the Restore Command Line Options dialog box.

9. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

10. Click OK.
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Restoring a database to a different location
The following procedures are useful when you want to use a new location for your 
databases on the same server or a different server when you restore them. After you 
restore your databases to the new location, you can then point your Exchange server to 
use that new location. 

The following procedures describe two ways you can restore a database to a different 
location:

◆ “Restoring databases to a different location on a different server”  on page 146
◆ “Restoring to an alternate location on the same server”  on page 149

Restoring databases to a different location on a different server

To perform a directed recovery of an Exchange 2007 or 2010 database to a different 
location on a different server:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the database to restore. 
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4. Select Actions > Restore Now.

The Restore Options dialog box appears. 

5. Select Restore everything to a different location. 

6. In the Restore Destination Client box, type the destination client for the restore. This 
can be either the same Exchange server or a different Exchange server. 

7. Click Set Destination.

The Set Destination dialog box appears.

8. Specify where to save the items to. Enter the destination in Save Target(s) in Directory. 
Use the format drive:\folder\folder. 

9. Click More Options.
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The Restore Command Line Options dialog box appears. 

10. Set the plug-in options:

a. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box. If you select this option, then you 
can manually copy additional transaction logs before you mount the database.

b. If log file conflicts may occur during the restore, then use the Move logs path box to 
specify a location to which to move the existing log files before the restore. 

c. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur.

11. Click OK on the Restore Command Line Options dialog box, and then click OK on the 
Restore Options dialog box. 

The following status message appears: 

Restore initiated.

12. Click OK.
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Restoring to an alternate location on the same server

To restore to an alternate location on the same server:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the Exchange 2007 storage group or Exchange 2010 
RDB to restore.

4. Select Actions > Restore Now.

The Restore Options dialog box appears. 
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5. From the Encryption method list, select the encryption method to use for client/server 
data transfer during this restore.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

6. Select Restore everything to a different location.

The Items Marked for Restore table lists the databases previously selected in the 
Avamar Administrator Backup and Restore window. 

7. Click Set Destination. 

8. Browse to a location using the Windows File System plug-in or enter a file system 
location in the Set Destination dialog box and then click OK. 

9. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

10. Click OK.

Resuming replication and restarting cluster resources
After the restore, replication on the passive node is in a suspended state, and the cluster 
resource for the database is stopped. You must manually resume replication and restart 
the cluster resource for the database.

The following topics provide details on performing the restore and the necessary steps 
after the restore to resume replication and restart the cluster resource:

◆ “Restoring from an active node backup”  on page 130
◆ “Restoring from passive node backups”  on page 134
◆ “Restoring from a passive node backup in Exchange 2007”  on page 138
◆ “Resuming replication in Exchange 2007”  on page 151
◆ “Resuming replication in Exchange 2010”  on page 151
◆ “Starting the cluster resource”  on page 152
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Resuming replication in Exchange 2007

Review the steps to reseed the database copy as described in the Microsoft TechNet 
article “How to Seed a Cluster Continuous Replication Copy” 
http://technet.microsoft.com/en-us/library/bb124706(EXCHG.80).aspx. Even if you are 
an advanced user who is familiar with this command, you should review the instructions 
in the Microsoft TechNet article to ensure successful completion of replication. 

To reseed and resume replication in Exchange 2007 after a restore from either the passive 
or active node: 

1. Resume replication by using the Resume-StorageGroupCopy command.

In some cases, replication may fail because the database needs to be reseeded on the 
current passive node. 

2. If replication fails, run the Update-StorageGroupCopy command in the Exchange 
Management Shell on the passive node.

3. After reseeding and successful replication, follow the steps “Starting the cluster 
resource”  on page 152.

Resuming replication in Exchange 2010

After a restore from an active node, you can resume replication in Exchange 2010 by using 
either the Exchange Management Console or the Exchange Management Shell.

Resuming replication with the Exchange Management Console
Review the steps to suspend, resume, or update a database copy as described in the 
Microsoft TechNet articles “Suspend or Resume a Mailbox Database Copy” 
http://technet.microsoft.com/en-us/library/dd298159.aspx and “Update a Mailbox 
Database Copy” http://technet.microsoft.com/en-us/library/dd351100.aspx. Even if you 
are an advanced user who is familiar with this command, you should review the 
instructions in the Microsoft TechNet article to ensure successful completion of 
replication. 

To resume replication in Exchange 2010 by using the Exchange Management Console:

1. Resume replication by using the Resume-MailboxDatabaseCopy command for all 
passive copies of the restored database.

In some cases, replication may fail because the database needs to be reseeded on the 
current passive node.

2. If replication fails, run the Update-MailboxDatabaseCopy command for all passive 
copies of the restored database restored.

3. After reseeding and successful replication, follow the steps “Starting the cluster 
resource”  on page 152.
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Resuming replication with the Exchange Management Shell
To resume replication in Exchange 2010 by using the Exchange Management Shell:

1. Resume replication by using the Resume-MailboxDatabaseCopy command.

In some cases, replication may fail because the database needs to be reseeded on the 
current passive node.

2. If replication fails, run the Update-MailboxDatabaseCopy command.

Follow the steps to reseed the database copy as described in the “How to Seed a 
Cluster Continuous Replication Copy” article on the Microsoft TechNet website. Even if 
you are an advanced user who is familiar with this command, you should review the 
instructions in the Microsoft TechNet article to ensure successful completion of 
replication. 

3. After reseeding and successful replication, follow the steps “Starting the cluster 
resource”  on page 152.

Starting the cluster resource 

To start the cluster resource for a restored database:

1. Open Failover Cluster Management (Windows Server 2008 or Windows Server 2008 
R2) or Cluster Administrator (Windows Server 2003).

2. Right-click the offline resource and select Bring this resource online.

Disaster recovery 
Avamar provides operating system backup of the Windows servers that Exchange runs on, 
using the Avamar for Windows client, and application backup with the Windows Exchange 
VSS plug-in of Exchange databases, database recovery, and recovery down to the granular 
or message level. However, if you need to recover a lost Exchange computer, server, 
cluster, external services or site, follow the guidelines and procedures provided by 
Microsoft. 

Disaster recovery of an entire Exchange server requires the following:

1. Rebuild the Windows server on similar equipment as the original server, to the same 
Windows version and service pack level.

Full operating system backups with the Avamar Client for Microsoft Windows help you 
to rebuild your Windows Server with full backups of critical volumes and system state. 
The EMC Avamar for Windows Server User Guide provides instructions on performing 
full system state backups, and performing disaster recovery of the Windows server. 

2. Rebuild the Exchange server to the same version and service pack as the original 
Exchange server. 
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Rebuilding the Exchange server requires at least the same level of skill and expertise 
as installing and setting up a new Exchange installation. Microsoft provides very 
specific instructions for performing disaster recovery of an Exchange server. Separate 
documentation is provided for Exchange 2007, and Exchange 2010: 

• Exchange 2007 disaster recovery:

For Exchange 2007, review and follow the instructions for planning and performing 
disaster recovery in the Microsoft TechNet article “Disaster Recovery,” 
http://technet.microsoft.com/en-us/library/aa998848(EXCHG.80).aspx.

• Exchange 2010 disaster recovery:

For Exchange 2010, review and follow the instructions for planning and performing 
disaster recovery in the Microsoft TechNet article “Recover an Exchange Server,” 
http://technet.microsoft.com/en-us/library/dd876880.aspx.

3. Restore Exchange databases. 

Depending on your Exchange environment, and the instructions from Microsoft’s 
TechNet disaster recovery articles, there may be several ways to restore your Exchange 
databases:

• Restore from Avamar plug-in for Windows Exchange VSS backups, if they are very 
recent.

• Bring the Exchange server back online in the cluster, and allow the mailbox 
databases to be synced from the current versions on the other servers in the 
cluster.

• Use a combination of both methods: reseed the mailbox databases with the 
Avamar for Windows Exchange VSS backups, and then sync the newly restored 
Exchange server with the current version on the other servers in the cluster. 

Troubleshooting database restores
The following topics explain issues that may occur during the restore process for an 
Exchange environment, as well as steps to resolve or work around the issues.

Restore requirements

When you restore an Exchange database, the destination Exchange server must have the 
same Exchange Server version and service pack as the Exchange server on which the 
backup was performed. 

If the Exchange Server version on the destination and source servers does not match, then 
the restore fails. 

Some of the common causes for a mismatch are:

◆ The destination server is a new server to replace the old one, and a different number 
of service packs have been installed on it.

◆ The source and destination servers are always upgraded at the same time, but all 
servers were upgraded after the backup was performed.

◆ You are restoring to the original server, but the server was upgraded after the backup 
was performed.
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Troubleshooting log file issues

The following issues may occur with Avamar plug-in log files during a restore. 

Log files are moved if gaps are detected

During a normal restore, if a transaction log gap is detected, any existing log files are 
moved to a folder named logs_TIME_DATE, where TIME and DATE are the time and date of 
the restore, respectively. The folder is created as a subfolder in the transaction log file 
path of the Exchange 2007 storage group or Exchange 2010 database. You can use these 
logs to analyze the restore operation, if necessary, or apply those logs up to where the 
failure occurred.

“Range of log files is missing” error in the Event Log

A gap in transaction log files error message may appear in the Avamar log file and Event 
Log during recovery, if backups were performed simultaneously for the same database on 
the active and passive node of a DAG. Though the backup itself was successful, the log 
files may not match and may produce the following error in the Event Log: 

The range of log files LOGFILENAME1 to LOGFILENAME2 is missing (error 
-528) and cannot be used.

where LOGFILENAME1 and LOGFILENAME2 are the file names of the two log files.

If this error occurs, you may still be able to recover that backup by using the Exchange 
Server Database Utilities tool, Eseutil.exe. The “Eseutil” article on the Microsoft TechNet 
website describes how to use this tool. 

Missing or inaccessible log files

When you perform an Exchange recovery, the status and messages are written to the 
MOD-XXX-3018-Exchange_VSS_Writer_2007.log file. This log file is normally viewable 
through the Avamar Management Console status log. However, if the user performing the 
backup or restore operation does not have the appropriate backup and restore privileges 
or write permission to the \var folder, then the recovery process cannot create or write to 
the log file, and recovery fails. If the user does not have backup and recovery privileges, 
but has write permissions to the \var directory, then messages and failure information are 
written to the avexvss.log file in the \var directory. 

Troubleshooting miscellaneous restore issues

The following miscellaneous issues may occur during a restore.

Exchange 2007 database mounting after restore

Before starting a restore, Avamar dismounts all databases in a storage group, even if the 
databases are not being selected for restore. When the restore completes, Avamar 
attempts to mount all existing databases in the storage group, even if they were not 
previously mounted. Avamar does not attempt to mount databases that do not exist on 
disk, even if they exist in Active Directory. 
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Selective restore of databases from an older backup may fail 

If you attempt to restore selected databases from an older backup when newer backups 
exist, then the restore may fail. If this occurs, delete the restore.env file created in the log 
folder path, along with all the log files in that path, and rerun the restore. Also, check the 
event logs through the Event Viewer if mounting one or more databases fails.
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CHAPTER 5
Message and Granular Level Restore 

The following topics explain how to restore Exchange items at a granular level, such as 
user mailboxes, user mailbox folders, and messages:

◆ Performing message and granular level restores....................................................  158
◆ Restoring with Avamar granular level recovery .......................................................  159
◆ Restoring to an RDB on the original server .............................................................  163
◆ Restoring to an RSG on the original server .............................................................  167
◆ Restoring to an RDB on a different server...............................................................  170
◆ Restoring to an RSG on a different server...............................................................  173
◆ Accessing archive mailboxes in recovery databases ..............................................  176
◆ Recovering a deleted or current user mailbox to an alternate mailbox ....................  177
◆ Troubleshooting message and granular level restores............................................  178
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Performing message and granular level restores
When you need to retrieve individual user mailboxes, user mail folders, or messages, you 
can do so without overwriting entire mail databases. You can restore a storage group to an 
Exchange 2007 RSG or database to an Exchange 2010 RDB, and then use Avamar Granular 
Level Recovery (GLR) or Exchange server management tools to browse, select, and restore 
individual mailboxes, folders, or messages. 

“Recovering individual mailboxes, mailbox folders, and messages”  on page 38 describes 
the granular level recovery and restore to RSG/RDB processes in detail, including 
information flow diagrams.

If you use Avamar granular level recovery to restore to RSG/RDB, you must install the 
Windows Exchange GLR plug-in option when you install the Windows Exchange VSS 
plug-in. “Task 2: Installing the Windows Exchange VSS plug-in”  on page 54 and 
“Configuring the environment for message-level restores”  on page 62 provide more 
information. If you use Exchange server management tools to restore to RSG/RDB, you do 
not need to install the Windows Exchange GLR plug-in option. 

Avamar granular level recovery restores

Avamar granular level recovery allows you to mount a virtual backup set, created under 
\avs\var\..., where you can browse the contents of the backup without actually moving or 
copying the data. It only takes minutes to create this virtual drive, and does not require 
any significant amount of disk storage space. You can browse and select the data from 
this virtual backup set as if you were looking at the actual database, down to the message 
level. Only when you send the restore request to the Avamar server are actual items 
copied to out of the backup set to the user’s mailbox. The following topic provides the 
steps for performing granular level recovery:

◆ “Restoring with Avamar granular level recovery”  on page 159 

RDB or RSG restores

Restoring to a RDB or RSG allows you to restore Exchange mail databases to a separate 
location without disrupting the active or production Exchange servers. After restoring to an 
RDB/RSG, you can browse, select, and restore items to user mailboxes, by using Microsoft 
Exchange tools and utilities. 

The steps for restoring an Exchange 2010 RDB or an Exchange 2007 RSG are very similar, 
but are provided in separate procedures:

◆ “Restoring to an RDB on the original server”  on page 163
◆ “Restoring to an RSG on the original server”  on page 167
◆ “Restoring to an RDB on a different server”  on page 170
◆ “Restoring to an RSG on a different server”  on page 173
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Restoring with Avamar granular level recovery
To perform a granular level recovery to an Exchange server:

1. Ensure that you have prepared the environment as discussed in “Configuring the 
environment for message-level restores”  on page 62.

2. (Exchange 2010 only) Delete all existing RDBs on the Exchange server. 

If another mounted or unmounted RDB exists when you perform granular level 
recovery, then the browse results appear empty.

3. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

4. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

You can perform granular level recovery from individual Exchange server client 
backups, or from federated DAG client backups. 

The backup to restore from is selected in the Backups table.

5. In the bottom left pane, click the Browse for granular restore icon:  

The Client Selection dialog box appears. 

GLR
icon
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6. Select the restore destination:

• If you are restoring from an Exchange 2007 CCR passive node backup, select 
Restore everything to a different location, and then browse to the Exchange Virtual 
Server. 

• If you are restoring from an Exchange 2010 DAG federated backup, select Restore 
everything to a different location, and then browse to a client that is a member of 
the DAG and has the GLR plug-in installed. 

• For all other Exchange 2007 or 2010 backups, select Restore everything to its 
original location. 

7. Click OK.

This mounts the backup to a virtual drive, so that you can browse and select the actual 
data to restore. This is only a view of the contents of the backup, not the actual files, 
so no data has actually been moved yet. 

8. In the bottom left pane of the Select for Restore tab, select the storage group or 
database from which to recover. 

The following figure illustrates Storage Groups in an Exchange 2007 backup; for 
Exchange 2010 the contents are similar except the items are databases. 

When you select a storage group or database:

a. (Exchange 2007 only) Avamar deletes any existing RSG from the Exchange server.

b. Avamar mounts the selected storage group or database.

c. If a Backup Browsing Status message appears, advising that mounting the 
database may take a long time, click OK.

d. When mounting has completed, the contents of the selected storage group or 
database appear. 
160 EMC Avamar 6.1 for Exchange VSS User Guide



Message and Granular Level Restore
9. In the bottom right pane of the Select for Restore tab, browse to and select the user, 
mail folder, or message to recover. The following example illustrates the contents of an 
Exchange 2007 storage group. An Exchange 2010 backup would be similar except the 
storage group would be called a database.

• To select a user, select the check box next to the user in the bottom right pane. In 
this example, E12User1 is selected.

• To select a mail folder, expand the node for the user that owns the mailbox in the 
bottom left pane, and then select the folder in the bottom right pane. In this 
example, the Inbox folder is selected. 

• To select a message, expand the nodes for the user and the mailbox in the bottom 
left pane, and then select the message in the bottom right pane. In this example, 
three messages are selected. 

Stop here if you want to restore items to an alternate mailbox, and follow the 
instructions in “Restoring to an RDB on the original server”  on page 163. For 
example, if you want to restore items from Steve’s mailbox to John’s mailbox.

10. Select Actions > Restore Now.

User mailbox

Mail folder

Messages
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The Restore Options dialog box appears.

11. From the Encryption method list, select the encryption method to use for client/server 
data transfer during this restore.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

12. Click More Options.
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The Restore Command Line Options dialog box appears. 

13. From the Amount of time to leave AvFS mounted list, select the amount of time to 
leave the Avamar Virtual Drive mounted before a timeout occurs. 

The drive is disconnected after this amount of inactivity. 

14. Click OK on the Restore Command Line Options dialog box.

15. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

16. Click OK.

Avamar places restored items in a new folder in the user's mailbox called Recovered 
Items DATE_AND_TIME, where DATE_AND_TIME are the date and time of the recovery. 
For example: Recovered Items Thu Feb 24 11:18:30 2011. 

Restoring to an RDB on the original server

You can only restore to a single RSG at a time per server.

To restore an Exchange 2010 RDB to the original server and then recover a single mailbox 
from the recovered database:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.
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The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select a database to restore to RDB.

4. Select Actions > Restore Now.

The Restore Options dialog box appears.

5. Leave Restore Destination Client as is. The default is the original location.

6. The Restore Plug-in displays the plug-in previously selected in the Avamar 
Administrator Backup and Restore window.
164 EMC Avamar 6.1 for Exchange VSS User Guide



Message and Granular Level Restore
7. From the Encryption method list, select the encryption method to use for client/server 
data transfer during this restore.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

8. The Items Marked for Restore table lists the databases previously selected in the 
Avamar Administrator Backup and Restore window. 

9. Click More Options.

The Restore Command Line Options dialog box appears. 

10. Set the plug-in options:

a. Choose one of the following settings to enable this database or all databases to be 
overwritten by the restore:

– To enable the overwrite of just the database you actually want to restore, in the 
Restore Command Line Options dialog box, leave the Allow database overwrite 
check box cleared, and then in Exchange Management Console, select the This 
database can be overwritten by a restore option in the recovery options for the 
database you want to restore. This enables you to set Allow database overwrite 
for the databases that were selected for restore.
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– To enable the overwrite of all databases when you perform a restore, in the 
Restore Command Line Options dialog box, select the Allow database overwrite 
option.

b. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

c. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.

d. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur.

e. Select the Restore into RSG/RDB check box.

f. In the RSG/RDB name box, type the name of the RSG to restore to. If the RSG does 
not exist, it will be automatically created. If an RSG with the same name already 
exists, you must select the Overwrite existing RSG/RDB check box. 

Note: Only one RSG can exist on an Exchange server at any given time. 

g. Optional: Enter a database path in RSG/RDB database path and log folder path in 
RSG/RDB Log path. 

11. Click OK on the Restore Command Line Options dialog box.

12. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

13. Click OK.
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Restoring to an RSG on the original server

You can only restore to a single RSG at a time per server.

To recover an Exchange database to an RSG in Exchange 2007, and then recover a single 
mailbox from the recovered database:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the storage group or databases to restore. 
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4. Select Actions > Restore Now.

The Restore Options dialog box appears. 

5. Leave Restore Destination Client as is. The default is the original location.

6. The Restore Plug-in displays the plug-in previously selected in the Avamar 
Administrator Backup and Restore window.

7. From the Encryption method list, select the encryption method to use for client/server 
data transfer during this restore.

The exact encryption technology and bit strength used for a client/server connection 
depends on a number of factors, including the client platform and Avamar server 
version. The EMC Avamar Product Security Guide provides additional information.

8. The Items Marked for Restore table lists the databases previously selected in the 
Avamar Administrator Backup and Restore window. 
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9. Click More Options.

The Restore Command Line Options dialog box appears. 

10. Set the plug-in options:

a. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

b. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.

c. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. 

d. Select the Restore into RSG/RDB check box.

e. In the RSG/RDB name box, type the name of the RSG to restore to. If the RSG does 
not exist, it will be automatically created. If an RSG with the same name already 
exists, you must select the Overwrite existing RSG/RDB check box. 
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Note: Only one RSG can exist on an Exchange server at any given time. 

f. Optional: Enter a database path in RSG/RDB database path and log folder path in 
RSG/RDB Log path. 

11. Click OK on the Restore Command Line Options dialog box.

12. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

13. Click OK.

Restoring to an RDB on a different server
To restore to an Exchange 2010 RDB on a different server:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

The backup to restore from is selected in the Backups table. 

3. In the bottom two panes, select the database to restore. When restoring to an RDB, 
you can only select one database.
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4. Select Actions > Restore Now.

The Restore Options dialog box appears. 

5. In the Restore Destination Client box, enter the client to restore to, or browse to it. 

6. Click More Options.

The Restore Command Line Options dialog box appears. 
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7. Set the plug-in options:

a. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

b. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box. If you select this option, then you 
can manually copy additional transaction logs before you mount the database.

c. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. 

d. Select the Restore into RSG/RDB check box.

e. In the RSG/RDB name box, type the name of the RDB to restore to. If the RDB does 
not exist, it will be automatically created. If an RDB with the same name already 
exists, you must select the Overwrite existing RSG/RDB check box. 

f. Optional: Enter a database path in RSG/RDB database path and log folder path in 
RSG/RDB Log path. 

8. Click OK on the Restore Command Line Options dialog box.

9. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

10. Click OK.
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Restoring to an RSG on a different server

You can only restore to a single RSG at a time per server.

To restore to an Exchange 2007 RSG on a different server:

1. In Avamar Administrator, click the Backup & Restore launcher button.

The Backup and Restore window appears.

2. Find the backup to restore, as discussed in “How to find a backup by date”  on 
page 123.

The backup to restore from is selected in the Backups table.

3. In the bottom two panes, select the database to restore.
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4. Select Actions > Restore Now.

The Restore Options dialog box appears. 

5. In the Restore Destination Client box, enter the client to restore to, or browse to it. 

6. Click More Options.

The Restore Command Line Options dialog box appears. 
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7. Set the plug-in options:

a. Choose whether to automatically mount the databases after a successful restore 
by selecting or clearing the Mount the database(s) after successful restore check 
box.

b. Choose whether to restore but not replay transaction logs by selecting or clearing 
the Do not replay the transaction logs check box.

If you select this option, then you can manually copy additional transaction logs 
before you mount the database.

c. To prevent metadata files that are used during the restore from being automatically 
deleted after the restore, select the Retain recovery metadata check box. The 
metadata is generally only needed for debugging purposes. 

You can use these files, which are in the \var\avexvss_restore folder, to investigate 
any restore issues that may occur. 

d. Select the Restore into RSG/RDB check box.

e. In the RSG/RDB name box, type the name of the RSG to restore to. If the RSG does 
not exist, it will be automatically created. If an RSG with the same name already 
exists, you must select the Overwrite existing RSG/RDB check box. 

Note: Only one RSG can exist on an Exchange server at any given time.

f. Optional: Enter a database path in RSG/RDB database path and log folder path in 
RSG/RDB Log path. 

8. Click OK on the Restore Command Line Options dialog box.

9. Click OK on the Restore Options dialog box. 

The following status message appears: 

Restore initiated.

10. Click OK.
Restoring to an RSG on a different server 175



Message and Granular Level Restore
Accessing archive mailboxes in recovery databases
Microsoft does not support access to archive mailboxes in the RDB through MAPI. A 
MAPI_E_FAILONEPROVIDER (0x8004011d) error will occur when a MAPI application 
attempts to log on. 

You can work around this by performing a granular level recovery, or physical database 
recovery to the RDB, and then using the Restore-Mailbox cmdlet in Exchange Management 
Shell to restore data from the archive mailbox in the Recovery Database. The Microsoft 
TechNet articles “Exchange Management Shell” 
http://technet.microsoft.com/en-us/library/bb123778.aspx and “Restore-Mailbox” 
http://technet.microsoft.com/en-us/library/bb125218.aspx provide more information 
about using this tool and features.

To access archive mailboxes in recovery databases:

1. In Avamar, recover the messages or user mailbox:

• To use granular level recovery:

a. Start the procedure “Restoring with Avamar granular level recovery”  on 
page 159. 

b. Follow the steps in the procedure up to mounting the backup to a virtual drive.

Do not click Restore Now.

• To use recovery to an RDB, complete one of the following procedures:

– “Restoring to an RDB on the original server”  on page 163

– “Restoring to an RDB on a different server”  on page 170

2. In Exchange Management Shell, get the archive mailbox GUID from the get-mailbox 
cmdlet for the user whose archive mailbox you want to restore:

[PS][C:\>Get-Mailbox <alias> | FL Name, Archive*

For example, in Exchange Management Shell, this command:

[PS][C:\>Get-Mailbox John | FL Name, Archive*

Returns the following information:

Name = John Smith
ArchiveDatabase = Mailbox Database 1112264233
ArchiveGuid = 3a215de77-c3c3-422f-8857-baD00036cc28d
ArchiveName = <Personal Archive - John Smith>
ArchiveQuota = 50 GB <53,687,091,200 bytes>
ArchiveWarning Quota = 45 GB <48,318,382,080 bytes>
ArchiveDomain =
ArchiveStatus = None

3. Run the Restore-Mailbox cmdlet. For example, in Exchange Management Shell:

C:\>Restore-Mailbox -RecoveryDatabase <Recovery Database Name> 
-RecoveryMailbox <GUID> -TargetFolder <Target Folder Name> -Identity 
<alias>

This restores the mailbox data back to a live mailbox, where the user can work with it.
176 EMC Avamar 6.1 for Exchange VSS User Guide



Message and Granular Level Restore
Recovering a deleted or current user mailbox to an alternate 
mailbox

You can use Avamar Exchange GLR and the New-MaiboxRestoreRequest cmdlt (Exchange 
2010 SP1 or later) or Restore-Mailbox cmdlt (Exchange 2010 or Exchange 2007) in 
Exchange Management Shell or Powershell to recover a mailbox or messages to an 
alternate mailbox. This is useful when you need to recover items:

• From the backup of a current user mailbox to another mailbox. For example, you want 
to recover items from a backup of the Steve mailbox and place them in the John 
mailbox. 

• From a backup of a mailbox of a user that was recently removed from Active Directory 
and Exchange mailbox accounts. How far back you can retrieve items from backups 
depends on your Exchange retention policies and Avamar backup retention policies. 

To direct granular level recovery to an alternate mailbox:

1. Start the procedure “Restoring with Avamar granular level recovery”  on page 159.

2. Follow the steps in the procedure up to mounting the backup to a virtual drive.

Do not click Restore Now. 

3. Start the Exchange Management Shell or PowerShell.

4. Run the New-MaiboxRestoreRequest cmdlt (Exchange 2010 SP1 or later) or 
Restore-Mailbox cmdlt (Exchange 2010 or Exchange 2007) to restore the original 
(source) mailbox to an alternate (target) mailbox. 

Microsoft provides a full list of syntax and parameters for the 
New-MaiboxRestoreRequest and Restore-Mailbox cmdlets at:

• http://technet.microsoft.com/en-us/library/ff829875.aspx. 
(New-MailboxRestoreRequest Exchange 2010 SP1 or later).

• http://technet.microsoft.com/en-us/library/bb125218.aspx. 
(Restore-MailboxExchange 2010).

• http://technet.microsoft.com/en-us/library/aa997694(v=exchg.80).aspx 
(Restore-Mailbox Exchange 2007).
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Troubleshooting message and granular level restores
For troubleshooting Exchange server restores in general, “Troubleshooting database 
restores”  on page 153 provides other troubleshooting information. The following issues 
may occur during restores to RSG/RDB or granular level recovery.

Granular level recovery may fail when security hardening packages are 
enabled on an Avamar server

When using an Avamar server with security hardening packages enabled, GLR operations 
may fail with one of the following errors:

◆ In avexchglr_plugin log: 

avexchglr Info <6444>: Plugin exited with 'code 536870920: cannot 
establish connection with server (possible network or DNS failure)'

or

• In Avamar Administrator:
Unable to locate full backup for this client.  Please check 
encryption settings.

To resolve this issue:

1. Go to the Avamar var directory. 

By default this is C:\Program Files\avs\var.

2. Modify avtar.cmd and avexchglr.cmd files. 

If these files do not already exist, create them. 

Add the following to both files:

--encrypt=tls

3. Stop EMC Avamar Exchange GLR service and attempt the GLR operation again.

Mailboxes do not appear when browsing

If mailboxes do not appear when you browse for items to restore during granular level 
recovery, then check the avmapi.log file, which is typically found in the C:\Program 
Files\avs\var folder. If an “Unable to create MAPI profile due to a network issue” error 
appears in the log file and the network is a pure IPv4 network, then disable IPv6 support 
on all Exchange servers with Mailbox and/or Client Access Server roles installed, as 
discussed in the Microsoft Support article “How to disable certain Internet Protocol 
version 6 (IPv6) components in Windows Vista, Windows 7 and Windows Server 2008,” 
http://support.microsoft.com/kb/929852.

Browsing mailboxes that have been moved to a different database

When you move a user mailbox from one database to another, backups for that mailbox 
may be browsable in both databases. Browsing the old database may still display the 
contents of the mailbox up to a point in time just before it was moved to the new 
database. 

Generally, you will want to browse and restore the mailbox contents from backups of the 
current database. If you need to restore items from the mailbox from a time before it was 
moved to the new database, browse the mailbox in backups of the old database location. 
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Deleted mailboxes do not appear when browsing

Organizations often disable and delete the Active Directory and Exchange user accounts 
when an employee leaves the organization. It is not unusual for a group such as a legal, 
security, or human resources department to request access to the former employee’s 
mailbox, several months after the employee’s separation. If a user is deleted from Active 
Directory and Exchange user accounts, backups of that account prior to the deletion will 
not appear in Avamar granular level recovery. The user’s mailbox is not lost; it just is not 
visible in the backups because Avamar does not display a mailbox if the user is no longer 
present in the current Exchange databases. 

If the organization performs regular (usually daily) backups of user mailboxes, the deleted 
user’s mailbox backups will still be present in backups prior to the employee’s separation 
from the organization. 

To access the mailbox of a deleted user mailbox, follow the steps in“Recovering a deleted 
or current user mailbox to an alternate mailbox”  on page 177.

When restoring a backup to overwrite existing RDB, cannot specify a new 
location for the logs or database file

When you restore a backup and specify to overwrite an existing RDB, if you specify a new 
location for the logs or database file, the new location settings are ignored. If you select to 
overwrite an existing RDB, it will also use the existing location for the logs or database file 
and overwrite those too. 

RSG is removed when selecting a storage group for mounting

Only one RSG can exist at a time. When you select a storage group from a saveset to be 
mounted by using granular level recovery, the existing RSG is removed. 

Browsing and restoring archive mailboxes is not supported

Exchange 2010 enables you to create a separate archive mailbox assigned to a user. The 
default naming convention for these mailboxes is “Online Archive -”, but you also can 
customize the name. These archive mailbox names appear in the list when you perform 
granular level recovery, but you cannot browse them or restore items from them. To restore 
archive mailboxes, perform an RDB recovery by using the Windows Exchange VSS plug-in, 
as discussed in “Restoring to an RDB on the original server”  on page 163 or “Restoring to 
an RDB on a different server”  on page 170.

Once the archive mailbox has been restored, you can use Microsoft Exchange tools to 
recover information in the archive mailboxes back to the associated user’s mailboxes. 

Exchange granular level recovery does not support Public folder databases

The Avamar Windows Exchange GLR plug-in utilizes the Exchange 2007 RSG, and 
Exchange 2010 RDB technologies. Microsoft does not support public folder databases in 
RSG or RDB. 

Browsing fails on an Exchange server without active database copies

If an Exchange server does not contain any active database copies, then the granular level 
recovery browse operation may fail with the error “Backup browse result is empty.” To 
resolve this issue, redirect the granular level recovery browse operation to an Exchange 
server that contains active database copies.
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GLR browsing may not work when CAS is specified or changed

GLR browsing may not work until the Exchange Client Access service on the Exchange 
Mailbox server is stopped and restarted.

GLR will not work if AvamarBackupUser mailbox is not created 

Avamar Exchange granular level recovery requires the AvamarBackupUser mailbox. 
Sometimes when creating the AvamarBackupUser account with the AvamarBackupUser 
Configuration Tool, the AvamarBackupUser mailbox is not created. This will appear as a 
failed test when you run the Check in this tool. If that occurs, manually create the mailbox 
as described in “Manually creating the AvamarBackupUser account and mailbox”  on 
page 58.

GLR will not work if AvamarBackupUser mailbox is hidden from Exchange 
address lists

The AvamarBackupUser mailbox must be visible to Exchange address lists, not hidden, for 
Exchange granular level recovery to work. The AvamarBackupUser Configuration Tool does 
not make this mailbox hidden, but if you manually create the mailbox make sure it is not 
hidden from Exchange address lists. 

GLR browse may fail if the database containing the AvamarBackupUser is 
dismounted

If the error message “Error MAPI_E_FAILONEPROVIDER” when performing granular level 
recovery on an Exchange 2007 database, it may mean granular level recovery browsing of 
the storage group failed because the database containing AvamarBackupUser was 
dismounted. To resolve this issue, ensure that the database containing the 
AvamarBackupUser mailbox is mounted.

Exchange granular level recovery browse for restore may fail if number of 
entries in mail folder exceeds 50,000

If the number of entries within a mail folder in an Exchange granular level recovery backup 
exceeds approximately 50,000, the browse for restore attempt might not display any 
results. The recommended restore process for this quantity of entries is to restore the 
entire folder, and then copy the desired messages from the restored folder to the selected 
folder. 

Canceling granular level recovery or federated backup resets the 
destination client to the DAG client

If you use the Exchange GLR plug-in to browse and select mailboxes or folders from a 
federated backup, and then click Cancel in the Restore Options window, Avamar resets the 
destination to the DAG client, instead of the Exchange client that was just browsed. 
Attempting to restore again will fail, because the Destination client is pointing to the DAG 
client which does not have the GLR plug-in installed. In order to perform a successful 
restore, reset the destination client to the client you were browsing with the Exchange GLR 
plug-in. 
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User mailbox names with mismatched parentheses may not be browsable

When using the Exchange GLR to browse backups, you may not be able to browse 
mailboxes that have mismatched parentheses in the mailbox name. This can occur due to 
typographical or input error when an Exchange mailbox is created. 

GLR browse of mailbox folder with large number of items may fail

When performing a granular level recovery browse of a mailbox folder containing a large 
number of items (typically in the tens of thousands, the exact number will vary), it is 
possible for the plug-in to reach the upper size limit of the number of messages that can 
be displayed in the Avamar Administrator - Backup and Restore window. When this occurs, 
the Restore window will fail to display any contents at all, and will be accompanied by the 
error message “Backup Mailbox Browse result is empty.”

If this situation occurs, you can do one of the following:

◆ Restore the contents of the entire folder, which will be recovered to a Restored Items 
folder in the production mailbox. Then you can move individual items from the 
Recovered Items folder to other mailbox folders as needed, and then delete the 
Recovered Items folder. 

or

◆ Set an upper limit on the number of mailbox items displayed in Avamar Administrator 
- Backup and Restore window by specifying "max_browse_entries=<maximum>" in the 
avexchglr.cmd file where <maximum> is a number you specify:

1. Create avexchglr.cmd file in the var directory. This is typically in the c:\program 
files\avs\var location.

2. In the file add the following line:

--max_browse_entries=<desired number of entries>

 Try to keep the number of entries to less than 40,000.

3. Stop the GLR plug-in and now attempt a new granular level recovery browse 
operation. 

4. If the browse operation succeeds, select and restore items, which will be recovered 
to the Recovered Items folder in the production mailbox. Move individual items 
from the Recovered Items folder to other mailbox folders as needed, and then 
delete the Recovered Items folder. 

If the browse operation succeeds, but the items you need are not displayed, then 
restore the entire folder.

If the browse operation fails because there are still too many items for Avamar to 
display, then restore the entire folder.
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Command-Line Interface

The following topics explain how to use the command-line interface (CLI) to back up or 
restore Exchange data.
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Understanding the Windows Exchange VSS plug-in CLI
The following topics provide an overview of the Windows Exchange VSS plug-in CLI.

CLI architecture

When you use the CLI to initiate a backup or restore, you specify the options for the 
Windows Exchange VSS plug-in binary on the command line. The plug-in interacts with the 
avtar process to write backup data to or read backup data from the Avamar server.

When you use Avamar Administrator instead, the Management Console Server (MCS) 
service on the Avamar server gives the avagent process on the client a workorder with the 
options that you specify through Avamar Administrator. The avagent process then starts 
the Windows Exchange VSS plug-in, which then interacts with avtar for the backup or 
restore.

With the CLI, the MCS and avagent process are not involved in the backup or restore.

Launching the CLI

The avexvss binary is located in C:\Program Files\avs\bin, where C:\Program Files\avs is 
the Avamar client installation directory. To launch the CLI, open a command prompt and 
change directory to the bin directory of the Avamar client installation directory. “Command 
reference”  on page 186 provides a complete list of available commands and options.

Available operations

The following topics provide an overview of the operations that are available with the 
avexvss command. To specify the operation, use --operation={browse | backup | restore} 
on the avexvss command line.

Browse
The browse operation returns a list of Exchange objects available to back up. The 
command results appear as standard output in the command window. The following 
information appears for each entry:

◆ Name (in Exchange 2007, storage group name; in Exchange 2010, database name)

◆ Size

◆ FStype (for example, db)

◆ User

The data is sorted alphabetically by name. 

Backup
The backup operation performs an on-demand backup of the specified data. 

You can specify plug-in options for the backup. Many of these plug-in options are the 
same options that you specify in the Backup Command Line Options dialog box when you 
perform an on-demand backup by using Avamar Administrator, or on the Options tab 
when you create a dataset for a scheduled backup. 
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Restore
The restore operation restores the specified data from either the Avamar server or a Data 
Domain system, depending on where the backup is stored.

You can specify plug-in options for the restore. Many of these plug-in options are the same 
options that you specify in the Restore Command Line Options dialog box when you 
perform a restore by using Avamar Administrator. 

Options

You can specify options for avexvss to control backup or restore behavior.

There are several ways to specify options for the avexvss command:

◆ Type the individual options on the command line.

◆ List the options in the avexvss.cmd file, which is located in the C:\Program 
Files\avs\var directory, where C:\Program Files\avs is the Avamar client installation 
directory. List each option on its own line, as shown in the following example:

--debug
--logfile=avamarclient.log
--verbose=5

◆ Create an option file as a text file, and then specify the option file on the command 
line by using the --flagfile=FILEPATH option, where FILEPATH is the full path and file 
name of the option file.

◆ You can pass certain options to the CLI as environment variables. For example, if you 
set Instance1=NamedInstance1 in the environment variables, then you can browse 
the instance by typing the following command:

avmexvss --operation=browse %Instance1%

Password encoding

You can use avtar to encode passwords that are entered through the command line or 
stored in script files, and then use the encoded string with the --password, --ap, or --pswd 
option.

To encode passwords:

1. Type the following command on the command line on the Exchange VSS client:

avtar --encodepassword=PASSWORD

where PASSWORD is the password to encode.

An encoded string is returned on the command line.

2. Use the encoded string on the avexvss command line as the password with the 
--password, --ap, or --pswd option.
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Help

To view command-line help output, use the --help option, as shown in the following 
example command line, which shows a complete list of available operations and options, 
with a description for each one:

avexvss --help

To view only the options for a specific operation, use the --help and 
--operation=OPERATION options together. The following example provides a list of options 
for the backup command:

avexvss --help --operation=backup

When you include the --debug option in the avexvss.cmd file, the avexvss --help command 
displays debug messages. To prevent debug messages from appearing in online help 
content use the following command:

avexvss --help --debug=false

Command reference
The avexvss command enables you to browse for Exchange data to back up or restore, 
perform the backup, or perform the restore.

Synopsis

avexvss --operation={browse | backup | restore} 

[--backup-type=TYPE] [{--exclude-pluginid-list=STRING | 
--excludepluginids=STRING}] [{--pluginid-list=STRING | 
--pluginids-STRING}] [--version][--federated] 
{--account=DEST | --path | --acnt} {--id=USER@DOMAIN/HOMEACNT} 
{--password=PASSWORD | --ap=PASSWORD |--pswd=PASSWORD | 
--server=IPADDR | --hfsaddr=AVAMARSERVER} 
[--informationals=N] [--logfile=FILE] [--log] [--noinformationals] 
[--nostdout] [--nowarnings] [--quiet] [{--verbose | -v}] 
[--expires={DAYS | TIMESTAMP}] [{--retention-type=TYPE | 
--retentiontype=TYPE}][--backuptype | 
--backup_type=[active|passive|always] [--brtype=level] 
[--circular_only] [--circular_promote] [--circular_skip] 
[--disable_cc] [--excludelist=string ] [--includelist=STRING] 
[--max-integrity-check-threads=N] [--num_ios=UNITS] 
[--pause_duration=MS] [--serverorderlist=STRING] [--throttle_cc]
[--labelnum=NAME] [--allowoverwrite] [--attachdb] 
[--fAttachDBs={TRUE | FALSE}] [--autosuspend][--dbpath=NAME] 
[--deleteexistingrsgrdb] [--logpath=NAME] [--movelogspath=NAME] 
[--MoveLogsPath] [--nologreplay] [--redirectedsgpath=NAME] 
[--RedirectedSgPath] [-retainmetadata] [--rsgname=NAME] 
[--rsgrestore] 

Note:

◆ Commands/operations are bold.
◆ Required options are not enclosed in any brackets.
◆ Optional options appear in square brackets [].
◆ Either/or choices appear in curly brackets {}.
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Operations

Supply one and only one of the following operations for the avexvss command by using 
the --operation option.

Options

The following topics list the options that are available for the avexvss command.

Common options
The following common options are available for the avexvss command.

Account options
The following account options are available for the avexvss command.

Table 11  Operations for the avexvss command

Command Description

browse Returns a list of data on the client that is available for backup.

backup Performs an on-demand backup of the specified data.

restore Restores the specified data.

Table 12  Common avexvss commands

Option Description

 --federated Specifies to run the backup in federated mode.

--version Displays the build version of the Avamar for Exchange VSS 
plug-in.

Table 13  Account options for the avexvss command

Option Description

--account=DEST | --path=DEST | 
--acnt=DEST

Specifies the Avamar server account path

--id=user@domain/homeacnt Specifies the client user name used for authentication where:
• USER is the username of the registered client.
• DOMAIN is the Avamar domain.
• HOMEACNT is the hostname of the Avamar Plug-in for 

Exchange VSS client.

--password=PSWD | --ap | 
--pswd

Specifies the password for --id=USER@DOMAIN/HOMEACNT.

--server=IPADDR 
--hfsaddr=IPADDR 

Specifies the Avamar server IP address .
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Logging options
The following logging options are available for the avexvss command.

Browse options
There are no browse options for the avexvss command.

Backup options
The following backup options are available for the avexvss command.

Table 14  Logging options for the avexvss command

Option Description

--informationals Sets information level for status messages.

--logfile=FILE | --log Creates log files in the directory you specify.

--noinformationals Disables informational messages.

--nostdout Disables output to standard output (stdout).

--nowarnings Disables warning messages.

--quiet Disables both warnings and status messages.

--verbose | --verbose=N | -v Enables all status and warning messages.
Use --verbose=N to specify a verbosity level, where N is 
a number from 1–6 with 6 being the highest level of 
verbosity.

Table 15  Backup options for the avexvss command (page 1 of 3)

Option Description

--expires={DAYS | TIMESTAMP} Specifies the backup expiration as a number of days from the 
day of the backup (DAYS) or an absolute timestamp 
(TIMESTAMP).
Specify TIMESTAMP by using 24-hour local timezone values 
conforming to the following syntax: 
YYYY-MM-DD HH:MM:SS 
You can specify partial date strings. For example, 2011-02 is 
equivalent to 2011-02-01 00:00:00.

--retention-type=TYPE Specifies one of the following retention types:
• none
• daily
• weekly
• monthly

--backup-type=TYPE Specifies the type of backup:
• active — Backs up only active databases.
• passive — Backs up only passive databases.
• always — Backs up both

--brtype=LEVEL Specifies the level of backup:
• full — Performs a full backup. 
• incremental — Performs an incremental backup.

Backup policy when saveset includes circular logging-enabled databases. 
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--circular_only Promotes all incremental backups of all databases with 
circular logging enabled to a full backup and skips any 
databases that do not have circular logging enabled.

Note: This option only applies to incremental backups 
--brtype=incremental, not full backups. You can only specify 
one --circular_ flag. 

--circular_promote Backs up all databases whether they have circular logging 
enabled or not. If one or more databases has circular logging 
enabled, all databases in the saveset will have any 
incremental backup promoted to a full backup.

Note: This option only applies to incremental backups 
--brtype=incremental, not full backups. You can only specify 
one --circular_ flag. 

--circular_skip Performs an incremental or full backup (depending on what 
has been specified) of all databases that have circular 
logging disabled and skips any database that have circular 
logging enabled.

Note: This option only applies to incremental backups 
--brtype=incremental, not full backups. You can only specify 
one --circular_ flag. 

--disable_cc Disables the consistency check.
Exchange backup performance is greatly affected by the 
consistency check. The larger the number of logs, the longer it 
takes to perform a consistency check. Consistency checking 
can cause performance issues, such as I/O bottlenecks so 
severe that consistency checks fail and other operations with 
the system are adversely affected.

--excludelist=string Specifies in a comma delimited list to exclude from the 
backup, by storage group (Exchange 2007) or database 
names (Exchange 2010). 
Exchange 2007 example:
--excludelist=Exchange Information Store/First 
Storage Group,Exchange Information Store/Third 
Storage Group

Exchange 2010 example: 
--excludelist=Exchange Information 
Store/My2010Db

--includelist=STRING Specifies in a comma delimited list to include in the backup 
the storage group (Exchange 2007) or database names 
(Exchange 2010). 
Exchange 2007 example:
--includelist= Exchange Information Store/First 
Storage Group,Exchange Information Store/Third 
Storage Group

Exchange 2010 example: 
--includelist=Exchange Information 
Store/My2010Db

Table 15  Backup options for the avexvss command (page 2 of 3)

Option Description
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Restore options
The following restore options are available for the avexvss command.

--num_ios=UNITS Specifies the number of I/Os between pauses when throttling 
the consistency check. Specify a value between 100 and 
10000. The default value is 1000.

--pause_duration=MS Specifies the duration of the pause in milliseconds when 
throttling the consistency check utility eseutil. Specify a value 
between 1000 and 60000. The default value is 1000.

--throttle_cc Specifies that the consistency check is throttled by using the 
# IOs between pauses and duration of pauses options.

--serverorderlist=STRING Specifies the order to use to back up the Exchange 
databases. Specify the server name only (not the FQDN), 
separated by commas. 

--vss-snapshot-timeout=MINUTES Specifies in minutes how long to wait for snapshot creation, 
before failing the backup. If you do not specify this flag, the 
default is 5 minutes. Use this flag when VSS snapshot 
creation takes longer than 5 minutes, which may occur with 
very large Exchange servers or databases. To use this flag, 
create a file named avexvss.cmd, if this file does not already 
exist, in the avs\var folder on each node of the DAG where the 
DAG client is installed. “Backups may time out for large 
Exchange databases when using the default time out value”  
on page 118 provides more information about using this 
command. 

Table 15  Backup options for the avexvss command (page 3 of 3)

Option Description

Table 16  Restore options for the avexvss command (page 1 of 2)

Option Description

--labelnum=NAME Specifies the label of the backup to restore.

--allowoverwrite  Specifies to allow the database to be overwritten by a 
restore.

--attachdb, --fAttachDBs=TRUE|FALSE Specifies to attach and mount the database. The default 
value is True.

--autosuspend Specifies to automate replication 
suspension/resumption.

--dbpath=NAME  Specifies the RSG/RDB database path.

--deleteexistingrsgrdb Specifies to overwrite an existing RSG/RDB.

--logpath=NAME Specifies the RSG/RDB log folder path.

--movelogspath=NAME, 
--MoveLogsPath

Specifies the destination path for logs.

--nologreplay  Specifies not to replay the transaction logs.

--redirectedsgpath=NAME, 
--RedirectedSgPath 

Specifies the redirected storage group path.
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CLI examples
The following topics provide examples of avexvss commands.

Example browse commands

The browse operation displays a list of Exchange objects available to back up:

avexvss --operation=browse "Exchange Information Store"

Example backup commands

The following commands provide examples for using the avexvss command to back up 
Exchange files to the Avamar server.

The following command backs up the specified target:

avexvss --operation=backup --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain 
<--backuptype={active|passive|all}>  
<--brtype={full|incremental}> <--federated=true 
--serverorderlist={listofservers}> “{Exchange target}”

The following command specifies with the --backuptype=active flag to back up only the 
active databases on the Exchange server:

avexvss --operation=backup --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain --backuptype=active 
<--brtype={full|incremental}> <--federated=true 
--serverorderlist={listofservers}> “{Exchange target}”

The following command specifies with the --backuptype=passive flag to back up only the 
passive databases on the Exchange server:

avexvss --operation=backup --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain --backuptype=passive 
<--brtype={full|incremental}> <--federated=true 
--serverorderlist={listofservers}> “{Exchange target}”

The following command specifies with the --backuptype=all flag to back up all databases 
on the Exchange server:

avexvss --operation=backup --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain --backuptype=all 
<--brtype={full|incremental}> <--federated=true 
--serverorderlist={listofservers}> “{Exchange target}”

The following command specifies with the --brtype=full flag to perform a full backup.:

--retainmetadata  Specifies to retain recovery metadata.

--rsgname=NAME Specifies the name of the RSG.

--rsgrestore Redirects restore into a RSG.

Table 16  Restore options for the avexvss command (page 2 of 2)

Option Description
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avexvss --operation=backup --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain 
<--backuptype={active|passive|all}> --brtype=full <--federated=true 
--serverorderlist={listofservers}> “{Exchange target}”

The following command specifies with the --brtype=incremental flag to perform an 
incremental backup:

avexvss --operation=backup --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain 
<--backuptype={active|passive|all}> --brtype=incremental 
<--federated=true --serverorderlist={listofservers}> “{Exchange 
target}”

The following command, performed on the Exchange server that is currently hosting the 
DAG, specifies with the --federated=true flag to perform a federated backup of all 
databases, sending out workorders to the individual Exchange servers in the DAG. The 
--backuptype=passive options is specified; specifying all or active results in an error. 
When the --federated=true flag is used, the --serverorderlist= flag will also need to be 
specified:

avexvss --operation=backup --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain --backuptype=passive 
<--brtype={full|incremental}> --federated=true 
--serverorderlist=ExchSrv3,ExchSrv2,ExchSrv5,ExchSrv1 “{Exchange 
target}”

Example restore commands

The following command restores the specified targets: 

avexvss --operation=restore --server=server_name --id=root 
--ap=password --acnt=/clients/client.domain 
--labelnum={labelnumber}> <--allowoverwrite=true> “{Exchange 
target}”
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Plug-in Options

The following topics provide information about backup and restore plug-in options for the 
Windows Exchange VSS plug-in and the Windows Exchange GLR plug-in:

◆ How to set plug-in options ....................................................................................  194
◆ Backup options.....................................................................................................  194
◆ Restore options.....................................................................................................  197
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How to set plug-in options
Plug-in options enable you to control specific actions for on-demand backups, restores, 
and scheduled backups. The plug-in options that are available depend on the operation 
type and client plug-in type. 

You specify plug-in options in Avamar Administrator for on-demand backup or restore 
operations, or when you create a dataset for a scheduled backup. You can set options by 
using the graphical user interface (GUI) controls (text boxes, check boxes, radio buttons, 
and so forth). In addition to using the GUI controls for the options, you can type an option 
and its value in the Enter Attribute and Enter Attribute Value fields. 

The Avamar software does not check or validate the information you type in the Enter 
Attribute and Enter Attribute Value fields. In addition, the values in the Enter Attribute and 
Enter Attribute Value fields override settings that you specify with the GUI controls for the 
options.

Detailed instructions on how to access and set plug-in options during a backup or restore 
are available in Chapter 3, “Backup,” and Chapter 4, “Exchange Database Restore and 
Disaster Recovery.”

Backup options
The following backup options are available for the Avamar Plug-in for Exchange VSS when 
you perform an on-demand backup or when you configure a dataset for scheduled 
backups.

Table 17  Backup plug-in options 

Option Description

Items Marked for Backup Lists the Avamar plug-in selected for the backup 

Retention Policy Settings Specifies how long to retain the backup: 
• To automatically delete this backup from the Avamar server 

after a specific amount of time, select Retention period and 
then specify the number of days, weeks, months, or years for 
the retention period.

• To automatically delete this backup from the Avamar server 
on a specific calendar date, select End date and browse to 
that date on the calendar.

• To keep this backup for as long as this client remains active 
in the Avamar server, select No end date.

Encryption method Specifies the encryption method to use for client/server data 
transfer during this backup.
The exact encryption technology and bit strength used for a 
client/server connection depends on a number of factors, 
including the client platform and Avamar server version. The 
EMC Avamar Product Security Guide provides additional 
information.
194 EMC Avamar 6.1 for Exchange VSS User Guide



Plug-in Options
The following backup command line options are available for the Avamar plug-in for 
Exchange VSS when you perform an on-demand backup or when you configure a dataset 
for scheduled backups. 

Table 18  Backup Command Line options  (page 1 of 2)

Option Description

Select type of backup to 
perform

Specifies whether to perform full or incremental backups. 
Incremental backups will automatically be promoted to full 
when no previous backups can be found.

Note: Only full backups can be used for granular-level recovery. 

Set when backup occurs on 
clustered or DAG systems

Specifies whether to back up passive or active databases, or 
both. The choices are:
• Replica (passive) writer only
• Store (active) writer only
• Always
In Exchange 2007, all databases on a physical machine are 
either passive or active at any given time. In Exchange 2010, a 
physical machine can contain both passive and active copies of 
different databases, but not an active and passive copy of the 
same database. 

Federated Backup Preferred 
server order list

When backing up Exchange 2010 DAG environments, this list 
specifies the order of which servers to use to back up the 
Exchange databases. “Federated backups of Exchange 2010 
DAG environments”  on page 34 provides more information.

Backup policy when saveset 
includes circular 
logging-enabled databases

Circular logging is an option provided by Microsoft that allows 
the user to reduce the number of transaction logs resident on 
the system. Incremental backups with circular logging enabled 
results in missing transaction logs and unrecoverable data. For 
mixed environments where some but not all storage groups or 
databases have circular logging enabled, you can select one of 
these settings to specify how Avamar handles incremental 
backups.

Note: These options only apply to incremental backups, not full 
backups. 

• Selecting Promote: back up all databases, promoting 
incrementals to full if any database in the saveset has 
circular logging enabled will back up all databases whether 
they have circular logging enabled or not. If one or more 
databases has circular logging enabled, all databases in the 
saveset will have any incremental backup promoted to a full 
backup.

• Selecting Circular: back up only those databases with 
circular logging enabled, promoting them to full will promote 
all incremental backups of all databases with circular logging 
enabled to a full backup and skip any databases that do not 
have circular logging enabled. 

• Selecting Skip: skip backup of databases with circular 
logging enabled, allowing incremental backups will perform 
an incremental or full backup (depending on what has been 
specified) of all databases that have circular logging 
disabled and skip any database that have circular logging 
enabled.
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Store backup on Data Domain 
system

To store the backup on a Data Domain system instead of the 
Avamar server, select the check box and then select the Data 
Domain system from the list.

Enable multi-streaming Enables the backup of multiple targets in parallel to reduce 
backup time.

Maximum number of streams When you enable multi-streaming, this option specifies the 
maximum number of streams to use for the backup. The default 
is 2, and the maximum value is 6.
You need one processor an one spindle for each stream.
When storing the backup on a Data Domain system, only one 
stream is used. 

Advanced options

Group by When you enable multi-streaming, this option specifies whether 
to group the backups by Database or by Volume. The default is 
by volume. 
By volume will split the data into streams by the volumes they 
are placed on. For example, files on E:\ get 1 stream, files on F:\ 
get another stream, etc.
By database will split the data into streams by database. For 
example, all files for “database 1” share 1 stream, all files for 
“database 2” share another stream, etc.
In general, by volume is used when the data on each volume of 
the backup set are roughly the same size, and by database is 
used when the databases in the backup set are roughly the 
same size. Since hard disk speed is one of the most common 
performance bottlenecks, by volume tends to work best in the 
majority of Exchange environments since it will use 1 stream per 
disk. Another benefit of by volume is that when database and 
log files are on separate volumes, following Microsoft best 
practices, each database can be split into 2 streams.

Enable debugging messages Specifies to write maximum information to log files. If selected, 
very large log files are created.

Disable consistency check 
(recommended only if 2+ 
members in DAG)

If selected, this setting disables the consistency check. 
Exchange backup performance is greatly affected by the 
consistency check. The larger the number of logs, the longer it 
takes to perform a consistency check. Consistency checking can 
cause performance issues, such as I/O bottlenecks so severe 
that consistency checks fail and other operations with the 
system are adversely affected. 

Enable consistency check 
throttling

If selected, specifies that the consistency check is throttled by 
using the # IOs between pauses and Duration of pauses 
options. 

#I/Os between pauses Specifies the number of I/Os between pauses when throttling 
the consistency check. Specify a value between 100 and 10000 
(10,000). The default value is 1000 (1,000).

Duration of pauses (ms) Specifies the duration of the pause in milliseconds when 
throttling the consistency check utility eseutil. Specify a value 
between 1000 (1,000) and 60000 (60,000). The default value 
is 1000 (1,000).

Table 18  Backup Command Line options  (page 2 of 2)

Option Description
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Restore options
The plug-in options that are available during a restore depend on whether you are 
performing a standard restore by using the Windows Exchange VSS plug-in or granular 
level recovery by using the Windows Exchange GLR plug-in.

Restore options for the Windows Exchange VSS plug-in

The following options are available when you perform a restore by using the Windows 
Exchange VSS plug-in.

Table 19  Restore options for the Windows Exchange VSS plug-in (page 1 of 2)

Option Description

Allow database overwrite If selected, this setting enables Avamar to overwrite all target 
databases during the restore operation.
You also can configure the restore options to only enable the 
overwrite of a specific database. To enable the overwrite of a 
specific database:
1. Leave the Allow database overwrite check box clear.

2. In the Exchange Management Console, select the This 
database can be overwritten by a restore option in the 
recovery options for the database.

Mount the database(s) after 
successful restore

Select this option to automatically mount databases after a 
successful restore.

Do not replay the transaction 
logs

Select this option to restore but not replay transaction logs. This 
enables you to manually copy additional transaction logs before 
you mount the database.

Move logs path Specifies the location to which to move existing log files before 
the restore, which prevents log file conflicts during the restore.

Retain recovery metadata If this option is enabled, the metadata files that are used during 
a restore are not deleted upon completion. You can use these 
files, which are in the \var\avexvss_restore folder, to 
investigate any restore issues that may occur. 

Recover path location Specifies an alternate path for the Storage Group \ Database 
files to be restored to.

Automate replication 
suspension

Specifies that replication to the passive nodes is suspended 
while you are performing the restore. If you do not select this 
option, you will need to manually suspend replication before 
you perform the restore as described in “Manually suspending 
replication to the passive node”  on page 134.

Note: When you select Automate replication suspension, that 
only suspends replication before the restore. Whether you 
select this setting or manually suspend replication, you will still 
need to manually resume replication after the restore, as 
described in “Resuming replication and restarting cluster 
resources”  on page 150.
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Restore options for the Windows Exchange GLR plug-in

The following options are available when you perform a restore by using the Windows 
Exchange GLR plug-in.

Restore into RSG/RDB Clear this option to specify an alternate path for the restore in 
the Recover path location or RSG/RDB name box. 
Select this option to specify a target Exchange Server 2010 RDB 
name in the Recover path location or RSG/RDB name box. This 
setting does not apply to Exchange Server 2007 RSGs.

Overwrite existing RSG/RDB Specifies to overwrite any existing RSG/RDB with the same 
name as specified in the RSG/RDB name field. 

RSG/RDB name Specifies the name of the Exchange Server 2010 Recovery 
Database or Exchange Server 2007 Recovery Storage Group to 
recover the databases to.

RSG/RDB database path Specifies the location for the RSG/RDB databases.

RSG/RDB Specifies the location for the RSG/RDB log files.

Advanced options

Enable debugging messages Specifies to write maximum information to log files. If selected, 
very large log files are created.

Table 19  Restore options for the Windows Exchange VSS plug-in (page 2 of 2)

Option Description

Table 20  Restore options for the Windows Exchange GLR plug-in 

Option Description

Amount of time to leave AvFS 
mounted

Specifies the amount of time to leave the Avamar Virtual Drive 
mounted before a timeout occurs. The drive is disconnected after 
the timeout, even if the drive is in use.

Advanced Options

Enable debugging messages Specifies to write maximum information to log files. If selected, 
very large log files are created.
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